Scream! 4.6

Seismic Monitoring Software

Document N°: MAN-SWA-0001

Issue N - June, 2018
Table of Contents

1 Preliminary Notes............................................................................................................7
  1.1 Proprietary Notice....................................................................................................7
  1.2 Cautions and Notes................................................................................................7
  1.3 Manuals and Software..............................................................................................7
  1.4 Conventions................................................................................................................7

2 Introduction......................................................................................................................8
  2.1 Scream! as a real time application.............................................................................8
    2.1.1 Diagnostic features............................................................................................9
    2.1.2 Digitiser configuration......................................................................................9
    2.1.3 Networking.........................................................................................................9
    2.1.4 Recording and replay.......................................................................................9
  2.2 Scream! as a data viewer..........................................................................................10

3 Installation and Configuration.........................................................................................12
  3.1 Installation on Windows.............................................................................................12
  3.2 Installation on Unix or Linux.....................................................................................13
    3.2.1 Installation from an RPM or .deb......................................................................13
    3.2.2 Installation from a .tar.gz archive.....................................................................13
  3.3 Initial Configuration – all platforms..........................................................................14

4 Acquiring data................................................................................................................15
  4.1 Acquiring data via serial ports..................................................................................15
  4.2 Acquiring data over dial-up links.............................................................................18
  4.3 Acquiring data from network sources......................................................................20
    4.3.1 Passive client / server-push..............................................................................21
    4.3.2 Active client / client-pull...................................................................................22
    4.3.3 Acquiring data from networked 6TDs and 3ESPCDs.........................................25
    4.3.4 Requesting data over TCP links........................................................................25
    4.3.5 Requesting data from Multicast servers...........................................................26
    4.3.6 Detecting data sources......................................................................................27
5 The Main Window......................................................................................................................29
  5.1 The stream buffer..................................................................................................................29
  5.2 The source tree.....................................................................................................................30
    5.2.1 Icons.................................................................................................................................31
  5.3 The stream list........................................................................................................................32
    5.3.1 Stream IDs.........................................................................................................................32
    5.3.2 Other columns....................................................................................................................35
    5.3.3 Sorting options...................................................................................................................36
  5.4 The status bar........................................................................................................................37
  5.5 Viewing streams.....................................................................................................................37
  5.6 Connecting to instruments.....................................................................................................39
  5.7 Calibration data......................................................................................................................39
    5.7.1 Example...............................................................................................................................43
    5.7.2 Six-channel digitisers.........................................................................................................43
  5.8 Other features........................................................................................................................44

6 WaveView windows..................................................................................................................45
  6.1 Window functions...................................................................................................................47
    6.1.1 Zooming in and out............................................................................................................48
    6.1.2 Making measurements.....................................................................................................49
    6.1.3 Printing...............................................................................................................................50
    6.1.4 Selecting data....................................................................................................................52
      Selecting data from one stream or several adjacent streams.....................................................52
      Selecting data from exactly two streams.................................................................................53
    6.1.5 Filtering.............................................................................................................................54
    6.1.6 Paused mode.....................................................................................................................55
    6.1.7 Other icons........................................................................................................................57
    6.1.8 Context menu.....................................................................................................................58
  6.2 Stream functions.....................................................................................................................64
    6.2.1 Identifying streams............................................................................................................66
    6.2.2 Changing the appearance of streams...............................................................................66
    6.2.3 Scaling streams................................................................................................................67
    6.2.4 Viewing offsets, ranges and averages: Details windows..................................................67
    6.2.5 Spectrogram.......................................................................................................................69
      Interpretation..............................................................................................................................69
      Height........................................................................................................................................70
      Contrast.....................................................................................................................................70
      Zooming in...............................................................................................................................70
      Example....................................................................................................................................72
  6.3 Filtering..................................................................................................................................73
    6.3.1 Filter parameters................................................................................................................74
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.3.2</td>
<td>Viewing spectra</td>
<td>76</td>
</tr>
<tr>
<td>6.3.3</td>
<td>Display options</td>
<td>80</td>
</tr>
<tr>
<td>6.3.4</td>
<td>Using your filter</td>
<td>80</td>
</tr>
<tr>
<td>6.3.5</td>
<td>Pre-sets</td>
<td>81</td>
</tr>
<tr>
<td>6.4</td>
<td>Display options</td>
<td>82</td>
</tr>
<tr>
<td>6.4.1</td>
<td>Display set-up</td>
<td>82</td>
</tr>
<tr>
<td>6.4.2</td>
<td>Stream mapping</td>
<td>83</td>
</tr>
<tr>
<td>7</td>
<td>Forwarding data over a network</td>
<td>86</td>
</tr>
<tr>
<td>7.1</td>
<td>Client pull</td>
<td>87</td>
</tr>
<tr>
<td>7.2</td>
<td>Server push</td>
<td>88</td>
</tr>
<tr>
<td>7.3</td>
<td>Server Buffer</td>
<td>90</td>
</tr>
<tr>
<td>7.4</td>
<td>Gap recovery</td>
<td>91</td>
</tr>
<tr>
<td>8</td>
<td>Supplementary windows</td>
<td>92</td>
</tr>
<tr>
<td>8.1</td>
<td>Terminal windows</td>
<td>92</td>
</tr>
<tr>
<td>8.1.1</td>
<td>Communicating with instruments</td>
<td>92</td>
</tr>
<tr>
<td>8.1.2</td>
<td>Macro commands</td>
<td>94</td>
</tr>
<tr>
<td>8.1.3</td>
<td>Direct connections</td>
<td>94</td>
</tr>
<tr>
<td>8.2</td>
<td>Digitiser status streams</td>
<td>95</td>
</tr>
<tr>
<td>8.2.1</td>
<td>GNSS</td>
<td>96</td>
</tr>
<tr>
<td>8.2.2</td>
<td>Graphing status information</td>
<td>99</td>
</tr>
<tr>
<td>8.2.3</td>
<td>Station Lat/Long</td>
<td>100</td>
</tr>
<tr>
<td>8.3</td>
<td>The summary window</td>
<td>102</td>
</tr>
<tr>
<td>8.3.1</td>
<td>Timing</td>
<td>102</td>
</tr>
<tr>
<td>8.3.2</td>
<td>Mass position</td>
<td>103</td>
</tr>
<tr>
<td>8.3.3</td>
<td>Age</td>
<td>103</td>
</tr>
<tr>
<td>8.3.4</td>
<td>Errors</td>
<td>104</td>
</tr>
<tr>
<td>8.3.5</td>
<td>Triggers</td>
<td>104</td>
</tr>
<tr>
<td>8.4</td>
<td>The ViewInfo window</td>
<td>106</td>
</tr>
<tr>
<td>9</td>
<td>Configuring CD24 and DM24 digitisers</td>
<td>108</td>
</tr>
<tr>
<td>9.1</td>
<td>System ID</td>
<td>109</td>
</tr>
<tr>
<td>9.2</td>
<td>Output control</td>
<td>110</td>
</tr>
<tr>
<td>9.3</td>
<td>Triggering</td>
<td>112</td>
</tr>
<tr>
<td>9.3.1</td>
<td>STA/LTA</td>
<td>114</td>
</tr>
<tr>
<td>9.3.2</td>
<td>Level</td>
<td>116</td>
</tr>
<tr>
<td>9.3.3</td>
<td>External triggering</td>
<td>117</td>
</tr>
<tr>
<td>9.3.4</td>
<td>Pre-trigger and post-trigger recording</td>
<td>118</td>
</tr>
<tr>
<td>9.4</td>
<td>Mux Channels</td>
<td>118</td>
</tr>
<tr>
<td>9.5</td>
<td>Ports</td>
<td>119</td>
</tr>
</tbody>
</table>
12 Printing options........................................................................................................157
12.1 Page printout........................................................................................................157
  12.1.1 Automatic printing.........................................................................................158
  12.1.2 Automatic screen-shots................................................................................159
12.2 Continuous printout............................................................................................160
  12.2.1 Parallel port redirection under Windows.....................................................162

13 Logging and notification........................................................................................164
13.1 Log files................................................................................................................164
13.2 E-mail notification...............................................................................................166

14 Extending Scream!..................................................................................................168
14.1 Installing new extensions.....................................................................................168
14.2 Running extensions..............................................................................................169

15 Keyboard and mouse shortcuts.............................................................................171
15.1 The Main Window...............................................................................................171
  15.1.1 Menu items....................................................................................................171
  15.1.2 The source tree.............................................................................................171
  15.1.3 The stream list...............................................................................................173
15.2 WaveView windows............................................................................................173
  15.2.1 Shortcuts for all streams..............................................................................173
  15.2.2 Shortcuts for the selected stream................................................................175
15.3 Details window......................................................................................................176

16 Inside Scream!.........................................................................................................177
16.1 Command line options.......................................................................................177
16.2 The calvals.txt file.............................................................................................178
16.3 File and directory locations...............................................................................179
  16.3.1 Windows version..........................................................................................179
  16.3.2 Linux version...............................................................................................180
16.4 Common issues....................................................................................................181

17 Revision history.....................................................................................................182
1 Preliminary Notes

1.1 Proprietary Notice

The information in this document is proprietary to Güralp Systems Limited and may be copied or distributed for educational and academic purposes but may not be used commercially without permission.

Whilst every effort is made to ensure the accuracy, completeness and usefulness of the information in the document, neither Güralp Systems Limited nor any employee assumes responsibility or is liable for any incidental or consequential damages resulting from the use of this document.

1.2 Cautions and Notes

Cautions and notes are displayed and defined as follows:

Caution: A yellow triangle indicates a chance of loss of data if the caution is not heeded.

Note: A blue circle indicates indicates a procedural or advisory note.

1.3 Manuals and Software

All manuals and software referred to in this document are available from the Güralp Systems website: www.guralp.com unless otherwise stated.

1.4 Conventions

Throughout this manual, examples are given of command-line interactions. In these examples, a fixed-width typeface will be used:

Example of the fixed-width typeface used.

Commands that you are required to type will be shown in bold:

Example of the fixed-width, bold typeface.

Where data that you type may vary depending on your individual configuration, such as parameters to commands, these data are additionally shown in italics:

Example of the fixed-width, bold, italic typeface.

Putting these together into a single example:

System prompt: user input with variable parameters
2 Introduction

Scream! 4.6 is a software application for seismometer configuration, real-time acquisition and monitoring. It runs on Linux and Windows (from 98 onwards) on both 32-bit and 64-bit PCs. It can be used for decompressing, viewing, printing, recording, transmitting and replaying GCF data from any Güralp Systems digital device.

Scream! 4.6 can be used in two modes:

• as a stand-alone, real time application for real-time data acquisition, including a network server and client, file replay, recording and analysis tools; or

• as a "helper" application for viewing pre-recorded GCF files. This mode also allows you to convert data formats and launch analysis tools.

2.1 Scream! as a real time application

When you run Scream! by double-clicking on its icon, or by launching it from the command line, it opens a Main Window showing all of the data streams coming in.

Scream! can listen for incoming streams in GCF format on local serial ports or network interfaces, as well as actively requesting data from network sources.

The Main Window is the control centre for the whole program. If you close this window, Scream! will quit. All of Scream!'s functions are invoked from this window: see Chapter 5 on page 29 for details.

You can view a data stream by opening a WaveView window for it. Any number of WaveView windows can be opened, each containing any number of streams. The same stream can appear in several WaveView windows, if desired. Each WaveView window has its own amplitude and time scaling, colour scheme, and display parameters. For example:

• a single data stream can be viewed simultaneously at different zoom factors in different windows;

• different groups of data streams can be viewed simultaneously, each group having the same zoom factor; or

• an entire array can be monitored in one window, using another window for detailed examination of incoming data.

WaveView windows provide simple filtering capabilities, allowing you to examine seismic signals within a particular frequency range of interest. When more detailed analysis is required, data can be passed to a configurable range of Scream! extensions with a simple, mouse-driven selection process.
WaveView windows are fully described in Chapter 6 on page 45; Scream! extensions are covered in Chapter 14 on page 168.

2.1.1 Diagnostic features

Scream! performs extensive checks on all incoming GCF data and logs any errors to disk. You can see details about the incoming data, including any errors detected by Scream!, using the ShowInfo, Network Control, Summary and Status windows. These are described in Chapter 8 on page 92.

Scream! also provides logging facilities and can e-mail operators when a potential problem is detected, as described in Chapter 13 on page 164.

2.1.2 Digitiser configuration

Scream! provides an easy-to-use graphical interface for configuring Güralp DM24 and CD24 digitisers, including in digital instruments such as the 3TD and 6TD. Output stream selection, triggering, calibration and mass control can all be managed by Scream!.

See Chapter 9 on page 108 and Chapter 10 on page 121 for more information on these features.

2.1.3 Networking

The real time Scream! application provides a built-in network server and client for data in GCF format. A Network Control window provides full control of Scream!'s network connections. The Scream! server can be configured to allow remote clients to configure digitisers and control instruments over the network.

Client functions (data acquisition) are described in section 4.3 on page 20 while Chapter 7 on page 86 describes Scream!'s server functions.

2.1.4 Recording and replay

Scream! can record data to disk in a variety of formats. Scream! supports GCF, SAC, miniSEED, P-SEGy, SEG2, PEPP, SUDs and GSE, among others, allowing you to transfer data quickly and easily for further analysis or processing. Recorded files can optionally be post-processed by your own scripts or programs; either for file-transfer or data transformation.

GCF data files, including data from Güralp Systems NAM, Affinity or EAM units, can be read, replayed at variable time-scales, viewed, converted or printed with a few mouse clicks.

Support for SCSI tape devices is also included for accessing historical archives.

See Chapter 11 on page 135 and Chapter 12 on page 157 for details of these features.
2.2 Scream! as a data viewer

Scream! can be run in a slimmed-down viewing mode, which loads in a GCF file, a selection of GCF files, or an entire directory tree containing GCF files, and displays the data in a WaveView window.

To use these features on a Windows PC, select one or more GCF files (or folders containing GCF files), right-click on the selection and, in the pop-up context menu that appears, click on the View in Scream entry to open a WaveView window showing the data in the file, files or folders.

Any valid GCF file can be loaded, including multi-stream files, files with gaps or out-of-order data and files containing status packets. If a file contains a mix of data and status packets, a WaveView will be opened for the data, and a status window for the status data.

WaveView windows opened this way behave exactly like windows from the real-time application, except that (i) the “pause” button (⅛) is replaced with a button which resets the view to its initial settings (⅛) and (ii) the original file is used instead of the Stream Buffer - see section 5.1 on page 29 for a description of the Stream Buffer.

You can design and apply filters, plot spectrograms, or send data to Scream! extensions just as you would from real-time Scream!. See Chapter 6 on page 45 for full details of the available options.

From the command line, Scream! can be run in viewing mode with

```
scream -view filename [filename…]
```

Scream! cannot transfer data between real-time mode and viewing mode. If you want to load GCF files into the real-time application, you should use the Replay Files...
facility (see section 11.2 on page 151). However, you can have both real-time Scream! and Scream! viewer windows open at the same time.
3 Installation and Configuration

The Scream! software is available free-of-charge by request to mailto:scream@quralp.com. Please specify, when ordering, your name, any organisational affiliations, the equipment (instruments and digitisers etc) that you are using and the operating system on which you wish to run the software.

3.1 Installation on Windows

Scream! for Windows is delivered as an installer-packaged application so you will receive a single .exe file. Run this file and follow the instructions on screen. Please see section 3.3 on page 14 for initial configuration steps.

Note: Windows users may have to reconfigure the Windows FireWall in order to allow Scream! to communicate properly.

Under Windows, the first time that you start Scream!, Windows may ask you to specify how you wish Scream! to interact with the Windows Firewall. Because Scream! requires network communication in order to function, it is important that you understand the options available.

The following screen is displayed:

The screen provides three check-boxes which indicate whether Scream! can communicate with networked devices in the "Domain" profile, the "Private" profile or the “Public” profile. (Profiles are also known as “network locations”.)

The "Domain" profile applies to networks where the host system can authenticate to a domain controller. The "Private" profile is a user-assigned profile and is used to designate private or home networks. The default profile is the “Public” profile, which
Scream! 4.6

Installation and Configuration

is used to designate public networks such as Wi-Fi hotspots at coffee shops, airports, and other locations.

For a more complete discussion of this topic, please see www.tenforums.com/tutorials/6815-network-location-set-private-public-windows-10-a.html or your Windows documentation.

Select which of the profiles you wish to allow Scream! to operate in and click the button to proceed.

3.2 Installation on Unix or Linux

Scream! for Unix/Linux is delivered as either an RPM package or a .tar.gz compressed archive. For users of Debian GNU Linux-based distributions, such as Ubuntu, the alien command can be used to create a .deb package from the RPM.

The package includes a binary called scream and a wrapper script called scream.sh, which must be used when starting the program. It is usually convenient to create a symbolic link to the wrapper script with a command like

```
sudo ln -s /usr/lib/scream4.6/scream.sh /usr/bin/scream
```

Scream can then be started from the command line by simply typing scream.

Special instructions for users of 64-bit systems are available from our web site at http://www.guralp.com/howtos/running-scream-on-64-bit-linux.shtml. Ubuntu users should also visit http://www.guralp.com/howtos/Ubuntu-Scream-Dash.shtml, which describes integration with the Ubuntu Dash.

3.2.1 Installation from an RPM or .deb

You can normally use your package manager to install Scream! in the usual fashion. On some systems, however, you may need to use the --nodeps option with rpm, the --force-depends option with dpkg or a similar option with other package managers. Please see section 3.3 on page 14 for initial configuration steps.

3.2.2 Installation from a .tar.gz archive

The archive is created with relative file-paths and contains, at its root, a single directory, scream-4.6. It should be unpacked (using

```
sudo tar -xzf scream-4.6.tar.gz
```

or an equivalent command) into a suitable location, such as /usr/lib. After unpacking, you need to copy a file to the system library directory (usually /usr/lib) and create a symbolic link. You normally need to have root authority to do this.
Change your working directory to the \textit{scream-4.6} directory and issue the following commands:

\begin{verbatim}
sudo cp libborqt-6.9.0-qt2.3.so /usr/lib/
sudo ldconfig
\end{verbatim}

You may wish to change the owner and group of the extracted files according to your local policy.

Once fully installed, the application should be started with the command

\begin{verbatim}[/{install_path}]/scream-4.6/scream.sh\end{verbatim}
(or via a symbolic link, as described at the beginning of section 3.2 on page 13). Please see section 3.3 on page 14 for initial configuration steps.

### 3.3 Initial Configuration – all platforms

\textit{Scream}'s \textit{Setup} screen (available under the \textit{File} menu) allows you, amongst other things, to set the location of data files and log-files. It is wise to set these before proceeding. You can view the \textit{Setup} screen whenever the Main Window is in focus by keying \texttt{Ctrl} + \texttt{S}.

The folders/directories in which you choose to place these files must be writeable by you. They will be created when needed (if they do not already exist) as long as the parent folder/directory is writeable by you.

\begin{itemize}
  \item \textbf{Note:} Configured paths are not parsed by any command shell, so sequences such as \texttt{~} (home directory for Linux/Unix users) or \texttt{%AppData\%} (the application data directory for Windows users) will not do what you might expect.
  \item \textbf{Note:} As the data files can grow quite large, Windows users who use roaming profiles should pick a location which avoids having to transfer these files over the network each time they log on or off. Similar concerns may apply to Linux/Unix users in complex network environments.
\end{itemize}

The directory used for storing incoming stream data is set using the \textit{Base Directory} item on the \textit{Files} tab of the set-up dialogue. For detailed control of the file-names used, see section 11.1.2 on page 138.

The directory used for storing logging information is set using the \textit{Directory} item on the \textit{Event Log} tab of the set-up dialogue. For more information, see section 13 on page 164.
4 Acquiring data

When Scream is first started, the Main Window is displayed along with the Setup dialogue. The next step is to configure sources for data acquisition.

Data can be acquired:

- from digitisers directly connected over serial lines - see section 4.1 on page 15 for details about configuring serial ports to accept such data;
- from digitisers connected over serial modem links - see section 4.2 on page 18 for details about configuring Scream to use modem connections; and/or
- from digitisers, acquisition units and other instances of Scream connected over a network, such as a local Ethernet network or the public Internet. See section 4.3 on page 20 for details about configuring Scream as a network client.

Any combination of these sources can be used simultaneously. There are no software restrictions to the number of sources that can be configured and active. Modern PCs can cope with with many hundreds, if not thousands of simultaneous data streams.

4.1 Acquiring data via serial ports

1. If the Setup dialogue is not visible, select File → Setup... from the Main Window's menu. If the Com Ports page is not visible, bring it to the front by clicking on its tab.
2. The serial ports available to Scream! are listed in the table. Identify each port, and the instrument connected to it.

If you are using Microsoft Windows, the Port number corresponds to the COM number of the serial port. If you are using Linux, Port numbers 1 – 64 refer to the built-in serial ports /dev/ttyS0 – /dev/ttyS63. Ports 65 and above refer to USB-connected serial ports beginning /dev/ttyUSB0. Subtract 65 from the port number to get the ttyUSB number.

If you are using Microsoft Windows, the Port number corresponds to the COM number of the serial port. If you are using Linux, port numbers 1 to 64 refer to the built-in serial ports /dev/ttyS0 – /dev/ttyS63. Ports 65 and above refer to USB-connected serial ports beginning /dev/ttyUSB0. Subtract 65 from the port number to get the ttyUSB number.

A port may not be listed if it is not installed, suitable drivers are not available another program is using it or the user does not have permission to access it. Scream! scans your computer for new ports each time you open the Setup window. To make Scream! scan the ports again, click the Port column heading.

**Note:** Linux users should discover which system group provides access to the serial ports by entering the command:

```
ls -g /dev/ttyS* /dev/ttyUSB*
```

This will produce output like:

```
  crw-rw---- 1 uucp 4, 64 May 24 15:55 /dev/ttyS0
  crw-rw---- 1 uucp 4, 65 May 24 15:55 /dev/ttyS1
  crw-rw---- 1 uucp 4, 74 May 24 15:55 /dev/ttyS10
  crw-rw---- 1 uucp 4, 75 May 24 15:55 /dev/ttyS11
  crw-rw---- 1 uucp 4, 76 May 24 15:55 /dev/ttyS12
  ...
```

from which it can be seen that, in this case, the group is uucp. It may be different on your system: dialout is another common result. Once you have discovered the group, add each scream user to it with commands like:

```
sudo usermod -a -G uucp myusername
```

replacing uucp with the group discovered as before and myusername with the desired user’s login. Repeat as necessary to add any additional users.

3. Configure each port according to the settings of the digitisers connected to them:

**Baud Rate**: The speed of the serial link to the digitiser. The current digitiser product range defaults to 38,400 baud. Older 3-channel Güralp digitisers
default to a speed of 9,600 baud; 6-channel digitisers use 19,200 baud; EAM units use a baud rate of 115,200 by default. If you do not know the baud rate of your digitiser’s output port, select Auto-Detect from the drop-down menu to have Scream! attempt to detect it for you. The instrument must be producing data for this to work.

You can set all ports to the same baud rate by clicking on the column heading and choosing a suitable value from the drop-down menu.

If you are using Scream! for real time data, you will not need to change any of the remaining settings.

**AutoBaud**: Once connected, Scream! dynamically alters its baud rate to fit with the instrument to which it is connected. However, this can interfere with transmission over very noisy links. If you have problems, clear this check-box.

**ACKs**: This check-box controls whether Scream! should send Acknowledged messages to this digitiser in response to incoming data blocks. It should normally be enabled.

**NACKs**: This check-box controls whether Scream! should send Not Acknowledged messages to this digitiser when it detects a failure in transmission. It should normally be enabled.

**BRP**: This check-box controls whether Scream! should attempt to recover dropped blocks from the instrument using the Güralp Block Recovery Protocol. You should clear this box if you are using a single-direction (simplex) communications link.

If you clear all three check-boxes (ACKs, NACKs and BRP), Scream! will never acknowledge data packets that it is sent. This is particularly useful in situations where you need to connect to a digitiser without altering the flow of data. For example, a digitiser in FIFO or ADAPTIVE mode will normally save data in Flash memory only if data packets are not acknowledged. When you come to download the saved data from such a digitiser, you should clear these check-boxes before connecting the digitiser. Doing this will ensure that incoming data continues to be saved on the digitiser, rather than transmitted to Scream!.

**Rx T/O** (receive time-out): The time, in milliseconds, that Scream! will wait for the sender to finish transmitting a block, before assuming that it is complete. If the instrument stops transmitting in the middle of a block, Scream!s diagnostics will detect it and request retransmission next time the instrument is on-line.

**Note**: You can tick or clear all the check-boxes in a column by clicking on the column heading.

4. Click [OK]
If any digitisers are connected, data streams should now begin appearing in the right-hand portion of Scream!'s Main Window.

Another way to configure a serial port is to right-click on its entry in the streams list (the left-hand panel in the Main Window) and selecting Configure... However, you can only do this if data have already arrived through the port, making it appear in the streams list.

From this page, you can double-click on the port number of an open Com port to go directly to a terminal session on that port.

If you want to access Scream! servers on the network (i.e. EAMs, or other instances of Scream!), you will need to add the servers to the list using the Network Control window. See section 4.3 on page 20, for more details.

Scream! will remember all the data sources you have specified on exit. When you next open the program, it will automatically try to re-establish all the connections.

### 4.2 Acquiring data over dial-up links

Scream! can manage the retrieval of data from your installation using dial-up modems attached to your local PC. This feature is optimised for use in conjunction with the triggering capabilities and Flash recording modes of Güralp digitisers.

Dial-in support for continuous streams or triggered streams is automatic: if a remote system calls in on a port configured for dial-up, any data sent will be displayed automatically and recorded if so configured. In addition, the Auto-download on heartbeat option can be used to request recorded data from systems in FILING mode. See section 10.5.2 on page 128 for details.

Two new items, Dialup... and Hang up appear in the right-click context menu for each modem-equipped serial port in the source tree. These can be used to initiate and terminate out-going calls.
1. Click **File → Setup…** on Scream’s menu bar. Select the **Com Ports** tab.

2. You will see a list of all the serial ports available on your computer. This example shows a computer with two serial ports, COM1 and COM3. Scream issues **AT** commands to all COM ports and, if a modem is detected, the **Dialup** button is displayed, as is the case with COM1 in the example.

3. Make sure the baud rate and other flags are set up correctly for the modem and then click **Dialup**.

4. Enter the telephone number of the remote modem. If you want to contact several remote installations in turn, list their numbers, one per line.
5. In the right-hand panel, tick *Every (12) hours*, and set the value to your chosen polling interval.

6. Tick the *Limit each call to n minutes* check-box, and enter a suitable call length. Scream! will also hang up if it fails to receive any data for a specified length of time.

   Ensure that you allow enough time in each call to download all the new data, given the sample rates and baud rate that you have chosen. For example, if the modem connection can achieve 19200 baud, then a station outputting continuous 200 samples/s data for 3 components would require a continuous connection to collect all the data. If the data rate were only 20sps, then the modem would only need to be connected for 10% of the time (*e.g.* a 6-minute call every hour).

7. If the local modem needs extra commands, you can add these under Additional Modem Settings. Some useful commands are `Q1` to enter "quiet mode"; `E0` to turn off local echo, and `S0=1` to turn on the auto-answering facility. Modem commands normally start with the attention sequence `AT`; Scream! adds this sequence automatically, so you do not need to enter it in this box.

   Some modems have dip-switches which allow you to set permanent defaults for each command. These can be useful for autonomous installations, when you want to ensure that the modem does not enter an unrecoverable state.

8. When all the settings are correct, tick the Active check-box and click ✓*start* to start polling.

9. To switch off polling without losing your settings, clear the *Active* check-box.

   If you have more than one modem attached to your computer, you can set each one up with a different set of numbers and polling times. You might want to do this if:
   
   - you want to collect data from several stations simultaneously; or
   
   - using several modems allows you to reduce call charges (*e.g.* you might use a cellular modem to contact installations on GSM networks, and a standard PSTN modem to contact those on land lines).

   You can have up to 99 modems collecting data simultaneously, each with an unlimited number of scheduled dial-up times and telephone numbers. Scream! will remember all the settings when you exit.

---

**4.3 Acquiring data from network sources**

Scream can receive GCF data from sources such as networked digital instruments (*e.g.* 6TDs or 3TDEs), networked digitisers such as Affinity, Platinum systems such as EAMs and NAMs, and other copies of Scream.
These sources can push data to Scream, in which case it functions as a passive client and the configuration is referred to as "server-push". Alternatively, Scream! can be configured to actively request data from them, in which case it functions as an active client and the configuration is referred to as "client-pull". Both modes can be used simultaneously. These functions are configured from the My Client tab of the Network Control Window.

4.3.1 Passive client / server-push

In passive client mode, Scream! simply listens for incoming UDP packets on the port specified in the Port used for all network communications box. To configure Scream as a passive client, ensure that the "Receive UDP data" check-box is ticked and ensure that the port indicated in the Port used for all network communications box is not blocked by a firewall:

All blocks of GCF data received on the selected port will be listed in the "Block Rx" panel and the associated instruments and digitisers will appear in the source tree in the Main Window.

**Note:** You must configure the sources (servers) to push data to Scream using the IP address of the PC running Scream! and the port indicated in the Port used for all network communications box.
4.3.2 Active client / client-pull

In active client mode, Scream! must be configured to pull data from the remote sources.

The standard mode of transmission in Scream! uses UDP. Blocks of GCF data are received in UDP packets, which are shown in the Block Rx pane. UDP does not guarantee that data will be successfully received, although there is a mechanism for recovering missed packets - see section 7.4 on page 91 for details. If data are lost and subsequently recovered, a diagnostic message will appear in the Control pane.

To configure Scream to request data from a source, ensure that the "Receive UDP data" check-box is ticked, right-click anywhere in the Servers list of the My Client tab and select "Add UDP Server..." or use the keyboard shortcut. The "Add GCF server dialogue opens":

---

MAN-SWA-0001 22 Issue N - June, 2018
Type in the DNS name or IP address of the source followed by a colon (':') and the source port number. (If the source port number is omitted, the number specified as the Port used for all network communications at the bottom of the window is used.) Click and the new server will appear in the Servers list and an 'Added Server' message will appear in the Control window.

Right-click on the new server so that the context menu appears:
To check whether the server is contactable and can return data, select GCFPING from the menu (or, without right-clicking, left-click and use the keyboard shortcut + P).

If the new server replies, an acknowledgement will be shown:

Both the PING command and the response(s) will be shown in the Control pane.

![Network Control](image)

**Note:** If multiple servers respond, as might be the case if you GCFPING a broadcast address, the addresses of all the responding servers will be shown in separate GCFACKN entries in the Control pane.

To start data being transmitted, select GCFSEND:B from the context menu or use the keyboard shortcut + B. This command be recorded in the **Command** column of the **Servers** list and the **Refresh** count will be initialised.

The GCFSEND:B command is automatically re-sent every two minutes so that the server knows that the client is still alive. The countdown in the **Refresh** column indicates number of minutes remaining before the next issue.

To request that data transmissions stop, right-click on the server entry and select GCFSTOP from the context menu, or left-click on the entry and use the keyboard shortcut + S.

The steps above can be repeated as many times as necessary to pull data from several servers. (If several servers are selected, context menu commands or keyboard shortcuts will apply to all selected.) When you close Scream, it will
remember which servers you are pulling from. It will automatically issue a \texttt{GCFSTOP}
command as it closes, and a \texttt{GCFSEND:B} again when it re-starts.

Scream keeps track of the last block number received and, if the next block is not as
expected, it will request backfill (see section 7.4 on page 91). If Scream has been
closed for a long time, a large amount of back-fill data can be requested. The Status
column shows the progress of the back-filling process. If these data are not required,
the process can be cancelled by selecting "Purge Backfill" from the context menu or
by left-clicking on the entry and using the \texttt{Ctrl} + \texttt{F} keyboard shortcut. A
confirmation dialogue is displayed before the process is actually cancelled.

### 4.3.3 Acquiring data from networked 6TDs and 3ESPCDs

Most digitisers, digital instruments and acquisition units transmit GCF data using
the \texttt{Scream} transport protocol. This is also the protocol that Scream! uses when
transmitting GCF data between copies of Scream!.

6TDs and 3ESPCDs with wired or wireless networking capability, however, transmit
GCF data using the \texttt{BRP} transport protocol. This is the same protocol that is used
over direct serial connections to digitisers: BRP packets are simply encapsulated in
TCP packets. Details of the GCF format, the Scream protocol and the BRP protocol
are available in the Support \texttt{FAQs} section of our web site.

To request data from one of these BRP servers, right-click anywhere in the Servers
list of the My Client tab and select "Add TCP Server...". The "Add a TCP (serial) server"
dialogue opens. Type in the DNS name or IP address of the source followed by a
colon (':') and the source port number, which is usually 10002. Click \texttt{OK} and
the new server will appear in the "Servers" list.

To open a TCP connection to request data, right-click on the server entry and choose
"Connect" from the context menu or left-click on the entry and use the keyboard
shortcut \texttt{Ctrl} + \texttt{C}. The progress of the connection is shown in the "Command"
column of the servers list.

To request that data transmissions stop, right-click on the server entry and select
"Disconnect" from the context menu, or left-click on the entry and key \texttt{Ctrl} + \texttt{D}.

### 4.3.4 Requesting data over TCP links

In situations where UDP cannot be used, Scream! can also request data from
digitisers, digital instruments and acquisition units using the Scream transport
protocol over TCP.

\begin{warning}
\textbf{Note}: TCP is a connection-orientated protocol and has much higher
overheads than UDP, which is packet-orientated. UDP is normally
favoured.
\end{warning}
To request data from a server over a TCP link, right-click anywhere in the Servers list of the My Client tab and select "Add TCP Server...". The "Add a TCP (serial) server" dialogue opens. Type in the DNS name or IP address of the source followed by a colon (':') and the source port number, which is usually 1567. Click OK and the new server will appear in the "Servers" list.

To open a TCP connection to request data, right-click on the server entry and choose "Connect" from the context menu or left-click on the entry and use the keyboard shortcut Ctrl + C. The progress of the connection is shown in the "Command" column of the servers list.

To request that data transmissions stop, right-click on the server entry and select "Disconnect" from the context menu, or left-click on the entry and key Ctrl + D.

### 4.3.5 Requesting data from Multicast servers

Multicasting is a feature of TCP/IP which allows a server to send network packets to several clients at once. These are most often used on local networks. Multicast servers use addresses between 224.0.0.0 and 239.255.255.255. EAMs and NAMs, for example, always listen on the multicast address 239.193.15.67. (Mnemonic: 239.193 is in the privately-assignable block and 1567 is the default scream port.)

To request data from a multicast server, ensure that the "Receive UDP data" check-box is ticked, right-click anywhere in the Servers list of the My Client tab and select "Add UDP Server..." or use the keyboard shortcut Ins. The "Add GCF server dialogue opens". Enter the multicast address and click OK.

If you then right-click on the entry, the context menu has entries for Connect, Disconnect and GCFSEND:B.

- Selecting Connect instructs Scream! to join the multicast group with that address, and start listening to any servers transmitting to that address. If the server is running, data should begin appearing immediately.

- Selecting Disconnect makes Scream! leave the multicast group. You can be in several multicast groups simultaneously, and join or leave each one independently of the others.
You can also issue `GCFSEND` commands to the multicast address, to pull data from any compatible instruments that are on the local network (EAM, NAM, Affinity etc).

Keyboard shortcuts can also be used for these functions, as with other servers.

### 4.3.6 Detecting data sources

There are two methods to detect servers: DHCP snooping and Multicast.

#### DHCP snooping

DHCP snooping listens for DHCP broadcast packets to and from Güralp products, which can be identified from their MAC addresses. DHCP packets do not traverse routers, so this method only detects servers on the local network.

**Note:** DHCP snooping only works when Scream is running on a Windows PC or laptop. It is not available to Linux users.

To automatically find a network device on the local network using DHCP snooping, right-click anywhere in the *Servers* list box and select the option **Detect Servers …** from the context menu. This opens a dialogue box, and starts listening for DHCP traffic to/from Güralp products. Any servers detected are displayed in a list in the dialogue box. Select any device from the list and click **Add** to add it to the list of configured servers.

#### Multicast

When Scream! is first installed, the server list is pre-populated with an entry for the Güralp standard multicast address, `239.193.15.67`, with a comment of "Auto-detect instruments".

This address is used by EAMs, NAMs and *TDE instruments. It is part of the RFC 5771 "Administratively-scoped" address range, which means that its traffic can traverse suitably configured routers within an organisation, including VPN links over the public Internet.

**Caution:** Multicast traffic using this address cannot traverse the public Internet without explicit multicast routes or some form of packet encapsulation, such as a VPN link or SSH tunnel.

When Scream! starts, it sends a `GCFSEND:B` UDP packet to the multicast address. Any systems listening on this address respond with `GCFACKN` UDP packets. The control pane shows the addresses (and ports) of the responding systems and those systems will then start transmitting GCF data using the Scream protocol over UDP (although entries for them will not be created in the "Servers" list).
**Note:** A server that starts transmitting data because of a multicast GCFSEND will transmit GCF data from its "normal", unicast IP address (i.e. not the multicast address) to the "normal" unicast address of the PC running Scream. GCF data are not transmitted over the multicast link itself in this case, although multicast transmission can, in fact, be manually configured and used, if required. See section 7.2 on page 88 for details of multicast transmission.

In the example below, a GCFSEND was transmitted at 10:31, as indicated in the Control pane, and three servers responded immediately. The Block Rx pane shows that these three servers have started transmitting data.

**Note:** Windows and Linux handle static multicast routes differently from normal static routes. Users with multiple network interfaces should consult their operating system documentation if this feature does not behave as expected.
5 The Main Window

When you start Scream!, you will be shown an empty Main Window:

This will become populated once you start adding data sources.

The Main Window window is the controlling window for the instance. (It is possible to run many simultaneous instances provided that they have different initialisation files - see section 16.1 on page 177 for more details.) Scream!'s other windows can be opened and closed as you wish but, if you close the main window, the instance will exit.

Note: See section 15.1 on page 171 for a list of keyboard shortcuts that you can use in the main window.

5.1 The stream buffer

Scream! works by recording incoming streams into a fixed area of memory, called the stream buffer. All of Scream!'s operations work with the data in this buffer.

(When viewing recorded files, the file itself is used instead of the stream buffer, which allows much larger data-sets to be handled. View mode has a memory overhead of around 10% of the size of the recorded file(s): this is used to store summary information.)
When you start Scream! for the first time, this buffer is empty. You can add data to it either by receiving it from local serial ports, connecting to Scream! network servers, or replaying GCF files.

Once the stream buffer is full, Scream! will start discarding the oldest data. If you have not told Scream! to record the incoming streams (see Chapter 11 on page 135), then you will not be able to retrieve these discarded data.

**Note:** You can change the size of the stream buffer from the *Display* pane of the *Setup* window (see section 6.4.1 on page 82).

If you have enabled GCF recording, Scream! keeps track of the files which contain data in the stream buffer, and saves this information in a .lst file in a folder .display.lst under the current recording directory (set using the *Base Directory* item on the Files tab of the set-up dialogue). When Scream! is restarted, it reads this file and tries to rebuild the stream buffer as it was when it was shut down. Otherwise, the buffer starts off empty as before.

### 5.2 The source tree

The tree in the left panel of the Main Window shows all the data sources currently connected to Scream!, whether local instruments, networked instruments, or files being replayed.

Scream!’s source tree has two main parts: Files, which contains all the files you have replayed (including automatic replay: see section 11.2 on page 151), and Network, which represents your seismic network.

Beneath Network is a list of all the network servers Scream! is receiving data from, plus the entry Local for your computer’s own serial ports, if in use.
The next layer contains the serial ports themselves. These icons are provided to help you identify the instruments, as well as providing direct terminal access.

As an example, the screen shot above shows Scream! running on a computer which is not directly attached to any instruments, although it has a serial port labelled Com1. It receives data from two network sources: An EAM, EAM2243, and a PC, BANFF (which is sending its data via a system called JURAND).

The EAM has two serial ports, Port A and Port B, and BANFF has four serial ports, Com21, Com22, Com24 and Com25. Port A on the EAM is attached to instrument A808-4B15, Port B on the EAM is attached to instrument CD24-B73Q and Com21 on BANFF is attached to three instruments, BHCH3-4910, BHCH4-9669 and BHCH4-5095.

The EAM2243 server icon and the JURAND>BANFF server icon have been “unrolled” to reveal the serial port icons. You can “roll up” icons and save space by clicking on the box. This has been done to Com22, Com24 and Com25, where the box has been replaced by a which will unroll the sub-tree when clicked.

You can tell Scream! to ignore a particular instrument by right-clicking on its icon and selecting Ignore. When you do this, Scream! will discard any blocks it receives from the instrument. They will not appear in the stream buffer or be recorded to disk. Select Ignore again to stop ignoring the instrument. This setting is not remembered through stop/start of Scream.

Note: See section 15.1.2 on page 171 for a list of keyboard shortcuts that you can use in the source tree.

5.2.1 Icons

Instrument icons change colour to provide you with a quick overview of the instrument’s timing (top half) and mass position (bottom half) status:

If both halves of the instrument icon are grey, Scream! has not received any state of health information from the instrument since the program started.

If the top half is green, the instrument has reported a satisfactory timing fix.
Some digitisers might indicate an additional trimmed status with a purple top half, which is better than green. During normal operation, the icon might alternate between green and purple.

If the top half is yellow, the instrument has reported a degraded timing quality.
This will occur if the GNSS signal deteriorates to the point where the receiver cannot keep a lock on the satellites.

If the top half is red, the instrument has not reported a satisfactory timing fix for over an hour. This will happen if the instrument has reported failures (as above), but also if it has not reported anything. If you have set the GNSS system to power down.
for intervals longer than an hour, the icon will turn red even if the system is working normally.

*If the bottom half is red*, the instrument (or one of its components) is running with a mass position which exceeds a safe threshold. This threshold is set in the EMail tab of the Setup window - see section 13.2 on page 166 for details. You should re-centre the component, if possible, to avoid clipping during large ground movements.

*If the instrument appears as a green box*, the instrument has sent status blocks to Scream!, but no data. The box represents a Güralp CRM/SAM; these modules stored or forwarded data from other instruments, but occasionally produced status blocks themselves. If a digitiser produces a status block before any data, perhaps because you have configured very slow data rates, or are using FILING or DUAL transmission modes (see section 10.5 on page 126), it can appear with this icon temporarily.

### 5.3 The stream list

If *Network* is selected in the source tree, the right-hand panel will list all the data streams which Scream! receives (other than those which it is ignoring). If an entry in the source tree is selected, the stream list will only show the streams beneath that entry—selecting a serial port will only show streams from instruments connected to that port, and so on.

The first column contains the Stream ID. The other columns in the table provide useful information about each stream. A *System ID* and a *Stream ID*, together, uniquely identify a data stream. The Stream ID is encoded as described below.

![Stream ID Diagram](image)

**Note:** See section 15.1.3 on page 173 for a list of keyboard shortcuts that you can use in the stream list.

### 5.3.1 Stream IDs

A *Stream ID* is a unique name for the data stream, being a combination of six letters A – Z and numbers 0 – 9. The first four characters of this name identify the digitiser, and the last two characters identify the individual stream.
The first four characters are set by default to the serial number of the digitiser; you can change this on the System ID pane of the Configuration Setup window (see section 9.1 on page 109) or from the digitiser’s console.

The last two characters tell you the type, component, and output tap of the stream. The possible values for streams from CD24 and DM24 digitisers are given in the table below. The Affinity and Minimus digitisers add many more possible IDs: please see the relevant digitiser manual or the Support→FAQs section of our web site for further details.

<table>
<thead>
<tr>
<th>Suffix</th>
<th>Data source</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Main outputs (See note 1, below)</strong></td>
<td></td>
</tr>
<tr>
<td>Z0</td>
<td>SENSOR A, Vertical channel, 1st (fastest) tap</td>
</tr>
<tr>
<td>Z2</td>
<td>SENSOR A, Vertical channel, 2nd tap</td>
</tr>
<tr>
<td>Z4</td>
<td>SENSOR A, Vertical channel, 3rd tap</td>
</tr>
<tr>
<td>Z6</td>
<td>SENSOR A, Vertical channel, 4th (slowest) tap</td>
</tr>
<tr>
<td>N0, N2, N4, N6</td>
<td>SENSOR A, North/South channel, 1st to 4th tap, respectively</td>
</tr>
<tr>
<td>E0, E2, E4, E6</td>
<td>SENSOR A, East/West channel, 1st to 4th tap, respectively</td>
</tr>
<tr>
<td><strong>Mass positions</strong></td>
<td></td>
</tr>
<tr>
<td>M8</td>
<td>SENSOR A, Vertical channel, mass position output</td>
</tr>
<tr>
<td>M9</td>
<td>SENSOR A, North/South channel, mass position output</td>
</tr>
<tr>
<td>MA</td>
<td>SENSOR A, East/West channel, mass position output</td>
</tr>
<tr>
<td><strong>Metadata and text streams</strong></td>
<td></td>
</tr>
<tr>
<td>00</td>
<td>The status stream</td>
</tr>
<tr>
<td>IB</td>
<td>The contents of the information blocks (only sent at boot-up or on request). See section 5.7 on page 39 for details.</td>
</tr>
<tr>
<td>BP</td>
<td>Byte-pipe data (from text-to-GCF converters)</td>
</tr>
<tr>
<td>01</td>
<td>Unified status (structured state-of-health information)</td>
</tr>
<tr>
<td>CD</td>
<td>Structured status for CD1.1 (obsolete)</td>
</tr>
<tr>
<td><strong>Second instrument, main outputs (See note 2, below)</strong></td>
<td></td>
</tr>
<tr>
<td>Z1, Z3, Z5, Z7</td>
<td>SENSOR B, Vertical channel, 1st to 4th tap, respectively</td>
</tr>
<tr>
<td>N1, N3, N5, N7</td>
<td>SENSOR B, North/South channel, 1st to 4th tap, respectively</td>
</tr>
<tr>
<td>E1, E3, E5, E7</td>
<td>SENSOR B, East/West channel, 1st to 4th tap, respectively</td>
</tr>
<tr>
<td><strong>Auxiliary inputs and calibration returns</strong></td>
<td></td>
</tr>
<tr>
<td>X0</td>
<td>SENSOR A, Auxiliary input, 1st (fastest) tap</td>
</tr>
<tr>
<td>X2</td>
<td>SENSOR A, Auxiliary input, main output, 2nd tap</td>
</tr>
<tr>
<td>X4</td>
<td>SENSOR A, Auxiliary input, main output, 3rd tap</td>
</tr>
<tr>
<td>X6</td>
<td>SENSOR A, Auxiliary input, main output, 4th (slowest) tap</td>
</tr>
<tr>
<td>C0</td>
<td>SENSOR A, Calibration signal return, 1st (fastest) tap</td>
</tr>
<tr>
<td>C2</td>
<td>SENSOR A, Calibration signal return, 2nd tap</td>
</tr>
<tr>
<td>C4</td>
<td>SENSOR A, Calibration signal return, 3rd tap</td>
</tr>
<tr>
<td>C6</td>
<td>SENSOR A, Calibration signal return, 4th (slowest) tap</td>
</tr>
<tr>
<td>Suffix</td>
<td>Data source</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>MB</td>
<td>SENSOR A, multiplexed input B (used as calibration signal return on early digitisers)</td>
</tr>
<tr>
<td>MC</td>
<td>SENSOR A, multiplexed input C</td>
</tr>
<tr>
<td>MD</td>
<td>SENSOR A, multiplexed input D</td>
</tr>
<tr>
<td>ME</td>
<td>SENSOR A, multiplexed input E (connected to an internal thermometer on some models)</td>
</tr>
<tr>
<td>MF</td>
<td>SENSOR A, multiplexed input F</td>
</tr>
<tr>
<td>ZG</td>
<td>SENSOR A, Vertical channel, triggered output, 1&lt;sup&gt;st&lt;/sup&gt; (fastest) tap</td>
</tr>
<tr>
<td>ZI</td>
<td>SENSOR A, Vertical channel, triggered output, 2&lt;sup&gt;nd&lt;/sup&gt; tap</td>
</tr>
<tr>
<td>ZK</td>
<td>SENSOR A, Vertical channel, triggered output, 3&lt;sup&gt;rd&lt;/sup&gt; tap</td>
</tr>
<tr>
<td>ZM</td>
<td>SENSOR A, Vertical channel, triggered output, 4&lt;sup&gt;th&lt;/sup&gt; (slowest) tap</td>
</tr>
<tr>
<td>NG, NI, NK, NM</td>
<td>SENSOR A, North/South channel, triggered output, 1&lt;sup&gt;st&lt;/sup&gt; to 4&lt;sup&gt;th&lt;/sup&gt; tap, respectively</td>
</tr>
<tr>
<td>EG, EI, EK, EM</td>
<td>SENSOR A, East/West channel, triggered output, 1&lt;sup&gt;st&lt;/sup&gt; to 4&lt;sup&gt;th&lt;/sup&gt; tap, respectively</td>
</tr>
<tr>
<td>ZH, ZJ, ZL, ZN</td>
<td>SENSOR B, Vertical channel, triggered output, 1&lt;sup&gt;st&lt;/sup&gt; to 4&lt;sup&gt;th&lt;/sup&gt; tap, respectively</td>
</tr>
<tr>
<td>NH, NJ, NL, NN</td>
<td>SENSOR B, North/South channel, triggered output, 1&lt;sup&gt;st&lt;/sup&gt; to 4&lt;sup&gt;th&lt;/sup&gt; tap, respectively</td>
</tr>
<tr>
<td>EH, EJ, EL, EN</td>
<td>SENSOR B, East/West channel, triggered output, 1&lt;sup&gt;st&lt;/sup&gt; to 4&lt;sup&gt;th&lt;/sup&gt; tap, respectively</td>
</tr>
<tr>
<td>XH, XJ, XL, XN</td>
<td>Auxiliary channel, triggered output, 1&lt;sup&gt;st&lt;/sup&gt; to 4&lt;sup&gt;th&lt;/sup&gt; tap, respectively</td>
</tr>
</tbody>
</table>

**Strong motion and Causal-filtered (low-latency) data** *(See note 3, below)*

| ZO, NO, EO | Windowed minimum for Vertical, North/South and East/West, respectively |
| ZO | Windowed minimum for two-dimensional, horizontal resultant |
| ZO | Windowed minimum for three-dimensional (3D) resultant |
| ZP, NP, EP, 2P, 3P | Windowed PGA for Vertical, North/South, East/West, horizontal resultant and 3D resultant, respectively |
| ZQ, NQ, EQ, 2Q, 3Q | Windowed maximum for Vertical, North/South, East/West, horizontal resultant and 3D resultant, respectively |
| ZR, NR, ER, 2R, 3R | Windowed RMS for Vertical, North/South, East/West, horizontal resultant and 3D resultant, respectively |
| ZS, NS, ES, 2S, 3S | Windowed spectral intensity for Vertical, North/South, East/West, horizontal resultant and 3D resultant, respectively |
| ZT, NT, ET, 2T, 3T | Windowed average for Vertical, North/South, East/West, horizontal resultant and 3D resultant, respectively |
| ZC, NC, EC | On an S6 digitiser, SENSOR A, Causal-filtered (low-latency) data for Vertical, North/South and East/West, respectively |
### 5.3.2 Other columns

The other columns of the Stream List are:

- **Rec.** Whether Scream! is currently recording the data stream to the computer’s on-board hard disk (not the digitiser’s memory). If another device on your network is recording the data stream independently of Scream!, the entry in this column might still be *No*. If this entry shows *ERR*, then there has been an error whilst writing data for this stream. Investigate the cause, then re-enable recording to clear the error. By default, an automatic retry will occur every 30 seconds.

A ‘*’ symbol might appear when recording is enabled. This indicates that some data has not been written – recording has been deferred because of a gap in the stream buffer contents. See Chapter 11 on page 135 for more information.

Right-clicking on an entry in this column brings up a context menu which allows you to stop or start recording the selected stream. The selection is
stored in the `scream.rec` file (see section 16.3 on page 179) so that, if `scream` is subsequently set to automatically record all streams (see section 11.1.1 on page 136), the original, manual selection can be restored if the automatic option is later deselected.

- **Comp.**: The compression factor of the data in the stream, expressed as the number of bits occupied by each record (8, 16 or 32 bits). This can vary block-by-block.

- **SPS**: The sampling rate of the data stream, in samples per second. Status streams, ending in 00, do not constantly output data and have an *SPS* of 0. By default, the stream list is sorted in order of sample rate, with the status streams at the bottom.

- **End time and Date**: the date and time of the most recent data, as measured by the data’s own time-stamps. These are *not* necessarily the latest to arrive.

- **RIC**: The ‘Reverse Integrating Constant’. In effect this is the value of the last sample received. This is most useful for reading mass positions or other environmental streams. Status streams have a RIC of N/A.

If a stream is currently recording, on Windows the option ”Explore Recording Folder” will open a Windows Explorer window at the folder where the data are currently recorded. This is useful to quickly browse to the recorded files.

### 5.3.3 Sorting options

Sorting options are available from the *View → Sort By* menu:

- **Alphabetical**: Strict alphabetical order, 0 – 9 then A(a) – Z(z).

- **Component**: Vertical components (ending Zx), followed by Nx and Ex components, then Mux channels Mx. Within a component type, sort by the first four characters of the Stream ID.

- **Instrument**: Sort by the first four characters of the Stream ID. Within an instrument, sort by tap, then by component.

- **Sample Rate**: Sort by sample rate, highest to lowest. Within a sample rate, sort as Instrument.

- **Tap**: Sort by tap (the last character of the Stream ID). Within a tap, sort by instrument, then by component.

Select the Reversed option to reverse any of these sort orders.

You can also sort the list by *Stream ID* or *SPS* by clicking on the relevant heading; click again to reverse the sort order.
5.4 The status bar

At the bottom of Scream!'s Main Window is a status bar containing summary information about Scream!'s state:

- The server address from where the data for the currently selected instrument is being received;
- If no streams are selected, the number of different data streams currently accessible from the window, including those that have been "rolled up"; If any stream selection is in force (including a selected digitiser or port), the total number of streams selected;
- The amount of memory currently being used by Scream!'s stream buffer. You can change the maximum size of the stream buffer from the Setup window (see section 6.4.1 on page 82).

![Note: If this number approaches the capacity of your computer, the computer may become slow and unresponsive.]

- The current time after your time-zone is removed, according to the local computer (not the timestamps of incoming data).

To disable or re-enable the status bar, deselect View → Status Bar on the menu.

5.5 Viewing streams

Double-click on one of the streams to open a window for viewing the data, or right-click on it and select View... Alternatively, make a selection of streams from the list and then either double-click on the selection or key .

- To select an adjacent range of streams, left-click on the first and then on the last.
- To select a non-adjacent set of streams, left-click on the first and then Ctrl + on each additional stream.
The selected data streams are opened in a *WaveView* window:

This window allows you to see real-time data coming in. You can also pause the window and examine any features held in the stream buffer. For full information on the features provided by *WaveView* windows, see Chapter 6 on page 45.

Status streams (ending 00) consist of plain text. Double-clicking on a status stream produces the *Status* window:

The first blocks transmitted by a digitizer after power-up will give the boot message from the digitiser, including its software revision and the data streams selected for downloading and triggering. Later blocks give information on visible GNSS satellites, the location of the GNSS antenna and time synchronization status. Also displayed are the baud rates currently used for each channel and for the data link.

For more information on status streams and GNSS, see section 8.2 on page 95.
5.6 Connecting to instruments

There are two basic user interface types for the control and configuration of Güralp digitisers:

1. Built into Scream, for products based on the DM24 and CD24 modules,
2. The web interface of the device itself, for network-connected products containing EAM, NAM, Affinity, Minimus etc modules.

Some products contain both types of module (e.g. DM24xExEAM), where either interface can be used. However, the interfaces are not universally interchangeable, so the operator should choose to use one or the other, but not to mix both.

This section mainly discusses the interface for the above-mentioned type 1 modules. For type 2 – right-click on the computer icon in the source tree and select Open Web Browser. Under Windows, this will open a web page in your default browser, referencing the sending network address as a URL. Under Linux, the command `firefox` is invoked with the URL as an argument. See the product-specific documentation for more information on it's web interface.

Digitiser configuration (and other common operations) for DM24 and CD24 modules can be performed from Scream! by right-clicking on the digitiser in the source tree and selecting Configure… or Control… See Chapter 9 on page 108 and Chapter 10 on page 121 for more information.

Scream! also allows you to access the serial terminal of a connected DM24 or CD24 digitiser in order to issue commands directly. To do this, right-click on it and select Terminal…. See section 8.1 on page 92 for more information about Scream!'s built-in terminal emulator.

An instrument may connected to Scream! through a series of other units (NAMs, EAMs etc). Scream! will negotiate with each unit in turn to reach the instrument you are interested in. However, the process may take a little time.

Right-clicking on a digitiser and selecting Triggers… brings up a window describing all the digitiser triggers that have been detected. This window can also be reached from the Summary window: see section 8.3 on page 102 for more information.

5.7 Calibration data

Scream! can display data streams from displacement, velocity, and acceleration sensors in physical units. To be able to do this, it needs to know the calibration information provided with the sensor and digitiser.
Newer Güralp digitisers transmit calibration information in an *information block* (or *InfoBlock*) when they reboot. When Scream! receives an information block that it understands, it automatically extracts this information and remembers it.

You can also enter and edit calibration information manually. Right-click on the digitiser’s icon and select **Calvals…** A window will open with a text entry box. This window lets you edit Scream!'s calibration values file.

Fill in the text box with calibration information for your digitiser and the instrument connected to it, in the format described below.

- To set the serial number of the instrument, include the line
  
  `Serial-Nos=serial-number`

  Scream! cannot tell what instrument is connected to the digitiser. This line is provided to help you remember which set of calibration values you have used, and to provide a title for calibration graphs. If you attach a different instrument to the same digitiser, you will need to enter new calibration values to reflect the new instrument.

- To set the sensitivity of the digitiser, include the line
  
  `VPC=Z-sensitivity,N-sensitivity,E-sensitivity`

  \( VPC \) stands for *voltage per count*, measured in units of \( \mu V/\text{count} \). This is sometimes given as \( \mu V/\text{Bit} \) on the digitiser calibration sheet.

- To set the sensitivity of the calibration channel, include the line
  
  `CALVPC=sensitivity`

  as for the other digitiser channels.

- To set the value of the calibration resistor, include the line
  
  `CALRES=resistance`
Güralp Systems seismometers (velocimeters) digitisers normally use a 51 kΩ resistor (CALRES=51000). For accelerometers, you should enter CALRES=1 here.

- To set the sensor type, include the line

  ```
  TYPE=model-number
  ```

  *e.g. 3T, 5T etc.*

- To set the response of the sensor, include the line

  ```
  RESPONSE=response-type unit
  ```

Some of the values you can use are given in the table below. If none of these match the response of your instrument, please contact support for advice.

<table>
<thead>
<tr>
<th>Sensor</th>
<th>Sensor type code</th>
<th>Units (V/A)</th>
</tr>
</thead>
<tbody>
<tr>
<td>5T or 5TD, DC – 100 Hz response</td>
<td>CMG-5_100HZ</td>
<td>A</td>
</tr>
<tr>
<td>40T-1 or 6T-1, 1 s – 100 Hz response</td>
<td>CMG-40_1S_100HZ</td>
<td>V</td>
</tr>
<tr>
<td>40T-1 or 6T-1, 2 s – 100 Hz response</td>
<td>CMG-40_2S_100HZ</td>
<td>V</td>
</tr>
<tr>
<td>40T-1 or 6T-1, 10 s – 100 Hz response</td>
<td>CMG-40_10S_100HZ</td>
<td>V</td>
</tr>
<tr>
<td>40T, 20 s – 50 Hz response</td>
<td>CMG-40_20S_50HZ</td>
<td>V</td>
</tr>
<tr>
<td>40T, 30 s – 50 Hz response</td>
<td>CMG-40_30S_50HZ</td>
<td>V</td>
</tr>
<tr>
<td>3T or 3ESP, 30 s – 50 Hz response</td>
<td>CMG-3_30S_50HZ</td>
<td>V</td>
</tr>
<tr>
<td>40T, 60 s – 50 Hz response</td>
<td>CMG-40_60S_50HZ</td>
<td>V</td>
</tr>
<tr>
<td>3T or 3ESP, 60 s – 50 Hz response</td>
<td>CMG-3_60S_50HZ</td>
<td>V</td>
</tr>
<tr>
<td>3T or 3ESP, 100 s – 50 Hz response</td>
<td>CMG-3_100S_50HZ</td>
<td>V</td>
</tr>
<tr>
<td>3T or 3ESP, 120 s – 50 Hz response</td>
<td>CMG-3_120S_50HZ</td>
<td>V</td>
</tr>
<tr>
<td>3T, 360 s – 50 Hz response</td>
<td>CMG-3_360S_50HZ</td>
<td>V</td>
</tr>
<tr>
<td>3TB or 3V / 3ESP borehole, 30 s - 50 Hz response</td>
<td>CMG-3B_30S_50HZ</td>
<td>V</td>
</tr>
<tr>
<td>3TB or 3V / 3ESP borehole, 100 s – 50 Hz response</td>
<td>CMG-3B_100S_50HZ</td>
<td>V</td>
</tr>
<tr>
<td>3TB or 3V / 3ESP borehole, 120 s – 50 Hz response</td>
<td>CMG-3B_120S_50HZ</td>
<td>V</td>
</tr>
<tr>
<td>3TB or 3V / 3ESP borehole, 360 s – 50 Hz response</td>
<td>CMG-3B_360S_50HZ</td>
<td>V</td>
</tr>
<tr>
<td>3TB or 3V / 3ESP borehole, 360 s – 100 Hz response</td>
<td>CMG-3B_360S_100HZ</td>
<td>V</td>
</tr>
</tbody>
</table>
Some shorthand descriptions are also accepted, *e.g.* 120s velocity, or 100Hz acceleration but *this is not a free-format, parsed field.*

- To set the sensitivity (or gain) of the sensor components, include the line

  \[ G=Z\text{-sensitivity}, N/S\text{-sensitivity}, E/W\text{-sensitivity} \]

  These values are given on the sensor calibration sheet. For velocity sensors, they are given in units of V / ms\(^{-1}\). The gain of an accelerometer is expressed in V / ms\(^{2}\). Because Güralp sensors and digitisers use differential inputs and outputs, the sensitivity is quoted as \(2 \times\) (single-ended sensitivity) on the calibration sheet.

- To set the coil constants of the sensor components, include the line

  \[ \text{COILCONST}=Z\text{-constant}, N/S\text{-constant}, E/W\text{-constant} \]

  These values are given on the sensor calibration sheet.

- To set the local acceleration due to gravity, include the line

  \[ \text{GRAVITY}=\text{acceleration} \]

  You should give this value in ms\(^{-2}\), if you know it. If you miss out this line, Scream! will use a standard average \(g\) value of 9.80665 ms\(^{-2}\).

When you have filled in all the values, click [Save].

Any *WaveView* windows that are open will change to show streams in physical units. New *WaveView* windows will also use these units where possible.

**Note:** If an instance of Scream is receiving data forwarded by another copy of Scream, it will request an InfoBlock from the upstream instance if it receives data from a source for which it has no calibration information.
5.7.1 Example

The calibration information for a 3T weak-motion velocity sensor might look like the following:

```
Serial-Nos=T3X99
VPC=3.153, 3.147, 3.159
G=1010, 1007, 1002
COILCONST=0.02575, 0.01778, 0.01774
CALVPC=3.161
CALRES=51000
TYPE=CMG-3T
RESPONSE=CMG-3_30S_50HZ V
GRAVITY=9.80122
```

Note: 5TC accelerometers use 1 Ω calibration resistors, and their coil constant is set to 1.

For information on the file, `calvals.txt`, which stores these values, see section 16.2 on page 178.

5.7.2 Six-channel digitisers

When working with six-channel digitisers, you have a choice:

- You can keep a single serial number for both instruments. In this case, the VPC, G and COILCONST lines need to have six comma-separated values each and the CALRES and RESPONSE entries also need double-values; or

- You can configure a second serial number into the digitiser for use with SENSOR B. In this case two separate sets of information are required; one for each serial number.

Other than the stream names, the effects of both methods are identical so you should decide based on whether having two serial numbers appears natural in your application or not.

You can programme a second serial number:

- using Scream (see section 9.1 on page 109);

- using an EAM or NAM (see section 8.1.1.1 of the EAM manual); or
5.8 Other features

The main menu also provides some miscellaneous facilities:

Choose **File → Save Program State** to save Scream!'s configuration file immediately. This file is read whenever you start Scream!, and any changes are written back whenever you close it. Under Microsoft Windows, the configuration file appears as `scream.ini` in the `c:\scream` directory; under Linux, it is saved in `$HOME` if this variable is set, otherwise the same directory as the Scream! program file. You can change the name and location of the configuration file with a command line option (see section 16.1 on page 177).

Choose **File → Application Caption...** to change the title of Scream!'s Main Window. This is useful if you have several copies of Scream! running on the same computer (e.g. to run multiple network services).

Choose **View → Stay On Top** to keep Scream!'s Main Window on top of all other Scream! windows at all times. Other applications may still cover Scream!'s Main Window.
6 WaveView windows

The most commonly used features of Scream! are accessed through WaveView windows. You can open as many WaveView windows as you like, on any combination of streams; the same stream can be part of several WaveView windows at once, at several different scales.

To open a WaveView window from Scream!'s Main Window, either:

- select Window → New WaveView Window… from the main menu;
- double-click on a stream ID in the streams list;
- right-click on a stream in the list and select View; or
- make a selection of streams and double-click the selection or key:
  - To select a range of adjacent streams, left-click () on the first and then () on the last.
  - To select a non-adjacent set of streams, left-click () on the first and then (Ctrl) + () on each additional stream.
You can add additional streams to the WaveView window by selecting them from the streams list and dragging the selection into the WaveView window, or by dragging them from other WaveView windows. Dragging with Ctrl held down will copy the stream from one window to another; otherwise, the stream will be moved to the new window.

If you are running Scream! in real-time mode, and you double-click on a GCF file to view it (or open the Scream! viewer in some other way), you will have both real-time and “view” windows open. In this case, you can drag streams from real-time windows to other real-time windows, but not from these to view windows, or from view windows to other view windows. This is because the windows are handled by different instances of the Scream! program.

You can also drag streams within a WaveView window to reorder them. You will need to drag from the panel on the left, since dragging across the window will zoom in; see below.

To the left of the stream display is a panel identifying the stream by its System ID and Stream ID, or by another label if you have set one (see section 6.4.2 on page 83). If calibration values have been supplied (see section 5.7 on page 39), the units of measurement will also be shown. If there is insufficient space, this text can become small or be omitted entirely. In this case, you can resize the panel by dragging its right-hand edge across the WaveView window, as shown in the illustration below. You can also hide the panel completely by dragging its right-hand edge to the left of the WaveView window.
If you have several *WaveView* windows open, the **Windows** menu in Scream!'s Main Window allows you quickly to bring focus to any of them. This is particularly useful if you have given the windows labels, as described in section 6.1.8 on page 58:

### 6.1 Window functions

Above the stream display is a toolbar, containing icons which act on all of the streams within the window.
On the right of the toolbar, the time and date is displayed (when space is available). This is the time corresponding to the right-edge of the stream display window. Right-clicking on the date will toggle between displaying the date in year/month/day format and year/Julian-day format.

### 6.1.1 Zooming in and out

To zoom in and out vertically, either:

- click the vertical scale icons at the top of the window;
- use your mouse wheel;
- left- or right-click on the number itself.

The current zoom factor is shown between the icons, as a ratio of pixels to counts. Zooming in and out affects every stream in the window.

To zoom in and out horizontally, either:

- click the horizontal scale icons;
- hold down the shift-key whilst turning your mouse wheel;
- left- or right-click on the number itself; or
- select the data by left-clicking and dragging the mouse. Release the mouse and select “Zoom In” from the context menu.

The current zoom factor is shown between the icons, in pixels per second. To convert to pixels per sample, divide the zoom factor by the sample rate for the stream. Where several samples are shown in a single horizontal pixel-width, a vertical line is plotted between the lowest and the highest sample values.

If you have a large window which takes some time to scroll, especially at a high horizontal zoom factor, Scream! may not be able to finish drawing new data before it needs to scroll again. If this happens, Scream! will delay scrolling until it can display in real time once more. To prevent this, decrease the time scale.

If you have paused the window with the icon when paused), you can zoom into an area of interest by dragging a rectangle across the streams. While you are dragging, Scream! displays the time span in the top right corner of the rectangle, and the number of counts in the bottom left corner. You can drag across one stream, or several; the resulting window will still include all streams.

Whilst the window is paused, you can also adjust the start and end times of the view by dragging the ends of the horizontal scroll bar button, at the bottom of the window.
6.1.2 Making measurements

Click the **Time Cursors** or **Ampl Cursors** button to display a pair of horizontal (time) or vertical (amplitude) cursors. Each cursor has a square at one end, which can be dragged across the *WaveView* window to measure features. If two cursors coincide, you will only be able to see the squares.

The distance between the cursors replaces the labels of the **Time Cursors** or **Ampl Cursors** button, in seconds and Hertz or counts. You can have both vertical and horizontal cursors active at the same time. Because the limit of accuracy of the cursors is one pixel, you should zoom in to the range of interest for greater accuracy.

The **Ampl Cursors** measure distances in counts according to the current zoom settings. However, if you have applied a scaling factor to an individual stream (see below), the **Ampl Cursors** do *not* take this scaling into account, so the measured distance will no longer be in digitiser counts; they will be in the scaled units of the stream.

To obtain the true value in counts, divide the value displayed in the **Ampl Cursors** icon by the scale factor for that stream, as displayed beneath its ID on the left-hand panel.
If a stream is shown with a physical unit (e.g. nm s⁻¹), Scream! has scaled it so that the **Ampl Cursors** display a value in that unit. To do this, Scream! needs to know the calibration values - i.e. the sensitivities of your digitiser and instrument (see section 5.7 on page 39).

It is also possible to take absolute measurements. The values obtained in this way are affected by any offset in place, as described in section 6.2.4 on page 67, so these should be zeroed before you start. You can use the `Ctrl + 0` keyboard shortcut to set the offset of every stream to zero. If you wish to reset the offset of a single stream to zero, hover the mouse over its lane and use the `0` keyboard shortcut.

Zeroing an offset may cause the stream to move vertically such that it is no longer in its lane or even visible in the *WaveView* window. You can bring the waveform back into view by decreasing the amplitude, using the rightmost of the vertical scale icons at the top of the window or by scrolling the mouse wheel downwards.

**Note:** Zeroing an offset is different from nulling an offset. Zeroing an offset sets its value to zero so that absolute measurements can be taken. Nulling an offset centres the waveform vertically in its lane by setting the offset such that the mean value of the waveform (over the time period displayed in the window) is zero.

Once you have removed the offsets, you can measure detailed, absolute sample values, by holding `Alt` whilst performing a click-&-drag action. A hint box will display the exact time of the sample and its value. This is always displayed in counts but values in physical units are also given if calibration info is loaded (see section 5.7 on page 39). If the time scale is zoomed out such that multiple samples are on the same pixel, the maximum and minimum values for that pixel will be displayed:

**6.1.3 Printing**

To print the data currently being displayed in the *WaveView* window, click on the **Print** icon. Scream! will use the current default printer settings to print a full
page view of the window, using the current amplitude and time scaling, filtering and other display options. You can print at any time, in either real-time or paused mode.

Extra print options are available in the drop-down menu of the **Print** icon:

![Print Options Menu]

To print the same data in black and white (on a colour or grey-scale printer), click on the arrow beside the **Print** icon and select **Page Print (monochrome)** from the drop-down menu. Black and white output is more suitable for copying or faxing.

You can also set up Scream! to print automatically, or send data directly to a connected plotter. For full details on the printing options available in Scream!, see Chapter 12 on page 157.

**Note:** The “print” facility is a good way to produce PDF outputs of waveforms, by using a PDF printer-driver (e.g. PDFcreator).
6.1.4 Selecting data

Data can be selected from WaveView windows for use in a number of situations, including saving, processing and helping design filter responses.

It is sometimes helpful to pause the window before selecting data, as described in section 6.1.6 on page 55. It is not, however, necessary.

Data selections can encompass one, two or more streams but the start and end times of the selection are the same across all streams.

When selecting from more than two streams, the streams must be adjacent in the WaveView window and the order in which the streams are presented is always top to bottom. If you need a different order, you can drag individual streams up and down the WaveView window to re-order them, or duplicate the entire window (keyboard shortcut Ctrl + D) and delete any unwanted streams. When selecting from exactly two streams, you can choose the order.

Selecting data from one stream or several adjacent streams

To select data from one stream or several adjacent streams, hold down the Shift key ( ), click at the desired start-time in the first stream and then, while still holding the Shift key, drag to the desired end-time in the last stream:

![WaveView window](image)

The number of samples selected is shown at the top left of the selection.
If the region you have selected is entirely filled with contiguous data, the selection is shown as a solid block. If there are gaps or overlaps in any stream, the selection is shown in a hatched style:

![WaveView window](image)

**Note:** If you are selecting multiple streams in order to process their data in an add-on, such as one of the calibration scripts, note that the selected streams will always be presented to the script in top-to-bottom order, even if you dragged the mouse upwards. If this is not the order that you want, rearrange the streams in the WaveView window (by dragging their stream IDs up or down the left-hand panel) before selecting the streams.

**Selecting data from exactly two streams**

Select data from two (possibly non-adjacent) streams by holding down the Control key (Ctrl), clicking at the desired start-time in the first stream and then, while still holding down the Control key, dragging to the desired end-time in the second stream:
The number of samples selected is shown at the top left of the selection.

**Note:** If you are selecting two streams in order to process their data in an add-on, such as one of the calibration scripts, note that the selected streams will always be presented to the script in the order in which you click them, regardless of their position in the *WaveView* window.

## 6.1.5 Filtering

Clicking the **Filter** icon (or when selected) makes Scream! apply a filter to each of the displayed streams. Click the icon again to disable the filter.

Scream! can be configured to apply different filters to each *WaveView* window. To select the filter, click on the arrow beside the **Filter** icon. A drop-down menu will appear:

![Filter Options Menu](image)

From this menu:

- Select **Default filter** to apply Scream's built-in FIR bandpass filter. The properties of this filter depend on the sample rate of the stream. Data at 1 or 2 samples per second are filtered with a 10 – 30 second pass-band, whilst data at other sample rates are filtered with corner frequencies at 0.1 and 0.9 times the Nyquist frequency of the stream. For example, the pass band for the filter applied to a stream at 100 samples per second will be 5 – 45 Hz.

- Select **Custom filter** to activate the filter you have designed. If you have not designed a filter, a 10 – 30 second pass band filter will be used for all sample rates.

- Select **Design…** to open the *Filter Design* window (see section 6.3 on page 73).

- If you have saved some filter designs as presets (see section 6.3.5 on page 81), they will be listed below **Design…**. Select an entry to switch to a **Custom filter** with these settings.

- If you have saved some filter designs as presets, a **Delete preset** sub-menu will also appear. Select an entry in this sub-menu to delete that filter definition.
6.1.6 Paused mode

Click the **Pause** icon (or **Pause Break** when selected) or use the **Pause** shortcut key to stop the window scrolling. If new blocks arrive which contain data from the time period displayed, Scream! will add them to the window.

Whilst a window is paused, you can scroll the waveform to the left or right to view all the data that Scream! has in memory. This can be done dragging the horizontal scroll bar at the bottom of the window to the left or right or by turning the mouse wheel while holding down the **Ctrl** key.

You can also drag either **edge** of the horizontal scroll-bar in order to change the degree of zoom, as shown below:

![WaveView window](image)

**Note:** Because new data are still being added to the memory buffer, the scroll bar will move slowly to the left when the display is paused.

All of the following options are also available without pausing the display but it is often easier to pause the window first. You can:

- Use the mouse-wheel to zoom in and out to examine features in the data.
  Hold the Shift key while using the mouse wheel to zoom in and out in the time series, centred on the mouse position.
- Select data as described in section 6.1.4 on page 52.
- Clear any selections and re-draw the display by keying **F5**. (This also cancels any stream-positioning functions and recomputes the display cache so it can be a little slow when very large amounts of data are displayed.)
- Use data in a filter design by selecting data from a single stream and choosing **Use in Filter Design**... from the pop-up menu. See section 6.3 on page 73 for details.
• Pass data to a Scream! extension by selecting data as described in section 6.1.4 on page 52 and choosing the required extension from the pop-up menu. See Chapter 14 on page 168 for more details.

• Save data to a file by selecting data as described in section 6.1.4 on page 52 and choosing Save…:

Select the directory and format for the file, and click OK to save the data with one file for each stream (using the format shown).

Some formats support multiple streams per file. For these formats, you can select Single File to combine the streams. See section 11.1.1 on page 136 for details about the various file formats.

Click the Pause icon ( ) again (or key ) to return to real-time mode. If you have changed the zoom settings, the window will return to its previous state, with the window once more following the real-time data.
6.1.7 Other icons

Click the **Block Boundaries** icon to display a dotted line at the end of every GCF block displayed in the window:

The number beside each line is the number of bits used to store each sample in the block. A fixed-length GCF block with 8-bit samples (which can encode differences from -128 to +127) can store 4 times as many samples as a block using 32 bits for each one (encoding differences larger than two billion counts). Clicking the icon again removes the block markers. Block markers can also show icons for re-boots ( ) and re-syncs ( ) when reports of these are detected in the associated status stream.

Click the **Null Offsets** icon or use the `Ctrl + N` keyboard shortcut to centre each stream vertically in its lane. This is done by adjusting the offsets such that the mean value of the waveform (over the time period displayed in the window) is zero. If you do not want a particular stream to be zeroed when you click this icon, right-click on the stream beforehand and select **Locked Offset** from the context menu. If you wish to null the offset of a single stream, move the mouse into its lane and use the `N` keyboard shortcut.

**Note:** Nulling an offset is different from zeroing an offset. Nulling an offset centres the waveform vertically in its lane. Zeroing an offset sets the offset value to zero so that absolute measurements can be taken, as described in section 6.1.2 on page 49.

The **Locked Offset** option for a stream prevents nulling its offset but does not prevent zeroing its offset when the user keys `0` (zero a single stream) or `Ctrl + 0` (zero all streams).
When Scream! is used as a data viewer, the **Pause** icon (вшего) is replaced with the **Restore View** icon (реставрация). Click this icon to reset the time and amplitude zoom settings to their initial values - *i.e.* to display the entire selected data set within the window.

### 6.1.8 Context menu

Right-clicking inside a *WaveView* window brings up a context-sensitive menu in two sections, divided by a horizontal line:

The upper section of this menu contains options which affect a particular stream. These are described in section 6.2 on page 64. Options in the lower section affect the whole window and are described here.

**Note:** Many of these menu options have associated shortcut keys, which are shown to the right of the respective entry. It is not necessary to right-click and display the menu in order to use any of the shortcut keys listed in this section.

Select **Background Colour**... to change the background colour for the window.
Select **Show Lane Lines** to toggle the drawing of the lane boundaries, zero reference lines and time reference lines:

![WaveView window](image)

Select **Label...** to change the title of the window. This also changes the name of the window’s entry in Scream’s **Windows** menu and the name that is used on print-outs (see Chapter 12 on page 157).

Select **Clear Window** to remove all streams from the window. This does not remove the streams from memory; you can retrieve them by dragging from Scream’s Main Window onto the now-empty *WaveView* window.

Select **No Caption** to remove the title decoration and toolbar from the window. To maximise the screen area occupied by streams, first maximise the *WaveView* window, then choose **No Caption**. You can still use the mouse wheel or keyboard shortcuts (see Chapter 15 on page 171) to perform the actions of icons on the toolbar.

Select **Duplicate** to open a new *WaveView* window identical to the current one. (If you have renamed a stream using Stream Name Mapping, the new window will use the new name.)

**Note:** Duplication can be particularly helpful when a *WaveView* window has taken a long time to load due to the amount of data involved. You can create a duplicate and delete streams from it (in order to focus on something of interest) and then discard it. You can repeat these operations multiple times without having to reload the data again. The `Ctrl + D` keyboard shortcut makes this particularly easy.
The **Axis Spacing** sub-menu has a number of options:

- **Normal** (F5 keyboard shortcut) – the default, even spacing. This command cancels any of the stream-positioning functions listed below and recomputes the display cache. This may cause a small delay if enormous amounts of data are displayed.

- **Overlay streams** (F6 keyboard shortcut) - to draw all visible streams in the middle of the window, overlaid one on top of another. This is useful if you want to compare event records from several instruments in an array. Key F5 to cancel and return to the normal stream spacing.

- **Depth** (F7 keyboard shortcut) – if the calvals (see section 5.7 on page 39) contains a `depth=` entry for every stream in the window, this option will space the traces vertically, relative to the depth value. This can be useful for vertical seismic profiling "strings": i.e. when several instruments occupy the same borehole. Key F5 to cancel and return to the normal stream spacing.
- **Distance From Point** (F8 keyboard shortcut) – available if all instruments have Latitude/Longitude coordinates set in the calvals (see section 5.7 on page 39), and you have specified a **Set Point** (Ctrl + F8 keyboard shortcut). This is useful for aligning earthquake phase arrivals. Key F5 to cancel and return to the normal stream spacing.

- **Station map in Google Earth** - this option is available if all instruments have Latitude/Longitude coordinates set in the calvals (see section 5.7 on page 39). Selecting this option creates a .kml file mapping the station locations and calls Google Earth to view the file.

The **Sort by** sub-menu offers the following options:

- **Stream ID** - Sort by Stream ID. Where duplicate Stream IDs exist, maintain the previous sort order.
• **Component** - Vertical components (ending \(Zx\)), followed by \(Nx\) and \(Ex\) components, then Mux channels \(Mx\). Within a component type, sort by the first four characters of the Stream ID.

• **Instrument** - Sort by the first four characters of the Stream ID. Within an instrument, sort by tap, then by component.

• **Sample Rate** - Sort by sample rate, highest to lowest. Within a sample rate, sort as Instrument.

• **Tap** - Sort by tap (the last character of the Stream ID). Within a tap, sort by instrument, then by component.

• **System ID** - Sort by System ID. Within a System ID, sort as per instrument, described above.

• **Location** - this option is only available if all instruments have Latitude/Longitude coordinates set in the calvals (see section 5.7 on page 39). It displays a sub-menu:

![Location sub-menu]

At any one location, sorting is as per component, described above.

The **Spectrogram size** sub-menu allows the user to change the vertical size - and, hence, resolution - of the spectrograms in the current *WaveView* window.

![Spectrogram size sub-menu]

When the sub-menu is displayed the following key-strokes can also be used to select a size:

- 1 - set the size to 16 pixels
- set the size to 32 pixels
- set the size to 64 pixels
- set the size to 128 pixels
- set the size to 256 pixels
- set the size to 512 pixels
- set the size to 1024 pixels

This allows the spectrogram size to be changed entirely from the keyboard with a sequence like 

When you first enable spectrograms, the initial height of each is determined from the setting in the Display options pane of the Setup window. See section 6.4.1 on page 82 for details.

See section 6.2.5 on page 69 for details of spectrogram operations.
6.2 Stream functions

Actions can be performed on streams in a WaveView window using the context-sensitive menu, which appears when you right-click in the window.

Each stream has its own “focus lane”, although high zoom factors may make the trace extend outside the lane. The background colours have been altered in the window below to make the extents of the lanes visible. Right-clicking in any focus lane bring up the context menu for the associated stream.

If you have selected Overlay Streams for the window (as below), the focus lanes are still present, even though the streams are no longer drawn inside them. Right-clicking in the window anywhere to the right of a stream identifier will still bring up the context menu for that stream.
The context menu is divided into two by a horizontal line.

Items in the top section (above the divider line) apply to the individual stream and are described in the following section. Items below the divider line apply to all streams in the current WaveView window and are described in section 6.1.8 on page 58.
6.2.1 Identifying streams

Every stream is identified in its icon in the left-hand panel. For more details, right-click on the stream. The topmost option in the context menu displays the full network path to the instrument, including its System ID and Stream ID.

Here, a vertical stream (Z2) from a digitiser with the System ID BHCH2 and Serial Number HONE has a mapped name of BHCH2–GSL_Z2 (see section 6.4.2 on page 83). Right-clicking on the stream shows that the true Stream ID is BHCH2–HONEZ2, and that it originates from port Com24 on a system called JURAND. The data from JURAND have been forwarded by another system called BANFF.

6.2.2 Changing the appearance of streams

To change the colour of a stream’s trace, right-click on the stream in the WaveView window and choose Colour… Select the colour you want to use and click OK.

There are two further options for defining trace colours:

- You can set the default colour for each component (Z, N, E, and X) from the Display tab of the File → Setup… dialogue. See section 6.4.1 on page 82 for more details.

- You can set up Scream! to use particular colours automatically according to the name of the stream, and to label them differently in the WaveView window. See section 6.4.2 on page 83 for more details.
6.2.3 Scaling streams

To scale an individual stream, right-click on it and select Scale…:

Enter the new scale factor and click OK. You can scale whole instruments at a time by ticking the all [...] components in this window box. This overrides any previous scale-factor active for those streams. Select "all streams in this window" to set the scaling using the value entered for all streams.

If you have configured Scream! to scale streams to physical units, this box will display the scale factor that Scream! is using. If you entered a different scale factor, it will override the factor Scream! has chosen. To return to physical units, in the scaling box, enter the word "auto". You can also apply relative scaling by entering * and / operators. For example, entering a scaling of *2 will double the existing scale factor.

You can also type in the name of another stream that is in the same WaveView window. The selected stream will then be scaled such that the maximum/minimum range matches that of the stream you typed in.

To perform a one-time auto-scale of all streams so that the maximum/minimum is the same for all of the displayed data, right-click on the stream you want to be the reference, and select the Scale others to match option (keyboard shortcut).

The keyboard shortcut 1 will reset the active stream to a scale factor of 1. To reset all streams in the WaveView window, key Ctrl + 1.

6.2.4 Viewing offsets, ranges and averages: Details windows

To see the mean, range, average and RMS values for a stream, right-click on it and select Details.... A small window will appear beside the stream giving the current offset, mean, maximum and minimum values for the data in the window, together
with the $\textit{Diff}$ (the difference between the minimum and maximum values). The values are scaled according to the current scale-factor for the stream, or to any physical unit you have selected.

To alter the vertical offset of a stream, type a new value (in counts) into the $\textbf{Offset}$ box and press $\textit{Enter}$. You can do this even if the stream has its offset locked (via the $\textit{WaveView}$ window’s right-click context menu). The offset is changed for the current $\textit{WaveView}$ window only but it does affect any absolute measurements taken, as described in section 6.1.2 on page 49.

If you move a $\textit{WaveView}$ window, all its $\textit{Details}$ windows will move with it. You can change their relative position by dragging the title bar of each $\textit{Details}$ window.

Whilst the $\textit{Details}$ window is open, the mean value is displayed on the $\textit{WaveView}$ window as a dotted horizontal line, whilst the maximum and minimum values are displayed as solid lines.

You can also change the offset of a stream with the keyboard. With the mouse over the $\textit{Details}$ window, pressing the $\uparrow$ and $\downarrow$ arrow keys moves the current stream up or down by one pixel, whilst $\textit{Page Up}$ and $\textit{Page Down}$ move the stream by the height of one “lane”. This feature lets you compare streams by placing one directly on top of another. The lane used for selecting the streams stays the same.

While the details window is open, the keyboard shortcut $\textit{N}$ can be used to null the offset of the associated stream, centring the mean of the stream vertically in its lane.

(When the details window is closed, the $\textit{N}$ key only nulls the offset of the active stream: to null \textit{all} active offsets in the current $\textit{WaveView}$ window, use $\text{Ctrl} + \text{N}$.)
6.2.5 Spectrogram

Scream! can perform real-time spectral analysis on incoming data. To enable this feature, right-click on the stream of interest in the WaveView window and choose Spectrogram from the pop-up menu or use the $P$ keyboard shortcut. This displays or hides the spectrogram on a stream-by-stream basis. You can use the keyboard shortcut $\text{Ctrl} + $ to display/hide all spectrograms at once.

Interpretation

The vertical axis of the spectrogram is linear, with the Nyquist frequency (which, by definition, is equal to half the sample rate) at the top and 0 Hz (DC) at the bottom. The colouring is logarithmic, giving a large total range whilst retaining sensitivity at
low signal levels. Red represents the highest amplitudes and deep purple the lowest. Loosely speaking, the "hotter" the colour looks, the higher the amplitude.

**Height**

The height of each spectrogram in any given *WaveView* window is the same. When you first enable spectrograms, the initial height of each (in pixels) is determined from the setting in the *Display options* pane of the *Setup* window.

**Note:** Changing the default spectrogram size setting in the *Setup* window will immediately affect all spectrograms in all open *WaveView* windows.

Once spectrograms have been enabled in an individual *WaveView* window, their height can be changed by right-clicking in the window and using the context menu - see section 6.1.8 on page 58 for details.

**Contrast**

The colour contrast of any individual spectrogram can be changed by hovering the mouse over it and using the + and − shortcut keys. Hold Ctrl at the same time in order to apply the changes to all spectrograms in the current *WaveView* window.

This works by applying a ×2 or ÷2 scale factor to the stream data before applying the Fast Fourier Transform calculations. You can achieve the same effect by changing the scale factor of the stream (see section 6.2.3 on page 67), although this would also affect the size of the trace in the display.

**Zooming in**

The spectrogram supports zooming in to particular frequencies by holding down the left mouse button while dragging a selection across the frequency scale:

To apply the same zoom factor to all spectrograms in the current *WaveView* window, hold Ctrl at the same time.
To zoom out to the previous setting, right-click on the frequency scale (holding Ctrl, if desired, to apply the change to all spectrograms).
Example

The example below shows data from a 5TD which is sensing a signal of approximately 40 Hz, as shown in the green trace at the top.

The Red trace shows:

• the N/S component, with the spectrogram zoomed in once; and
• the blue trace where the spectrogram is zoomed in again, to the 39-40.5 Hz region.

On closer inspection, it can be seen that the signal frequency is changing over time, which was not apparent from the un-zoomed green trace. This could be a valuable diagnostic indication when trying to understand the source of the signal.
6.3 Filtering

Scream! can apply filters to your data before displaying them in a WaveView window. This feature allows you to eliminate frequency bands which contain unwanted noise and focus on frequency bands which contain data of interest. It can make a dramatic difference to the visibility of teleseisms in noisy data.

**Note:** Applying a filter only affects the appearance of the data in the current WaveView window (including spectrograms, where they are enabled). It does not affect any other windows showing the same data and it does not affect the results if you Save data or pass it to an add-on program, such as one of the calibration routines.

To apply or remove the filter, click the \( \text{FILTER} \) button or use the F shortcut key. Both act as toggles, turning the filter alternately on and off.

The properties of the default filter depend on the sample rate of the stream. Data at 1 or 2 samples per second are filtered with a 10 – 30 second pass-band, whilst data at other sample rates are filtered with corner frequencies at 0.1 and 0.9 times the Nyquist frequency of the stream. For example, the pass band for the filter applied to a stream at 100 samples per second will be 5 – 45 Hz.

In addition to the default filter, a custom filter response can be created. The Filter Design window allows you apply low-pass, high-pass or band-pass filters. Each WaveView window can have its own Filter Design settings.

Filter designs can be saved (with useful, mnemonic names) and retrieved.

To open the Filter Design window, click on the arrow to the right of the Filter icon \( \text{FILTER} \) and select Design... from the drop-down menu:
Alternatively, use the Ctrl + F keyboard shortcut.

The Filter Design window opens:

From top to bottom, the window contains:

- the parameters of the current high-pass (red) and low-pass (green) filter in numerical form,
- a graph of the response of the current filter, showing the −3 dB level and corner frequencies,
- (at bottom left) display settings for the graph, and
- (at bottom right) control buttons for the window.

### 6.3.1 Filter parameters

The filter parameters are shown at the top of the Filter Design window.

- Select Highpass to switch on the high-pass filter, and enter the value of the corner frequency required in either the Hz or the Secs (seconds) box. You are not allowed to enter a value of 0 in either box.

Alternatively, change the corner frequency by clicking and dragging across the graph with the left mouse button. If the low-pass filter is active, and you click to the right of the low-pass corner, both frequencies will be moved.
If the frequency you want is not shown in the window, it may be above the Nyquist frequency for the currently-selected sample rate. Change the value in the $n$ sps box at the bottom left and try again.

Change the order of the filter by entering a number in the $n$th Order box. If the cursor is in this box, pressing the $\uparrow$ and $\downarrow$ keys will alter the order by one in either direction.

- Select **Lowpass** to switch on the low-pass filter, and enter the value of the corner frequency required in either the $Hz$ or the $Secs$ (seconds) box.
Alternatively, change the corner frequency by clicking on the graph with the right mouse button. If the high-pass filter is active, and you click to the left of the high-pass corner, both frequencies will be moved.

Change the order of the filter by entering a number in the n\text{th} \text{Order} box.

- To create a band-pass filter, select both Highpass and Lowpass. Enter values into the text boxes, or click in the graph with the left and right mouse buttons to set the two corner frequencies.

![Filter Design](image)

When both filters are active, the individual filter curves are shown on the graph in light blue.

- Enter a value in the Gain (dB) box to change the gain of the filter.

In the example above, the overall gain of the band-pass filter has been set to 10 dB. This is done by applying a 5 dB gain to each of the component filters. As a result, the light blue traces appear 5 dB below the dark blue trace.

### 6.3.2 Viewing spectra

You can overlay the power spectra of up to two streams on the frequency graph. This is intended to help you design filters for specific events by focussing on the frequencies at which the event has significantly more energy than the background noise.

To design a filter for a specific event:
1. View the relevant stream in a *WaveView* window. If the window is not paused, it may be useful to pause it. Locate a time period where the stream is quiet.

2. Shift-drag (⌘ + ) to select the (single) stream across this quiet time range. Choose **Use in Filter Design...** from the context menu.

![WaveView window](image)

**Note:** If you do not see the **Use in Filter Design...** option, check that only one stream is selected.
The *Filter Design* window will appear, with the spectrum of the background noise overlaid in grey.

3. Leaving the *Filter Design* window open, switch to the *WaveView* window and view the event of interest.

4. Shift-drag ( + ) to select data from the same stream during the event. Choose **Use in Filter Design**… from the drop-down menu.
5. A dialogue box will open asking you if you want to replace the previous spectrum or add to it:

![Confirm dialog box](image)

Click **Yes**. The spectrum of the event will be overlaid onto the background noise spectrum, in a lighter shade.

You can now click in the graph to move the filter's corner frequencies to suit the event:

![Filter Design](image)

The drawing of the mouse (reminds you that the left mouse button controls the high-pass filter and the right-mouse button controls the low-pass filter.

6. If you want to view the spectrum of a different event, follow steps 3 – 4, choosing **Yes** when you are asked if you want to overlay the spectra. The old event spectrum will be replaced with the new one.
7. If you want to change the background spectrum, follow steps 1 – 2 and choose when you are asked if you want to overlay the spectra. The old event spectrum will be erased, and the background spectrum will be replaced with the new one. Now follow steps 3 – 5 to overlay the spectrum of a different event, as desired.

6.3.3 Display options

The icons at the bottom left of the Filter Design window change the properties of the graph.

- The Log/Lin selection box allows you to choose a logarithmic or linear time axis. (The magnitude axis is always displayed in dB, and is therefore always logarithmic.)

- Enter a value in the n sps box to display a frequency/period range suitable for streams at that rate. The graph displays a five-decade frequency range, up to the Nyquist frequency (i.e. half of the entered sample rate).

- When power spectra are being displayed on the graph, there is an additional selection box to the right of the Log/Lin icon.

The power spectrum calculation uses the Welch averaging periodogram algorithm. This algorithm produces frequency graphs by splitting the range into windows of a certain size. You can alter the size of window used by changing the value in this selection box.

Using a smaller window size produces a smoother graph, at the expense of losing information about lower frequencies. To examine lower frequencies, you will need to increase the window size; however, doing this will increase the noise visible at high frequency.

6.3.4 Using your filter

When you are happy with your filter design:

- Click to apply the filter to the WaveView window and close the Filter Design window.

- Alternatively, click to apply the filter and leave the Filter Design window open.
Ticking the *Auto-Apply* check-box makes the *Filter Design* window apply immediately any changes you make to the filter. Since applying a filter may take some time, you should not tick *Auto-Apply* if you are viewing a large amount of data. However, it can be very useful to interactively see the effects of changing the high-pass and low-pass corner frequencies, when dragging around with the mouse.

### 6.3.5 Pre-sets

If you have designed one or more filters that you would like to use repeatedly, you can save them as presets. To save the currently-active filter into Scream!'s configuration file, click the *Save* button and enter a name for the filter:

You can now select that filter, by name, from the drop-down menu next to the *WaveView* window’s *Filter* icon. All of your saved presets will be listed under the *Design…* entry.

The menu is also extended to include a *Delete preset* sub-menu, from which you can delete any of your saved filter definitions.
To modify an existing preset, first load it and then delete the definition. Revisit the design window, make the modifications that you want and then save the new version using the same name.

### 6.4 Display options

There are a number of Scream! set-up options which affect how WaveView windows are displayed.

#### 6.4.1 Display set-up

To change default display options for new WaveView windows, choose **File → Setup...** from the main menu and click on the **Display** tab.

**Stream Buffering**: You can change the size of Scream's stream buffer by altering the value and unit in these boxes. Scream! will discard any data older than this. If you want to record data to your computer's hard disk, you should use the **Recording** and **Files** panels; when you enable recording on a stream, any data in the stream buffer will be included in the recorded files. Scream! can also play back recorded GCF files (see Chapter 11 on page 135).

**Status Font**: Click **Select...** to change the font used in status stream display windows. The change comes into effect on new and existing **Status** windows as soon as you click **OK** or **Apply**.

**WaveView Defaults**: Allows you to take the default properties for new WaveView windows from a window already on the screen. Click **Select** and then click on the window you wish to copy. When you click **OK** or **Apply**, new WaveView
windows will have the same horizontal zoom factor, filter and block boundary options, background colour, and time/amplitude cursor state as are currently in place on that window. The vertical zoom factor is used only for new, blank WaveView windows, since Scream! automatically chooses a suitable factor if it can.

**Colour-coded Components**: When this box is ticked, Scream! will look for stream names ending Zn, Nn, En or Xn and automatically display them in the colours shown. To change the default colours, click on the boxes. Other streams are assigned a colour in rotation as they arrive. To define more specific colour defaults, you can use stream mapping (see below).

**Spectrogram**: Alter this value to change the default height of spectrograms displayed in WaveView windows, in pixels. When you click , newly-drawn spectrograms in all WaveView windows will use the new height. Pressing F5 will cause a WaveView window to be redrawn, as will resizing it, changing the zoom factor or using other buttons on the toolbar. Moving a window, or obscuring it and then revealing it, may or may not cause a redraw, depending on your operating system.

**Units**: Scream! can automatically scale new WaveView windows to physical displacement, velocity, acceleration units using sensitivity information you provide (see section 5.7 on page 39). To enable this feature, first edit the calibration values for your digitiser, then select a suitable unit from the Displacement, Velocity, or Acceleration drop-down lists.

Once you have done this, streams from the digitiser will be scaled automatically. Other instruments will default to displaying in counts.

A simple linear scaling algorithm is used, which does not take into account the response profile of the instrument, although where the instrument has a flat response in the pass-band, it is normally a sufficient approximation. For accelerometers, this is usually sufficient to be useful.

### 6.4.2 Stream mapping

You can tell Scream! to look for streams with a particular Stream ID, and to display them in WaveView windows with their own colour and label. This is configured from the set-up window. As with all set-up options, Scream! will remember any mappings you create in the scream.ini file and restore them next time you run the program.

To create a new stream mapping:

1. From Scream!’s Main Window, choose File → Setup…. Switch to the Stream Mapping tab.
2. Tick **Use Stream Name Mapping**. The pane will change to show the new options:

![Stream Mapping Dialog](image)

3. Click **Add...** and fill in the *Stream ID* you want to change, the new label and colour:

![Add Stream Mapping](image)

The label can be any length, but may not contain any of the characters

\ / : * ? " < > |

because these characters are not allowed in DOS or Windows file-names.

4. Click **OK**. In this example, new *WaveView* windows containing the *DEMOZ2* stream will now automatically show it in the new colour, and with the label *My 6TD vertical*. The new label is also used in the Main Window, on print-outs and in the file-names of recorded data streams (if your format...
specifier includes the \textit{mapped Stream ID}). Identifiers \textit{inside} exported files will still use the original \textit{Stream ID}.

\textit{WaveView} windows which are already open will not change until they are refreshed (\textit{e.g.} by resizing or zooming them, or by pressing \textsc{F5}).

You can edit an existing mapping by double-clicking on its entry in the table, or by selecting it and clicking \textbf{Edit…}. To change the default colour only, click the colour panel under \textit{Col} in the table.

To delete a stream name mapping, select it and click \textbf{Remove}.

Clicking \textbf{Import...} enables you to import a \texttt{scream.ini} file from another Scream! installation and extract the mappings from it. This is useful when you want to use a standard set of names and colours for several Scream! installations.
7 Forwarding data over a network

Previous chapters have described how to use Scream! to access data directly from a digitiser or via another copy of Scream! These data can come from serial ports, modem lines or anywhere on a local or wide-area network. This functionality is controlled from the My Client tab of the Network Control window and from the Com Ports tab of the Setup dialogue and is described in Chapter 4 on page 15.

Once data sources have been configured, Scream! can then act as a server to forward data to other computers running Scream!, any equipment running Platinum, such as Güralp NAMs, archival programs and/or processing software such as Antelope and Earthworm. Data are transmitted in GCF format using the Scream transport protocol. This functionality is controlled from the My Server tab of the Network Control window:

To access this window from Scream’s Main Window, select Windows→Network Control from the menu or use the keyboard shortcut Ctrl + N.

- You can choose whether or not to re-transmit data received over local serial links by ticking or clearing the Transmit data from local Com Ports check-box. See section 4.1 on page 15 for information about acquiring data from local serial ports.

- You can choose whether or not to re-transmit data received over the network by ticking or clearing the Transmit data from Network check-box. See section 4.3 on page 20 for information about acquiring data from network sources.
Caution: Because Scream! can simultaneously receive data over the network and retransmit it in broadcast packets, it is possible to create loops where a single packet is received and retransmitted multiple times. Platinum systems can also retransmit data received over the network so always consider this possibility when designing networks.

- If you are forwarding data across a high-cost or low-bandwidth link, you can choose to transmit only packets with low sample rates and not re-transmit packets with higher sample rates. To do this, set the sps transmitted block limit value to your chosen threshold. Setting it to zero causes Scream to transmit only status streams.

- Some digitisers allow terminal sessions and configuration/control actions to be performed across a network link. Scream’s server will, by default, block access to such functions from its clients. If you wish to allow such actions, tick the Allow remote control access check-box. For this to work, all upstream devices must also allow remote control.

Scream! can serve data in two ways. In the first, clients may request data from the Scream! server. This method is known as “client pull”. Alternatively, Scream! can keep a list of clients which need to be provided with data. This method is known as “server push”.

Note: In the illustrations in the following sections, we will show the Scream system that is transmitting data as a desktop PC and the system that is receiving data as a laptop. This is just a convenient shorthand: any system that can run Scream can act as a server.

7.1 Client pull

In a client pull configuration, Scream listens for incoming UDP requests from clients and serves data to them automatically.

To start a server and listen for pull requests from clients, tick the Transmit data from local Com Ports check-box and/or the Transmit data from Network check-box on the My Server pane. Scream will start listening on the UDP port specified in the Network Control window as the Port used for all network communications.
### 7.2 Server push

In a server-push configuration, the server must be configured with a list of clients. GCF data will be pushed to the client using the scream transport protocol over UDP.

![Server push diagram]

**Caution:** If your server is behind a firewall, you will need to unblock the UDP port at the server side to receive these requests.

**Note:** If you are using Scream as a client, you can simply tick the *Receive Data* check-box on the *My Client* tab to begin receiving data. If your client is behind a firewall, you will need to unblock the UDP port at the client side.

To configure Scream to push data to a particular client:

- Switch to the *My Server* pane of the *Network Control* window;
- Tick one or both of the *Transmit data from local Com Ports* check-box and the *Transmit data from Network* check-box, as required;
- Right-click anywhere in the *Clients* list box and select *Add...* from the context menu. Enter the IP address (or DNS name) and port number on which the server is waiting for requests, separated by a colon (`:`) (*e.g.* `192.168.42.98:1567`)
You can add any number of clients, including broadcast addresses and multicast groups. If you want to broadcast or multicast UDP packets, you should obtain suitable addresses from your network administrator.

- To broadcast to all connected computers, use the IP address 255.255.255.255.

- To restrict broadcasts to a particular subnet, use the broadcast address for that subnet: for example 192.168.60.255:1567 will broadcast data on port 1567 to all clients on a 192.168.60.0/24 subnet – i.e. those with IP addresses beginning 192.168.60.

- To send data to all instances of Scream! in a multicast group, use a multicast IP address. The address range from 239.255.0.0 to 239.255.255.255 is available for local networks, and that from 239.192.0.0 to 239.195.255.255 for organisation-level networks. Most other multicast addresses on the Internet must be specially registered.

The server will automatically start transmitting.

- To send data to another Scream! running on the same computer, use the IP address 127.0.0.1, but ensure that any other instances of Scream are using a different port number in order to avoid a loop.

- To send data to more than one Scream! running on the same computer, use the local broadcast address 127.0.0.255, or set up a multicast group. You must use a different port (e.g. 127.0.0.255:1568) in this case in order to avoid creating a network loop.

The list of clients to which Scream! is currently sending data is shown in the Clients table at the top of the My Server pane. Block-by-block details of the data being
transmitted are shown in the *Block Tx* pane. Other server operations are reported in the *Control* pane to its right.

![Network Control pane](image)

Both “server push” and “client pull” clients are listed in this pane. You can see which clients are using which method by looking in the *Time-out* column. When a *pull* client requests data, its time-out is reset and then starts counting down toward zero (as is the case for 10.10.0.33 in the screen-shot above). If a *pull* client’s time-out value reaches zero, Scream! assumes it has stopped listening and removes it from the list. On the other hand, *push* clients do not have a time-out, because Scream! will always try and transmit to them. Thus, clients using *pull* have a time-out figure listed in this column, whilst *push* clients are shown with the entry *None*, as is the case for 10.10.0.37 in the screen-shot above.

To alter the IP address or destination port of a client, right-click on it and select *Edit...* Enter the new IP address and port as for *Add...*, and click [OK].

To remove a client from the list, right-click on it and select *Delete*.

### 7.3 Server Buffer

The Scream server must store a history of the data transmitted in case the client does not receive all data and requests “back-filling”. Scream! stores this history on disk so that it can be very large, if desired. The *Server Buffer* tab of the *Network Control* window allows the configuration of the size and location of this disk-based buffering.
If disk-based buffering is not enabled, Scream! will use a small memory-based buffer. It is recommended that the user ensures there is sufficient disk space available on the drive selected to hold the buffer. The buffer size can be specified in either time (Days, Weeks or Years), or in terms of disk usage (MiB, GiB or TiB).

7.4 Gap recovery

In addition to the normal UDP data protocol, Scream! has facilities for attempting to recover missing data. When Scream! receives a block of data that indicates a gap (because the sequence number is not contiguous), it opens a new TCP connection to the server (from the same port). Once this connection is made, Scream! requests the missing data and, if they are available, the server transmits them over the same TCP connection. The UDP data stream continues unaffected.

If you are using a firewall on either side of the connection and want Scream! to be able to recover missing data in this way, you will need to unblock the relevant port for both UDP and TCP traffic.
8 Supplementary windows

Aside from the Main Window, WaveView windows and Network control window, Scream! includes facilities for monitoring status streams, the status of your network, the integrity of incoming data, and for accessing the serial consoles of attached DM24 and CD24 digitisers.

8.1 Terminal windows

Scream! provides a terminal emulator that can be used over both serial lines and networks. It can open a network terminal session with any connected CD24 or DM24 digitiser. Over a serial link, it can, in addition, open a session to the command line of an EAM if the server permits it: see Chapter 7 on page 86.

8.1.1 Communicating with instruments

To open a terminal session with an instrument, right-click on its entry in the left pane of Scream’s Main Window and choose Terminal… from the pop-up menu:

Scream! automatically negotiates with any other Güralp devices or software in the chain until it reaches the one you want to contact, and then attempts to place the target digitiser in command mode. If this fails, press Ctrl+S in the Terminal window to enter command mode manually.
If you see an ok prompt, as shown below, the digitiser is ready to receive commands. Otherwise, press \( \text{Esc} \) to display a prompt. You can now type terminal commands into the window.

The \( \text{Ctrl} + \uparrow \) and \( \text{Ctrl} + \downarrow \) arrow keys let you browse through the history of typed commands. This history is common to all Terminal windows, so you can easily (for example) send the same command to several digitisers in turn.

To begin capturing a session, including every command you type as well as the instrument’s response, right-click in the Terminal window and select Capture to File…. All subsequent actions will be saved to a file with name that you enter, combined with a unique source string. Capturing stays in effect through digitiser restarts and, also, if you close Scream! and restart it later. The capture file’s name is displayed in the caption of the Terminal window.

To send a file to a digitiser, right-click in the Terminal window and select Send File…. In Windows, you can also drag-and-drop a file. This can be used to read in lists of commands that you have prepared; for example, to set up a number of digitisers identically. It is also used to update a digitiser’s firmware.

Note: For details on how to set up firmware transfers, refer to the documentation for the relevant digitiser.

To close the connection, close the Terminal window. Scream! will automatically instruct the digitiser to start transmitting data. If the digitiser begins transmitting data whilst the Terminal window is still open (e.g. because you have issued the close or go command, or because of a time-out), the window will close automatically with the message Terminal session closed by instrument.
8.1.2 Macro commands

The Terminal window provides icons for the keys F2 – F12, which can be programmed with commonly-used commands (“macros”). To define such a macro, right-click on an Fn icon, and enter the command (or commands) in the text box.

You can enter these commands by

- left-clicking one of the Fn icons in the Terminal window,
- pressing the corresponding function key whilst the Terminal is open, or
- right-clicking on the digitiser’s entry in Scream!’s Main Window, and selecting the command from the drop-down menu. Scream! will automatically start a terminal session with the instrument, send the command and then close the link.

Scream! remembers all of your macro settings when you close the program.

8.1.3 Direct connections

You can also open a terminal session directly to your computer’s serial ports or over a network. This is useful for communicating directly with modems, or with the consoles of third-party equipment.

To do this, select File → Terminal… from Scream!’s main menu:

The Select Port to open window is displayed.

- To make a serial connection, choose Direct Serial as the Link Type, select the name of the serial port you want to use, and check that it has the expected baud rate. If it does not, you can change it in the Setup window (see section 4.1 on page 15). Click OK.

Scream! servers can provide access to their own serial ports over the network. To connect to the serial port of a remote Scream! server, choose Remote Serial
and fill in the IP address of the remote computer, together with the port name or number. Click [OK].

You will need to enable serial access on the Scream! server to use this feature:

- If it is another instance of Scream!, open the **My Server** tab of the **Network Control** window in that instance and tick **Allow remote access to Com ports**.

- If your Scream! server is a Güralp NAM or EAM, you will need to ensure that the **Disable terminal access** check-box is not ticked in the **gcf-out-scream server configuration dialogue**.

This option is most useful for accessing serial ports on a remote computer which is not producing GCF data. If a remote port does emit GCF data, it will appear in the source tree as normal, and you can open a session with it by right-clicking and selecting **Terminal...**

- To connect over a TCP/IP terminal link, either to a remote Scream! server or to a TCP terminal device (*e.g.* a serial to network converter), choose **TCP/IP** and fill in the IP address of the remote computer. Click [OK].

The terminal window will then open as described above.

### 8.2 Digitiser status streams

Most Güralp digitisers have a separate stream for reporting information about the system, such as their GNSS and time synchronization status. This status information is in plain ASCII text format.

To see a Status window for any digitiser, double-click on the **Stream ID** which ends with two zeros: `xxxx00`. This stream always has a reported sample rate of 0 samples per second.

During boot-up, each unit reports its model type, firmware revision number, its **System ID** and its serial number via this stream. This information is followed by the number of resets that have occurred and the time of the latest reboot from its internal clock. The following lines report the current configuration of the unit’s sample rates, output taps, and baud rates.
A typical digitiser re-boot status message looks like this:

The system will produce a similar status message whenever it is powered up and whenever you reboot it (for example, after changing its configuration).

Various status messages will be highlighted in red or green depending on the importance of the message (e.g. the “System Boot” message above). The right-click context menu offers a Custom highlighting... option that allows user-definable key words or phrases to cause a status line containing that phrase to be highlighted red or green, depending on the list into which it is entered.

8.2.1 GNSS

GNSS is the general term for a Global Navigation Satellite System. It can refer to one or more of GPS, GLONASS, Galileo, Beidou etc. In this document, the term GNSS is also used to refer to the receiver module that is connected to the digitiser.

If a GNSS receiver is connected to the digitiser, its operational status is reported on reboot and the behaviour of the time synchronisation software will also be shown.

From a cold start, the GNSS receiver will initially report No GPS time together with its last position (taken from the internal backup). All messages from the GNSS that
involve a change of its status are automatically reported. Some digitisers will suppress small changes in reception strength once a 3D fix has been obtained.

A typical GNSS status report from a DM24 digitiser looks like this:

![GNSS Status Report Example](image)

This report shows which satellites (officially: Space Vehicles, abbreviated to SVs) the system has found, along with their corresponding signal strengths.

If the system has not been moved from its previous location, it should be able to find enough satellites to obtain an accurate time fairly quickly; if the GNSS receiver has difficulty finding satellites, there may be a delay of several minutes before a new message is displayed.

Before beginning to synchronise, the digitiser's internal clock management software will wait for the GNSS receiver to report a good position fix from at least three satellites, for at least six consecutive messages. Messages are normally received every 10 to 20 seconds.

The system will then set the internal clock and re-synchronise the Analogue to Digital Converters so that all subsequent data are accurately time-stamped to the new reference.
**Note:** Any data transmitted up to this point will have been stamped with the time from the internal, battery-powered backup clock, which can be significantly inaccurate if the digitiser has been powered down for a long time.

The re-synchronisation will result in a discontinuity in the data received. If you are viewing the data in a *WaveView* window and the status stream is also being received and block markers are enabled, the resynchronisation will be marked in the *WaveView* window with the symbol. See section 6.1.7 on page 57 for more information.

From this point, the control process in the digitiser will attempt to keep the internal time-base synchronised to the GNSS’ 1 pulse-per-second (PPS) output, by adjusting a voltage-controlled crystal oscillator. First it alters the voltage control to minimise the error. Next it attempts to minimise both the “phase error” (i.e. the offset between the internal 1 Hz signal and the GNSS) and the drift (the frequency error relative to GNSS, which is the first derivative of the phase error). During the control process, the system reports the measured errors and the control signal applied as the PWM (Pulse Width Modulation) value.

During the initial, coarse adjustment stage, only the coarse voltage control is used and no drift calculation is made. If the system is operating in a similar environment to that when the system was last powered (most importantly, the same temperature), the saved control parameters will be appropriate and the system should rapidly switch to the ‘fine’ control mode. The system reports its control status and parameters each minute, with error measurements given in nominal timebase units. In a stable temperature environment, the system should soon settle down and show an offset (error) of only a few thousand (average error < 100 microseconds) and a drift rate of under a hundred counts (< 1 in $10^{-6}$).
8.2.2 Graphing status information

Most Güralp digitisers transmit a status block every few minutes, giving information about the GNSS status, internal temperature etc:

Scream! can automatically extract measurements from these messages and show them in graphical form. For each plotable field that Scream! finds, an check-box is displayed at the top of the Status window. In the example above, Scream! has found Offset, Drift, PWM, Volts (i.e. DC input) and Temp (temperature) fields in the status messages. Not all digitisers output all of these fields, so some of these check-boxes may not be present in all windows.

Note: Scream determines that a field is present only once it has seen the relevant value appear in the status stream. It may be many minutes before a given parameter, such as Temperature, appears. Scream will not offer the ability to graph such a value until it has appeared at least twice.
To display any or all of these fields in graphical form, tick the check-box(es) for the field(s) you want to examine:

![Graphical display example]

You can resize the Status window, or drag the bar between the graphs and the block display area, to see the graphs in more detail.

8.2.3 Station Lat/Long

Some digitisers will periodically report the Latitude and Longitude of the GNSS receiver coordinates in the status information. For example

2017 6 14 09:00:00 Lat 51°21.6718N  Long 001°09.8555W Height 113m

When detected, Scream will parse these lines, and update an internal record of instrument location.

Scream can use this location information in several ways:

- It can generate google maps references for single stations, and launch Google Maps in a web browser. In the The source tree, right-click on an instrument, and select **Plot in Google Maps**.

- It can generate .kml files for arrays or networks, and launch in the Google Earth application. In the The source tree, right-click on **Network** or a server, and select **Plot in Google Earth**.

- The WaveView Context menu also contains location-based options, such as stream-sorting and axis-spacing. See section 6.1.8 on page 58 for details.

The location information is stored in the **calvals** data. Entries are automatically created with the name `aPos1=`. A number of fields in this entry record the details of the location, as follows:

<table>
<thead>
<tr>
<th>Field</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Description</td>
</tr>
<tr>
<td>---</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>1</td>
<td>Averaged latitude</td>
</tr>
<tr>
<td>2</td>
<td>Averaged longitude</td>
</tr>
<tr>
<td>3</td>
<td>Averaged height</td>
</tr>
<tr>
<td>4</td>
<td>Number of points received at this location</td>
</tr>
<tr>
<td>5</td>
<td>Date/time of first report at this location, in ISO8601 format</td>
</tr>
<tr>
<td>6</td>
<td>Date/time of most recent report at this location, in ISO8601 format</td>
</tr>
</tbody>
</table>

When a new Latitude/Longitude report is detected in the status, it is compared to the current, known position. If within a small range (default 250 metres), it is assumed that the receiver has not moved so the location is added to the averaged position and the most recent time is updated. In this way, the longer the station runs for, the more readings are averaged, and the more precise the stored location becomes.

However, if the new position is out of this range, the instrument is assumed to have moved, so a new location is started with an incrementing `apos` entry (e.g. `apos2=` then `apos3` etc). In this way, a history is built up of where and when a particular sensor has been. This can be useful for portable arrays and seismic surveys, where equipment moves regularly.

In some circumstances, GNSS receiver location is not available, or not accurate (e.g. time source is not a GNSS, or is centrally distributed to an array over a large area). To override the automatic position, a manual position entry - `mpos=...` - can be entered in the format shown:

```
mPos1=51.3132 -1.2243 160.7132
```

Only fields one, two and three - latitude, longitude and height - are specified in this case.
8.3 The summary window

This window provides at-a-glance state of health information about all instruments on your network. To open it, choose Windows → Summary window from Scream!’s Main Window.

![Summary Window](image)

Every instrument known to Scream! is listed in this window, with coloured icons representing their timing, mass position and data flow status. The window also reports how many triggers have been communicated to Scream! in status blocks.

To make Scream! forget this information and start afresh, click **Reset All**. This will not remove streams from the Main Window, the WaveView windows or the stream buffer.

In the leftmost four columns, each entry is a coloured rectangle with a border. A grey rectangle indicates that no relevant data have been received from the instrument since Scream! was started. Green indicates that this measurement is satisfactory; yellow indicates that some attention may be necessary, and red indicates that there is probably a problem.

If a box has a coloured border, an unsatisfactory reading has been received since the last reset, but the status has since improved. Thus, if a box goes from yellow to green, the border will be coloured yellow until you reset. If the same box subsequently turns red momentarily and then returns to yellow or green, the border will change to red.

8.3.1 Timing

This column details the instrument’s GNSS timing status. The colours are the same as those used for the top half of the instrument’s icon in the Main Window. Double-click on a column entry to see the status messages coming from that instrument.
8.3.2 Mass position

This column indicates the instrument’s mass position status. To open a WaveView window showing the instrument’s mass position channels, double-click on the column entry.

The status is obtained by comparing the mass positions to the threshold set in the EMail tab of the Setup window - see section 13.2 on page 166 for details.

- **Grey**: Scream! has not received any mass positions information from the instrument since the last reset.
- **Green**: The instrument has reported satisfactory mass positions (all components less than 50% of the specified threshold).
- **Yellow**: One or more components are reporting mass positions between 50% and 100% of the threshold. Most instrument types will still function normally, but the noise level will increase and the masses should be re-centred at the first convenient opportunity.
- **Red**: One or more components are reporting mass positions over the configured threshold. Most instrument types may still function adequately, but the masses should be re-centred as a matter of urgency.

8.3.3 Age

This column records the time that the instrument last sent data to Scream!.

When a data block is received, the box turns green. Over the next two minutes, if no more data are received, the box gradually changes through shades of yellow, to orange, and finally red.

If more than two minutes pass before the next data block is received, the border of the box will change to red to alert you that a suspicious gap in data has been detected. If you do not expect real-time data from this instrument, or you are using...
low sample rates exclusively, you may allow this column to turn red. For example, a one sample per second stream will transmit a block only once every four minutes under quiet conditions.

Double-click on a column entry to select the instrument in Scream!'s Main Window.

### 8.3.4 Errors

This column records the number of corrupted blocks that Scream! has received. A corrupted block is one whose checksum does not match the data, or which fails one of Scream!'s integrity checks. To see which checks are failing:

- Open a *ViewInfo* window on the suspect stream, where erroneous values are shown in red (see section 2.1.4 on page 106).
- *Alternatively*, double-click on the column entry to open the error log file (if you are recording one) in Notepad or an *xterm*.

The meaning of the colours is as follows:

- **Green**: Fewer than two corrupted data blocks have been received in the last minute, or the window was reset less than a minute ago.
- **Yellow**: Between two and ten corrupted data blocks have been received in the last minute.
- **Red**: More than ten corrupted data blocks have been received in the last minute.

### 8.3.5 Triggers

This column records the number of times the digitiser has sent a trigger status message since Scream! was started. New triggers are coloured in green; when you *Reset window*, the green shading will disappear, but the number will remain.
Double-clicking on a column entry opens a window with details of the trigger events:

The top half of the window lists all the trigger events, with information extracted from each trigger’s status message. The full status message is reported in the lower half.

Double-clicking on an entry in the table (or selecting it and pressing paused) opens a paused WaveView window containing all of the streams from the digitiser which declared the trigger, covering the time period of the trigger. This time period is marked with the Time Cursors to show the duration of the event.

If you have instructed the digitiser to record pre- or post-trigger data, Scream! will attempt to include these as well. If two triggers from the same digitiser overlap, Scream! may show both triggers in the WaveView window, because the point where one trigger ends and the next begins is essentially arbitrary.

Scream! can only display data which is still in its stream buffer. If the buffer is full and the data have already been purged, double-clicking on a trigger will show a blank window. To view the data, you will need to retrieve it from the hard disk or your recording system and replay it into Scream!.

The columns contain the following information:

**Start**: The start time of the trigger, prefixed with a * if the trigger occurred since the last time you reset the Summary window.

**End**: The end time of the trigger.

**Type**: What caused the trigger: R if the STA/LTA ratio exceeded the set threshold, L if the level exceeded the threshold, E for an external trigger (if the digitiser supports it) or S for a manual trigger (generated in software).
You can also open the **Triggers** window by right-clicking on a digitiser's entry in the Main Window and selecting **Triggers...** from the menu.

### 8.4 The ViewInfo window

Detailed header information from incoming data blocks is available from the **ViewInfo** window, accessible by selecting **Windows → Info Display...** from Scream!'s Main Window.

If **ALL** is selected as the **Source** at the top of this window, details of every incoming data block will be shown as they arrive. You can narrow the selection to a particular source using the drop-down menu.

Scream! makes a number of validity checks for incoming blocks. Any suspect fields are shown in red in the **ViewInfo** window.

When analysing data received over BRP (**i.e.** from all serially connected digitisers and network-connected CD24s), the first three fields and the final Checksum (Cksum) come from the transport header, which is added to each GCF block to aid with data transmission. When analysing data received over the network using the Scream! protocol, these values are synthesised.

The displayed fields are:

- **Block ID character**: Must be a **G** for GCF format blocks.

- **Block Number**: An incrementing counter, modulo 256 (**i.e.** $255 + 1 = 0$) for blocks from a data source. This box reports the **Block Number** for every incoming block, so this value will not update sequentially if you are using several sources. Unless the field turns red, the value is what Scream! expected.
The remaining fields constitute the information available from the GCF block's internal header and mostly duplicate the information available in the stream list. The following additional information is available:

- **Block Size**: The size, in bytes, of the GCF block following, not including transport information.

- **Decimation Index**: This byte, otherwise known as the *Tap Table Lookup* value, or *TTL*, provides information about the filter-chain configuration of the digitiser, among other things. When the byte is non-zero (legacy digitisers did not populate this field), Scream! will interpret it if it can, and display the corresponding filter set-up. For more details, please see the Support → FAQs section of our web-site.

- **Sample Rate and Compression**: The current sample rate and compression code, also displayed in Scream!'s Main Window.

- **Number of Records**: GCF blocks are divided into four-byte records. Each record can contain one, two or four samples, depending on the current compression factor. Since all GCF blocks are 1024 bytes long, allowing for the 24-byte header, a full GCF block should always contain at least 250 records. However, it is permissible for a GCF block to be only partially full. In particular, for 200 sps data, the requirement that block boundaries be at integer seconds means that the GCF packets will contain 200, 400 or 1000 samples.

- **RIC / Calculated**: The Reverse Integrating Constant (effectively the value of the last sample in the block) and its calculated value from the differences in the block.

- **Checksum / Calculated**: Received and calculated checksum values for the data in the block. If these differ, Scream! assumes the data are corrupt and asks the digitiser to re-transmit the corrupt block. If you are using a simplex communications link, this will fail and the data block will be lost.

Scream! also logs any errors that it detects. For more information on Scream!'s logging system, see Chapter 13 on page 164.
9 Configuring CD24 and DM24 digitisers

Note: This chapter applies only to Güralp CD24 and DM24 digitisers. For other models, please refer to the relevant digitiser manuals.

Scream! distinguishes between configuration and control of digitisers. The most important difference is that a digitiser may be controlled through Scream! at any time whilst it is acquiring data, whereas changes to configuration options only take effect after a reboot (with consequent loss of data).

To change the configuration of any connected digitiser:

1. Locate the digitiser you want to configure. All connected digitisers have an entry in the source tree on the left of Scream!'s Main Window. If the digitiser is transmitting data through a remote server or EAM, you may need to “unroll” the entry for that server (by clicking on the icon) to see the digitisers connected to it.

2. Right-click on the digitiser's entry ( - not the icon for the server or any Comxx icon).

3. Click Configure.... Scream! will then contact the digitiser and retrieve its current configuration, a process which will take a few seconds. When this is done, the Configuration set-up window will be displayed.

4. Once you are happy with any changes you have made in the Configuration Setup window, click UPLOAD to send them to the digitiser and reboot. This will take around a minute.

To control a digitiser while it is running, either right-click on the digitiser’s entry in the list and click Control..., or double-click the entry. If the digitiser is already highlighted, you can simply click . In either case Scream! will contact the digitiser to retrieve control information and display the Control window. The options you can control immediately are:

- the type of sensor you are using (which affects which other controls are available),
- GNSS power cycling options,
- the short-term and long-term average values for triggering (but not which streams perform the trigger, or which are output by it - see section 9.3 on page 112),
- the length of the pre-trigger and post-trigger periods,
- calibration signal options, and
- mass control functions.
Some of these options can also be altered in the *Configuration set-up* window. For more information on the *Control* window, see Chapter 10 on page 121.

9.1 System ID

The *System ID* pane gives information about the digitiser and its internal software, and allows you to change timing source parameters.

**System Identifier and Serial Number**: The digitiser type is identified by its system identifier and serial number. Every data and status block generated by the digitiser includes these two fields at the beginning, so that the block’s origin can be identified. On delivery from the factory, the system identifier and the serial number are set production reference numbers, but almost any combination of letters A-Z and numbers can be used, such as an abbreviation of your institution’s name etc. The system identifier can be up to five characters long, whilst the serial number cannot be longer than four.

**Sensor Type**: If the sensor attached to the digitiser is a Güralp velocity sensor, useful seismometer functions (such as sensor locking, centring, and calibration) can be controlled through the digitiser. The *Sensor Type that* you set here determines which functions will be available through the Scream! digitiser configuration set-up interface or through interactive commands.

**Timing Source**: The digitiser needs to be able to time-stamp accurately all data that pass through it. It can set its clock either by receiving time signals from a GNSS satellite network, using an attached compatible unit (NMEA+PPS output) or by...
taking time information from a central site (*stream sync* mode). In *stream sync* mode, the digitiser expects to receive two-byte packets from the central timing source, which may have its own GNSS unit, or take signals from one of the radio time standards. Choose the mode you require from the drop-down menu.

Most GNSS modules use a fixed 4800 baud rate. However, for non-standard applications, the baud rate can be controlled on some digitisers, so a variable baud option is available in these cases.

**Enable GNSS power cycling**: If you are using a GNSS unit to receive time signals, but do not experience significant drift in the system’s clock (for example, in an environment with a stable temperature), you can save power by selecting *Enable GNSS power cycling*. With this option in use, the GNSS time is only checked at intervals of a specified number of hours. Disabling this option keeps the GNSS unit running constantly; if you have ample power, this will give the most accurate results. You can choose any whole number of hours for the interval.

### 9.2 Output control

The *Output control* tab allows you to configure which data streams are sent to Scream! from the digitiser.

Güralp digitisers initially sample incoming data at a high rate (*e.g.* 2000 Hz for the DM24), which is then filtered and reduced to a lower rate (*decimated*) using an on-board digital signal processing unit, or DSP. The DSP has several filtering-decimation stages, which run one after the other. Stages which can produce output
are called *taps*. The Güralp DM24 and CD24 digitiser can both output data from four taps simultaneously.

Each configurable tap can be set to a different decimation factor by choosing values from the drop-down menus on the left. Decimation factors of 2, 4, 5, 8, and 10 are available. The numbers visible in the drop-down menu of each tap are the data rates that each of the possible decimation factors will provide, given the settings of the taps above it. Only integer (Hz) data rates are allowed: thus, for example, if one tap produces data at 25 Hz, the only possible further decimation factor is 5.

To the right of each decimation factor menu is a grid of check-boxes. These boxes mark which streams of data to generate at each sample rate. The screen-shot above shows a possible configuration for 6-channel digitiser with two triaxial instruments connected. Every channel of the digitiser may be output at any tap; currently, all three axes of both instruments are being output at Tap 3 (100 Hz).

If you want to change the names used for the channels, click in the white box containing a Z in the above picture, and type a letter or number. It will name the channels with a sequence of letters or numbers beginning with the one you choose (*e.g.* A, B, C; 2, 3, 4; 9, A, B), unless you type *Z* in which case they will revert to Z, N, and E.

Each combination of channel and tap has two check-boxes. The upper check-box of each pair activates *continuous* output, whilst the lower activates *triggered* output. In the example above, the digitiser will output data continuously for all six channels at Tap 3, but never for any other taps. You cannot tick both continuous and triggered output for the same channel and tap.

When you enable a triggered stream, the digitiser will output data in that stream only when a particular set of trigger criteria are met. This is pictured in the window as a switch. For example, to generate high-rate data from Tap 2 only when an event registers at some other tap, the *lower* check-boxes of Tap 2 should be ticked.
With this configuration uploaded, Tap 3 will continue to produce output at all times, but Tap 2 will now also emit data whenever the trigger criteria are met. The Triggering button is now shown in red (Triggering) to remind you that the trigger is active.

Every ticked box in this window will give rise to a data stream coming from the digitiser. These streams will be displayed in Scream!’s Main Window when Scream! first receives some data from it.

**Note:** Each stream is identified by a unique "Stream ID". See section 5.3.1 on page 32 for an explanation of the encodings used to generate these.

### 9.3 Triggering

In its standard configuration, the digitiser outputs continuous data at a sample rate you specify. In addition to this, most Güralp digitisers can run a triggering algorithm on the data they acquire. This allows you to record data continuously at a relatively low sample rate, but record at a much higher sample rate during short periods when the trigger is active. The parameters controlling the triggering algorithm, and controlling the data output once the system is triggered, are all selectable by the user, permitting maximum flexibility of operation and the most efficient use of available storage space.

The digitiser can be set up for triggered output. This means that it will generate certain data streams only when a particular trigger criterion is met. The trigger criterion can be refer to data from the same or some other stream. For example, you
could use a later tap (with a lower sample rate) as a trigger for output from an earlier, higher sample-rate tap. Scream! also allows you to configure each digitiser to receive trigger signals from other digitisers (external triggering).

To create a new stream with a trigger, open Scream!'s Digitiser configuration window for the relevant digitiser, and click on the Output control tab. In the Output control pane, a tap which gives rise to a triggered stream has a tick in the lower row of its grid of check-boxes. You cannot configure the trigger criteria until you have selected at least one stream to be affected by the trigger.

**Note:** To remove triggers, remove the criteria before disabling the triggered streams. You cannot modify the triggering criteria unless at least one stream is selected for triggered output.

Once you have decided which streams should be output when the trigger is activated, you will be able to click on the Triggering button to describe the trigger condition. Alternatively, click on the Triggering tab at the top of the window.

Either action will open the **Triggering pane:**

There are two triggering algorithms which Güralp digitisers can use. However, not all models can use both methods. Scream! will find out from the digitiser whether its on-board software supports each method.

In addition, some digitisers support external and software triggering.
9.3.1 STA/LTA

The STA/LTA algorithm applies a simple

\[
\text{(Short-Term Average)} \div \text{(Long-Term Average)}
\]

calculation to the triggering stream. It works by identifying sections of an incoming data stream when the signal amplitude increases. The purpose of taking a short term average, rather than triggering on signal amplitude directly, is to make it less likely that spurious spikes or generally elevated background noise will trigger the device. Averaging also introduces an element of frequency selectivity into the triggering process.

You can select which tap is used as the input data for the triggering calculations using the Data source drop-down menu. The tap does not have to be selected for continuous output for you to be able to use it here.

Any or all of the channels available at that tap may be used to determine a trigger. You can select which channels are considered by ticking the boxes in the Channel column of the table. If any of the ticked channels passes the trigger condition, the trigger will activate, and will not de-trigger until all of the ticked channels have fallen below their respective ratio values.

The STA and LTA columns allow you to set, in seconds, the intervals over which the two averages are calculated. Typically, the time interval for the short term average should be about as long as the signals you want to trigger on, while the long term average should be taken over a much longer interval. Both the STA and LTA values are recalculated continually, even during a trigger.

The Ratio column determines by what factor the STA and LTA must differ for the trigger to be activated. Finding the ratio most suited to your needs is best done by experiment. Too high a value will result in events being missed, while too low a value will result in spurious non-seismic noise triggering the system. Like the averages, their ratio is continuously recalculated for all components.

Note: None of the boxes are allowed to be empty, and so you will need to over-type any old value with your new one. Alternatively, you can use the \( \uparrow \) and \( \downarrow \) cursor keys to change the values.
For example, setting the **STA** to 1 second, the **LTA** to 10 seconds and the **Ratio** to 4 would give rise to the trigger behaviour depicted in the following illustrations:

Usually, the values of the two periods, and of the **Ratio**, will be the same for all ticked channels. For convenience, Scream! will automatically fill in other values to match ones you enter. If you want to use different values for some channels, you should clear the **Common values** check-box before altering them.

Once you have enabled **STA/LTA** triggering on a particular channel, you can use the **Control** window to change the values of the **STA** and **LTA** periods, together with the **Ratio**, without restarting the digitiser (see Chapter 10 on page 121).

Since it is not generally advisable to trigger from broadband data, the digitiser provides a set of standard bandpass filters to apply to the data streams before they are tested for the trigger condition. This filtering serves to maximise sensitivity within the frequency band of interest, and filter out noise outside this band. You can select which bandpass filter to use from the **Bandpass filter** drop-down menu. The corner frequencies of the pass band of the filter are determined by the Nyquist frequency, which is given by the sampling rate of the triggering data. The three filter
options have pass bands between 10% and 90%, between 20% and 90% and between 50% and 90% of the data's Nyquist frequency, respectively.

The possible filter configurations are:

<table>
<thead>
<tr>
<th>Tap #</th>
<th>Rate (samples/s)</th>
<th>Bandwidth 1 (Hz)</th>
<th>Bandwidth 2 (Hz)</th>
<th>Bandwidth 5 (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>200</td>
<td>10 – 90</td>
<td>20 – 90</td>
<td>50 – 90</td>
</tr>
<tr>
<td></td>
<td>100</td>
<td>5 – 45</td>
<td>10 – 45</td>
<td>25 – 45</td>
</tr>
<tr>
<td></td>
<td>50</td>
<td>2.5 – 22.5</td>
<td>5 – 22.5</td>
<td>12.5 – 22.5</td>
</tr>
<tr>
<td>1</td>
<td>40</td>
<td>2 – 18</td>
<td>4 – 18</td>
<td>10 – 18</td>
</tr>
<tr>
<td></td>
<td>25</td>
<td>1.25 – 11.25</td>
<td>2.5 – 11.25</td>
<td>6.25 – 11.25</td>
</tr>
<tr>
<td></td>
<td>20</td>
<td>1 – 9</td>
<td>2 – 9</td>
<td>5 – 9</td>
</tr>
<tr>
<td></td>
<td>50</td>
<td>2.5 – 22.5</td>
<td>5 – 22.5</td>
<td>12.5 – 22.5</td>
</tr>
<tr>
<td></td>
<td>25</td>
<td>1.25 – 11.25</td>
<td>2.5 – 11.25</td>
<td>6.25 – 11.25</td>
</tr>
<tr>
<td></td>
<td>20</td>
<td>1 – 9</td>
<td>2 – 9</td>
<td>5 – 9</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>0.5 – 4.5</td>
<td>1 – 4.5</td>
<td>2.5 – 4.5</td>
</tr>
<tr>
<td></td>
<td>8</td>
<td>0.4 – 3.6</td>
<td>0.8 – 3.6</td>
<td>2 – 3.6</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>0.25 – 2.25</td>
<td>0.5 – 2.25</td>
<td>1.25 – 2.25</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>0.2 – 1.8</td>
<td>0.4 – 1.8</td>
<td>1 – 1.8</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>0.1 – 0.9</td>
<td>0.2 – 0.9</td>
<td>0.5 – 0.9</td>
</tr>
<tr>
<td>2</td>
<td>25</td>
<td>1.25 – 11.25</td>
<td>12.5 – 11.25</td>
<td>6.25 – 11.25</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>0.5 – 4.5</td>
<td>1 – 4.5</td>
<td>2.5 – 4.5</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>0.25 – 2.25</td>
<td>0.5 – 2.25</td>
<td>1.25 – 2.25</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>0.2 – 1.8</td>
<td>0.4 – 1.8</td>
<td>1 – 1.8</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>0.1 – 0.9</td>
<td>0.2 – 0.9</td>
<td>0.5 – 0.9</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>0.05 – 0.45</td>
<td>0.1 – 0.45</td>
<td>0.25 – 0.45</td>
</tr>
</tbody>
</table>

9.3.2 Level

Using the Level triggering method, a trigger is generated whenever any of the ticked components reaches a certain level above the baseline. You can select which tap is monitored from the Data source drop-down menu, and the channel(s) to be considered from the Channel column of the table. The values in the Level column are the number of counts above the baseline that channel must reach before a trigger is generated.
As with the STA/LTA method, the values of the Level will often be the same for all ticked channels. If you want to use different values for some channels, you should clear the Common values check-box before altering them.

Once you have enabled Level triggering on a particular channel, you can use the Control window to change the level at which the system triggers without restarting the digitiser (see Chapter 10 on page 121).

If an InfoBlock has been loaded into the digitiser, then the digitiser will interpret the level values so that they are in physical units (e.g. µg for accelerometers).

**Note:** For level triggering configurations, it is highly recommended that you enable the high-pass filter in the “Output Control” page. This removes any DC offsets and/or long-term drift from the data. In the illustration below, the drift has caused a false trigger from the unfiltered data. No such problem exists with the filtered data.

![Unfiltered data with drift](image)

9.3.3 External triggering

When a digitiser or digital sensor triggers, as well as recording or transmitting any extra data, it can also transmit the fact to connected devices. You can configure other digitisers to respond to this signal by triggering themselves. (This is an option which you should specify at the time of manufacture.)
As an example, to instruct a stand-alone digitiser with digital inputs to respond to triggers generated by an attached digital sensor:

1. Open the *Configuration set-up* window for the digital sensor, and tick *Enable External Trigger Output* to make it send triggers to connected devices.

2. **UPLOAD** the new configuration to the digital sensor.

3. Open the *Configuration set-up* window for the digitiser, and tick *Enable External Trigger Input* to make it listen for triggers coming from the digital instrument, and record data from attached analogue instruments when it receives one (depending on its *Output control* configuration).

4. **UPLOAD** the new configuration to the digitiser,

If a digitiser has both *Enable External Trigger Output* and *Enable External Trigger Input* selected, it will record data when it receives an external trigger as if it had triggered itself, but it will *not* send that trigger on to other digitisers. It will only send a trigger message if its own triggering criteria are satisfied.

For full details on external triggering, see the manual for your digitiser or the technical notes available on the Güralp website.

### 9.3.4 Pre-trigger and post-trigger recording

In order to capture all of a seismic event, it is often useful to be able to record data immediately preceding the trigger. Güralp digitisers have an internal buffer of some seconds which allows this data to be added to the triggered stream. Pre-trigger data are particularly useful for emergent-type signals, where the system does not trigger until one phase after the first arrival. In addition, to ensure that the coda of each event is included, some seconds of data are recorded after the system de-triggers.

The two boxes at bottom right of the *Triggering* pane allow the user to set the pre-trigger and post-trigger periods, in seconds. These values determine the *minimum* length of time during which data will be saved before the trigger condition occurs, and after it has lapsed. Regardless of the intervals chosen, the data in the triggered streams will begin on an integer second.

### 9.4 Mux Channels

Güralp digitisers provide a range of slow-rate auxiliary channels for reporting the system’s state of health and other diagnostic information, known as multiplexed (“Mux”) channels. The number of Mux channels depends on the model and configuration of your digitiser. Generally, three channels are used to report the sensor mass position. In addition to these, and depending on the hardware and digitiser options selected, up to twelve Mux channels may be configured for the user’s own purposes.
Some digitisers have a separate AUXILIARY connector which can be used to input signals which are digitised to these channels.

The collection and transmission of Mux channels is controlled using the Mux Channels pane:

If a tick is placed in the box next to a channel, its data will be collected and transmitted as a data stream in GCF format, just as with the normal data channels. To indicate that the data comes from a Mux channel, the Stream ID will take the form ****Mx, where M stands for Mux and x is a hexadecimal integer (i.e. 0 – 9, and A – F for 10 through 15).

Depending on the type of digitiser you connect, Scream! may be able to replace the legends with descriptions appropriate to the digitiser. For example, on DM24 digitisers, the Mux channels M8, M9 and MA appear with the legends Z, N/S and E/W Mass Position respectively, as shown above.

9.5 Ports

The Ports pane of the Configuration set-up window allows you to program the baud rate and number of stop bits for the digitiser's output port.

The baud rate you choose must satisfy two conditions:

- It must be high enough to allow all the transmission of all data generated by the digitiser at the sampling rates you have chosen. For three streams of data
at 100 Hz, for example, 9,600 baud will usually be sufficient. If you wish to transmit 200 Hz data, however, the baud rate must be at least 19,200.

- It must be low enough to fit within the operating range of the telemetry equipment you are using. While many serial modems often offer transfer rates in excess of 115200 baud, the telephone or transmission lines may not support these rates. The same holds true for radio telemetry.

Usually, the transmit and receive rates of the data port will be the same. If not, you may select different data rates by clearing the Identical Tx/Rx rates check-box.

The Stop Bits option allows you to choose whether the serial link uses one or two stop bits. In most cases this can be left at one, although two may be required if you are sending data over 'difficult' transmission lines (for example, some types of radio link). Using two stop bits will add an additional 10% overhead to the data.

You will also need to set the same baud rate for Scream's local serial port, as well as for the NAM, EAM or other receiving communications device (if you are using one). In Scream!, you can configure a serial port by right-clicking on its icon (not that of the digitiser) and selecting Configure... from the pop-up menu: see section 4.1 on page 15. If you are using an additional communications device, you should consult its documentation to learn how to set its baud rate.
10 Controlling CD24 and DM24 digitisers

**Note:** This chapter applies only to Güralp CD24 and DM24 digitisers. For other models, please refer to the relevant digitiser manuals.

To control a digitiser whilst it is running, either right-click on the digitiser's entry in the list to the left of Scream!'s Main Window (not the icon for the server or any Local or Comxx icons) and click Control..., or simply double-click the entry. If the digitiser is already highlighted, you can simply click . Scream! will then contact the digitiser and retrieve its current status (a process which will take a few seconds), after which the Control window will be displayed. Once you are happy with any changes you have made in the Control window, click to send them to the digitiser, where they will take effect immediately.

If you cannot find the setting you want in the Control window, it may be because the digitiser needs to reboot after a change. Try looking in the Configure window instead.

### 10.1 System

When the Control window is first opened, it will be showing the System pane.
The following controls are available:

- **Sensor Type**: If the sensor attached to the digitiser requires mass control, you can send control commands to it from the *Mass Control* tab (see below). Which functions are available on the *Mass Control* tab depends on the *Sensor Type* you have set in the *System* tab.

- If you change the *Sensor Type*, you may have to **Apply** the change, close the *Control* window, and open a new one to access the *Mass Control* options.

- **Output Unified Status packets**: Unified status packets are a binary formatted status information packet that is intended for use with Güralp EAM and NAM modules. If your digitiser is connected directly to an EAM or NAM, you should enable this option. Unified status packets report GNSS and channel status every second, so may consume a lot of bandwidth if a digitiser is connected via a bandwidth-restricted link.

- **Enable GNSS power cycling**: If you are using a GNSS unit to receive time signals, but do not experience significant drift in the system’s clock (for example, in a stable-temperature environment), you can save power by selecting *Enable GNSS power cycling*. The digitiser will power up the GNSS receiver at the specified rate, and keep it powered up until a satisfactory timing fix has been achieved. It will then power it down until the next power-up time occurs.

---

**10.2 Triggering**

The *Triggering* pane is very similar to the corresponding pane of the *Configuration* window, although not all options are available (some changes require rebooting the digitiser). See section 9.3 on page 112 for more details.
10.3 Calibration

You can check that your instrumentation is correctly calibrated by injecting known signals into the sensor’s feedback loop. The Calibration pane allows you to do this once the sensors are installed.
Each channel can be calibrated separately. For most triaxial digital instruments, each channel calibrates the corresponding axis of the instrument; simply select one of the $Z$, $N/S$ and $E/W$ check-boxes to calibrate that axis. Alternatively, click ALL to calibrate all channels simultaneously.

Some instruments have only one calibration input, which is applied to all three components: if you have one of these instruments, you should select $Z$ to calibrate the sensor.

The Duration box tells the digitiser how long to maintain the calibration signal before disconnecting. This avoids the system being inadvertently left in calibration mode. The default is two minutes, however the recommended duration depends on the type of signal being applied.

Güralp digitisers can produce either sine-wave, square-wave (step) and broadband noise calibration. The calibration signal is normally returned on a new stream with a $C_n$ suffix (where $n$ identifies the tap). If the ‘X’ channel was in use, digitisation of the ‘X’ channel is suspended during calibration.

The Sine wave calibration signal always starts and stops on the zero crossing. The frequency or period is specified by the boxes at the top right. The range for frequency is 1-10 Hz, and period is 1-1000 s. Only integers may be specified for either frequency or period, so to generate a 0.5 Hz signal you should select Period and set the time to 2 (seconds). Likewise, if you require a 0.25 second period you should select Frequency and set the rate to 4 (Hz). In this manner, you can select frequencies ranging from 0.001 to 10 Hz (1000 to 0.1 s periods).

You can specify step calibration by selecting the Square wave (step) button. For period $p$, the step function output consists of:

- $p$ seconds of zero volts; then
- $p$ seconds of a negative voltage; then
- $p$ seconds of zero volts; then
- $p$ seconds of a positive voltage

before the signal is disconnected, as shown below.
The *Broadband Noise* calibration signal consists of a constant stream of white noise, which lasts for the specified number of minutes.

Once ready, click [Inject now] to begin the calibration.

**Note:** For detailed information about calculating instrument responses from the results of calibration experiments, please see the Support→FAQs section of our web-site.

### 10.4 Mass Control

Many Güralp instruments respond to control signals to centre, unlock, and lock the sensor masses. These signals are generated by the digitiser. You can tell the digitiser to send a signal using the [Center Now], [Lock Now] and [Unlock Now] buttons on the *Mass Control* tab.

**Note:** Güralp 40T, 6T seismometers and 5T strong-motion instruments do not need locking or unlocking. If you have set the *Sensor Type* (on the *System* tab) to one of these sensors, the *Mass Control* tab will not be available.

If you tick the *Monitor progress* check-box, the digitiser console session will remain open during the process, and the mass positions will be displayed in the *Vertical.*
**N/South** and **E/West** boxes. Note that this will interrupt the transmission of time-series data. If you leave **Monitor progress** clear, the selected action will continue in the sensor in the background, allowing real-time data transmission to resume. You can still monitor the mass positions by selecting the appropriate streams and opening a **WaveView** window for them.

Depending on which **Sensor Type** you have chosen in the **System** tab (see above), not all the control signals will be available. For example, Güralp 3ESP sensors can be centred from Scream!, but must be locked and unlocked manually, whilst the Güralp 3T has remote lock and unlock commands.

### 10.5 Data flow

Güralp CD24 and DM24 digitisers transmit data over serial links using BRP (**B**lock **R**ecovery **P**rotocol). CD24 digitisers with network capabilities also use BRP. This section describes options that control the flow of data over a BRP link.

#### Note: If the digitiser is connected directly to an EAM, as it is in a DM24SxEAM digitiser or a 30TDE instrument, this section does not apply and the digitiser transmission mode should be left in the factory default of **DIRECT** mode.

The digitiser operates in one of several **transmission modes**. These modes relate to how the unit uses its Flash memory:

- as a simple data store, from which you can request data (**FILING** and **DUAL** modes);
- as a buffer holding unacknowledged blocks, which are transmitted in preference to real-time data (**FIFO** mode);
- as a buffer holding unacknowledged blocks, which are transmitted whenever the transmission is free and no real-time data blocks are ready (**ADAPTIVE** mode);
- flash not used at all (**DIRECT** mode).

Separate from and orthogonal to these modes are the two **buffering modes**, which tell the unit what to do when its Flash memory becomes full: It can either

- carry on, overwriting the oldest data held, or
- stop writing and switch the digitiser into **DIRECT** mode.
You can select a transmission mode and a buffering mode from the Data Flow tab:

To choose a transmission or buffering mode, select the required option from the Transmission Mode and/or Buffering drop-down menus, and then click Apply. An explanation of the chosen mode is displayed beneath each menu. The following sections also explain the transmission modes available.

The Buffering legend also displays the amount of Flash memory present in your digitiser. It is 64 Mib in the example shown above.

To clear the Flash memory of the digitiser, click Reset-flash. You will be asked for confirmation before the memory is cleared.

At the bottom of the tab is a line describing the current state of the digitiser’s memory pointers. You can use this line to check that data are being written into memory. Click Auto-Refresh to make the line update automatically.
10.5.1 DIRECT

Instructs the digitiser not to use Flash memory for storage. Instead, all data are transmitted directly to clients. An instrument in DIRECT mode still honours the GCF Block Recovery Protocol: a temporary RAM buffer always holds the last 256 blocks generated, and if a client fails to receive a block it can request its retransmission.

If you expect breaks in communication between the instrument and its client to last more than 256 blocks, or if you want the instrument to handle breaks in transmission (rather than relying on the client to request missed blocks), you should use

- ADAPTIVE mode, if you want data to stay as near to real time as possible (but do not mind if blocks are received out of order) or
- FIFO mode, if you need blocks to be received in strict order (but do not mind if the instrument takes a while to catch up to real time).

10.5.2 FILING

Instructs the digitiser not to transmit blocks to clients automatically, but to store all digitized data in the Flash memory. If you have chosen the RECYCLE buffering mode (see below), the memory is used in circular fashion, i.e. if it becomes full, incoming
blocks begin overwriting the oldest in memory. If the *WRITE-ONCE* mode is active, the instrument will switch to *DIRECT* mode (see above) when the memory becomes full.

**Heartbeat messages**

When in *FILING* mode, an instrument transmits “heartbeat” messages over its data port. These short messages take the place of data blocks, and ensure that programs such as Scream! know that an instrument is present.

If your digitiser is in *FILING* mode, Scream! will displays a slider at the bottom of the tab. Moving this slider changes the interval between heartbeat blocks.

You can tell Scream! to download new data automatically whenever it receives a heartbeat message from an instrument in *FILING* mode. This is useful, for example, in autonomous installations connected by intermittent modem links. To enable this feature:

1. Choose **File → Setup...** from Scream!’s main menu, and navigate to the *Recording* pane.

2. Tick the **Auto-download on heartbeat** check-box.

3. Click **OK**
Using the *FILING* transmission mode with *Auto-download on heartbeat* ensures that Scream! receives all new data whenever it can, regardless of the configuration of any devices between Scream! and the instrument.

### 10.5.3 DUPLICATE

Selecting this mode instructs the DM24 to transmit streams directly to clients (as for *DIRECT* mode) but also to store all data into Flash storage (as for *FILING* mode).

If a client fails to acknowledge a block, the digitiser does not attempt to retransmit it.

Heartbeat messages are not sent in *DUPLICATE* mode.

### 10.5.4 DUAL

Selecting this mode instructs the digitiser to transmit any *continuous* streams directly to clients as for *DIRECT* mode, but to store *triggered* data into Flash storage as for *FILING* mode.

If you choose *DUAL* mode but do not select any continuous streams for output, the instrument will send heartbeat messages as for *FILING* mode. Scream! can pick these up and download new data as necessary.
10.5.5 FIFO (First In First Out)

Selecting this mode instructs the digitiser to begin writing blocks to Flash memory as for *FILING* mode, but also to transmit data to clients. Data are transmitted in strict order, oldest first; the digitiser will only transmit the next block when it receives an explicit acknowledgement of the previous block.

If the communications link is only marginally faster than the data rate, it will take some time to catch up with the real-time data after an outage. If you want data to be transmitted in real-time where possible but are worried about possible breaks in communication, you should use *ADAPTIVE* mode instead.

*FIFO* mode will consider a data block successfully transmitted once it has received an acknowledgement from the next device in the chain. If there are several devices between you and the instrument, you will need to set up the transmission mode for each device (if applicable) to ensure that data flow works the way you expect.

Like all the transmission modes, *FIFO* mode does not delete data once it has been transmitted. You can still request anything in the Flash memory using Scream! or over the command line. The only way data can be deleted is if they are overwritten (in the *RECYCLE* buffering mode, see below) or if you delete them manually.
10.5.6 ADAPTIVE

Selecting this mode instructs the digitiser to transmit current blocks to clients if possible, but to store all unacknowledged blocks in the Flash memory and re-send them, oldest first, when time allows. *ADAPTIVE* mode is best suited for “real-time” installations where the link between digitiser and client is intermittent or difficult of access.

If the communications link is only marginally faster than the data rate, it will usually be busy transmitting real-time data. Thus, it may take a while for the instrument to work through the missed blocks. In this case, and if your client supports it, you may prefer to use the Block Recovery Protocol to request missed blocks where possible.

Caution: Some software packages cannot handle blocks being received out of time order. If you are using such a package, *ADAPTIVE* mode will not work, and may crash the software.
### 10.5.7 Transmission mode summary

<table>
<thead>
<tr>
<th>Transmission Mode:</th>
<th>DIRECT</th>
<th>FILING</th>
<th>DUPLICATE</th>
<th>DUAL</th>
<th>FIFO</th>
<th>ADAPTIVE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function</td>
<td>✔</td>
<td>✘</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Transmit continuous data:</td>
<td>✔</td>
<td>✘</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Store continuous data:</td>
<td>✘</td>
<td>✔</td>
<td>✘</td>
<td>✔</td>
<td>✔</td>
<td>?</td>
</tr>
<tr>
<td>Transmit trigger data:</td>
<td>✔</td>
<td>✘</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Store trigger data:</td>
<td>✘</td>
<td>✔</td>
<td>✘</td>
<td>✔</td>
<td>✔</td>
<td>?</td>
</tr>
<tr>
<td>Heartbeat messages:</td>
<td>✘</td>
<td>✔</td>
<td>✘</td>
<td>✔</td>
<td>✔</td>
<td>✘</td>
</tr>
<tr>
<td>Strict time order:</td>
<td>✔</td>
<td>n/a</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
<td>✘</td>
</tr>
<tr>
<td>Retransmit unacknowledged blocks:</td>
<td>✔</td>
<td>n/a</td>
<td>✘</td>
<td>✘</td>
<td>✔</td>
<td>✔</td>
</tr>
</tbody>
</table>

**Notes:**

1. Acknowledged data are not stored. Unacknowledged data are stored until they are acknowledged.
2. Heartbeat messages will only be sent if no continuous streams are enabled.
3. The receiver can request a “rewind” if blocks are not received correctly but retransmission resumes in strict time order.
4. Real-time data are prioritised over missed blocks.
5. Up to 256 blocks can be buffered to satisfy rewind requests.
6. The whole of flash memory is used as a retransmission buffer.

### 10.6 Buffer Memory Usage

Güralp CD24 and DM24 digitisers transmit data over serial links using the BRP protocol. CD24 digitisers with network capabilities also use BRP. These digitisers can operate in one of a number of transmission modes, which were described in the previous section. Some transmission modes involve storing data in the digitiser’s internal memory. This section describes how to control the behaviour of the system when the memory becomes full.
**Note:** If the digitiser is connected directly to an EAM, as it is in a DM24S×EAM digitiser or a 30TDE instrument, the transmission mode should be left in the factory default of *DIRECT* mode and this section does not apply.

### 10.6.1 RE-USE

Selecting this mode instructs the digitiser to carry on using the current transmission mode when the Flash memory becomes full, overwriting the oldest data held.

For example, in *DUAL* mode with *RE-USE* buffering, the latest continuous data will be transmitted to you as normal, and the latest triggered data may be retrieved from the Flash memory using Scream! or the command line. If, however, you do not download data regularly from the Flash memory, you may lose older blocks. This mode thus lets you prioritise the most recent data held by the instrument.

### 10.6.2 WRITE-ONCE

Selecting this mode instructs the digitiser to stop writing data to the Flash memory when it is full, and to switch to *DIRECT* mode automatically.

For example, in *FIFO* mode with *WRITE-ONCE* buffering, the station will transmit data to you continuously, but also save it in the Flash memory until it is full. Once full, the instrument will switch to *DIRECT* mode and continue transmitting, though no further data will be saved. This mode thus lets you prioritise the earliest (oldest) data held by the instrument.
11 Recording and playback

Scream! allows you to record all incoming data and store it on the local hard disk of your computer. To do this, you should configure the file-name format and destination directory, then select the streams that you want to record from Scream!’s Main Window, right-click and choose Start recording from the pop-up menu. The streams will display Yes in the Rec. column to indicate that they are recording.

The selection of streams to record is stored in the scream.rec file (see section 16.3 on page 179) so that, if Scream is subsequently set to automatically record all streams (see section 11.1.1 on page 136), the original, manual selection can be restored if the automatic option is later deselected.

When Scream! starts recording, it starts at the earliest point in the current stream buffer, and immediately records all the data that it can. For continuous streams, the recorder will soon catch up with the real-time data.

If there is a gap in a stream (e.g. because you are using adaptive mode: see section 10.5.6 on page 132), Scream! will delay recording that stream until the gap is filled. If the gap reaches the end of the stream buffer (as described in section 5.1 on page 29) before data are transmitted to fill it, Scream! will give up and begin recording data from after the gap. If there are unwritten data due to a gap, an ‘*’ symbol will appear next to “Yes” in the recording column, and a right-click menu option Flush to Disk is available which will force writing of all data immediately for the selected streams.

By default, recorded data are placed in a data directory within Scream!’s installation directory, in GCF format. Scream! records files for each stream separately, which it puts in that stream’s own directory. This directory may contain one or several GCF files.

Caution: If you do not have write permission on the recorded data directory, Windows may record to the virtual store instead. Please see the Microsoft documentation for information about the virtual store. Linux systems and Windows systems without virtual store support will indicate an error ERR in recording in the stream list:
11.1 Recording

Scream! has a number of options which allow you to change the way data are recorded and filed. From the Main Window, select Setup... from the File menu to open the Setup window. Two tabs on this window control the way that Scream records incoming data: the Recording tab and the Files tab. In addition, the scream.ini configuration file can be modified with a new section that controls other aspects of data recording.

11.1.1 The "Recording" configuration options

Click on the Recording tab. The available options are described in the following sections.

The upper part of this pane allows you to instruct Scream! to record various types of streams automatically. These options control the Rec setting when a new stream is received (e.g., after start-up). The options are remembered for the next time Scream! is started up.

- **Auto Record—Enable for High Sample Rates**: Tick this box to make Scream! automatically save all local data streams with sample-rates above that specified in the "Files" granularity field.
• **Auto Record—Enable for Low Sample Rates**: Tick this box to make Scream! automatically save all local data streams with sample-rates below that specified in the "Files" granularity field.

• **Auto Record—Enable for Status Streams**: Tick this box to make Scream! save all local status streams automatically.

• **Auto-record downloaded streams**: If you have selected *Auto-download on heartbeat*, you can tick this box to instruct Scream! to automatically record to the local hard disk any data that it receives as a result of a "download" instruction that Scream! issues (see below).

• **Auto-download on heartbeat**: If a digitiser has been configured to record data into its own Flash memory only (*FILING* mode), it transmits heartbeat status messages. With this box ticked, Scream! will listen for heartbeat messages, and ask the digitiser to send saved data whenever it receives one. This option should ONLY be used when the connected digitisers are in *FILING* mode (or in *DUAL* mode with no continuous streams enabled - see section 10.5 on page 126 for more details).

• **Close Files after timeout**: Normally, Scream! keeps GCF files open whilst it records them. This can be a problem in some situations, because no other program can access the file whilst it is open. To make Scream! close the files after each write, tick this box, and enter a time (in seconds) in the field which appears. Scream! will close the file if it has not written anything to it for this number of seconds.

**Note**: If any of the Auto-Record options are disabled after use, any streams which had previously been set to record (by manually enabling them from the Main Window’s stream list) will continue to be recorded. The list of streams for which recording has been manually enabled is stored in the file `scream.rec`. See section 16.3 on page 179 for details.

The lower section tells Scream! how to use its hard disk space:

• **If Stop on Disk Full** is selected, then Scream! will stop recording data once it runs out of space in its directory. This way, the data recorded will have a known starting point.

• **If you select Ring Buffer**, then Scream! will start deleting the oldest files in the data directory in order to make space for new data, so that you will always have access to the most recent recorded measurements.

**Caution**: Scream! does not check whether it created the files itself. If you put your own files in Scream's data directory, then they are at risk of being deleted.

**Note**: Scream! uses operating-system time-stamps (*not* file-names) to decide which files are oldest.
• If **Stream Buffer Only** is selected, Scream! will delete any file which no longer appears in the stream buffer. This is useful if you are only recording to preserve data in the stream buffer through restarts of Scream!.

If there is very little space on the disk, the PC’s operating system can become slow or unstable. By default, Scream! will consider the disk “full” when only 50 MiB of space remains on it. You can change this amount by altering the value at bottom right (**Leave nnn MiB free disk space**).

Changes to these settings take effect as soon as you click **OK** or **Apply**.

**11.1.2 The "Files" configuration options**

Another part of the **Setup** window allows you to alter the way in which Scream! files the data it records. Click on the **Files** tab to open the following pane:

The options you can change are:

**Base Directory:** This specifies the root directory in which data files will be saved. There are useful notes about the choice of directory in section 3.3 on page 14. Files for each stream are stored in sub-directories below the directory specified. The sub-directory structure is defined by the file-name format.
**Note:** You can quickly browse this directory by right-clicking on the Files section header icon (ockeye) in the source tree and selecting **Explore recording base folder** from the context menu.

**Filename format:** This allows you to describe how you want files to be named, by entering a *format specifier*. The string you enter is used to construct the file names for all files. Among the specifiers you can use are:

- **YYYY** the year number (*e.g.* 2003),
- **M** the month number (1 – 12),
- **D** the day of the month (1 – 31),
- **H** the hour (0 – 23),
- **N** the minute (0 – 59),
- **S** the second (0 – 59),
- **R** or **J** the day number in its year (1 – 366),
- **X** the date represented as an 8-digit hexadecimal number (this allows a complete date to fit in the DOS 8.3 format, for compatibility),
- **I** the *System ID*,
- **T** the *Stream ID* (*e.g.* MYD MZ2),
- **E** the *Serial Number* of the digitiser, as given in the first 4 characters of the *Stream ID* (*e.g.* MYDM). You can change this *Serial Number* when you reconfigure the digitiser, so it does not always correspond with the Güralp Systems assigned serial number.
- **C** the component identifier (*Z*, *N*, *E*, *M* etc);
- **P** the sample rate, in samples per second;
- **A** the name of the stream, if you have set a mapping (see section 6.4.2 on page 83), otherwise the same as **T**.

The specifiers **MM, DD, HH, NN, SS, RRR, JJJJ, TTTTTTT** and **EEEE** are the same as their single-letter counterparts, but they are padded with zeros or underscores to a constant length. **YY** can also be used for a 2-digit abbreviation of the year (*e.g.* 03 for 2003), and **MMM** for a 3-letter month name (*jan*, *feb* etc).
Any other letters (including lower-case letters) in the file-name will be left as they are, so you can add constant descriptions or field separators as you wish. Owing to operating system limitations, you cannot use any of the punctuation marks * ? " : < > | in file-names. You can, however, create directory structures by using the back-slash (\) character under Windows or the solidus (/) under Linux. For example:

```
T\YYYY_MM_DD;HHhNNmSSs.msd
```

will give file-names like

```
dmz2\1997_10_05;07h35m20s.msd
```

**Caution:** You should always ensure that files are given unique names. Scream! writes each stream separately. If it finds that it cannot write to a file because it is already open for another stream, the write will fail and data will not be recorded.

Scream! can record data in many formats. Some file formats, such as GCF and MiniSEED, divide their internal data into blocks, each of which has a time-stamp. Such formats can store streams which includes gaps. Most other formats are not block-structured and only have a single time-stamped header at the start of the file. If Scream! is saving data in a non-block-structured format and encounters a gap in the stream, it starts a new file.

**Caution:** For formats other than GCF and MiniSEED, if the file-name configuration does not permit sufficient granularity (e.g. one-hour-long files with no time-of-day indication in the file-name), Scream! will silently over-write the previous file, resulting in loss of data. You should pay particular attention to the file-name settings when using these formats in order to avoid this scenario.

**Data Format:** Selects the format of the recorded data files. Options are GCF, SAC, MiniSEED, P-SEGy, PEPP, SUDS, GSE, UFF (ufa and ufb; see below), CSS and SEG2.

A single instance of Scream! can record in one format at a time; if you need output in multiple formats, you can either:

- record in GCF and perform conversions later using freely-available tools; or
- record in one format and set up a Scream! server to relay real-time data to another Scream! on the same computer (see Chapter 7 on page 86).

**Byte Order:** For SAC, SEG-y, UFB, CSS and SEG2 files, the byte order of the files can be specified. This can be used to match the byte order to the native order of the platform where you are going to perform analysis. GCF and MiniSEED are defined to be in “Motorola or SPARC” byte order. PEPP and SUDs data are defined to be in “Intel” byte order. Byte order is not applicable to the ASCII-like GSE or UFA formats.
Granularity: This setting allows you to specify how large files are allowed to become before a new one is started, for three different types of stream (high sample rates, low sample rates and status streams).

The distinction between high and low sample rates is set by the number in the Sample Rates >= box; the remaining boxes give the number of hours of data that Scream! should combine into a single file for each type of stream. In the example above, streams with a sample rate of 20 samples per second or above will be recorded in files with up to one hour of data per file; lower-rate streams will be recorded in four-hour files, whilst a new status file will be started every twelve hours. You will need to choose a Filename format (see above) which gives each file a unique name.

If you prefer to set a limit on a file's size, rather than its duration, choose Kilobytes from the drop-down menu (instead of Hours or Minutes) and set as appropriate.

Post-processor: This option allows you to specify a program, batch-file or shell-script which Scream! will run every time it closes a file. The name of the file is passed as a parameter.

You can use this feature to interface to other analysis or archival systems, for example:

- you can use FTP or email to send files to remote data centres,
- you can perform format conversion using a third party utility,
- You can post-process file data headers to add site-specific information.
- You can pass data to your own MATLAB® scripts - see section 11.1.12 on page 150 for details.

11.1.3 EXPORTINFO configuration options

A number of output file formats require some additional static information for populating header fields or mapping stream names. This information must be specified in a section of the scream.ini file in a section headed MAN-SWA-0001
[EXPORTINFO]

You can add this section header to the end of your `scream.ini` if it does not already exist. The location of the `scream.ini` file is given in section 16.3 on page 179.

After the `[EXPORTINFO]` section header, add one or more lines in the format

```
KEY=VALUE
```

Some key/value pairs are used for mapping from Güralp stream IDs to stream names in a format recognised by the International Federation of Digital Seismograph Networks (FDSN). These are known as FDSN-format or SNCL-format (Station/Network/Channel/Location) names. These key/value pairs required for these mappings are described below.

Other key/value pairs are optional or mandatory for specific file formats. These will be described in the relevant sub-sections for each format.
Stream name mapping

Channels whose names should be mapped into FDSN format should be listed, one per line, in the format

\[
\text{SysID-StreamID}=\text{sta:SSS chan:CCC net:NN loc:LL}
\]

or

\[
\text{SysID-SerialNumber}=\text{sta:SSS net:NN loc:LL}
\]

or

\[
\text{SysID}=\text{net:NN loc:LL}
\]

where

- **SysID** is the *System ID*,
- **StreamID** is the *Stream ID*,
- **SerialNumber** is the serial number,
- **SSS** is the desired station name,
- **CCC** the desired channel code,
- **NN** is the desired 2-character network code, and
- **LL** the desired location code.

If you use a *SysID-SerialNumber* line, Scream! will apply it to all streams from the digitiser with that serial number, filling in the channel code automatically.

If you use a *SysID* line, Scream! will apply it to all streams from any digitiser with that *System ID*, filling in the channel code automatically and taking the *Station Name* from the digitiser's serial number.

If both instrument (*SysID-SerialNumber*) and stream (*SysID-StreamID*) lines are present, the stream lines will override the instrument lines. Likewise, a *SysID-SerialNumber* line will override a line with just *SysID* if both are present. This allows you to set default values for an instrument or network with single statements.

If you omit a specification, Scream! will fill in the default value. Specifying a value for *loc* is optional.

For example:

```
[EXPORTINFO]
GSL0=net:UN loc:B1
GSL0-DOWNH=sta:BHD
GSL0-SURFX4=sta:SMO chan:LKO
```

specifies that:

- the *Network code* and *Location code* are set to *UN* and *B1* respectively for every stream from the digitiser with *SysID* GSL0.
• all streams from GSL0 with SerialNumber DOWNH will have the Station code set to BHD.

• all other streams from GSL0 will have their Station codes set to the SerialNumbers of their streams (which is the default behaviour) and their Channel codes generated automatically ...

• ... except for the X4 tap, which will have Station code SMO and Channel code LKO (which signifies an exterior thermometer sampled at one sps).

11.1.4 UFF file format

Universal File Format (UFF) is a commonly-used interchange format for seismic data. Two types of UFF format are supported: ASCII and binary, where the extension .ufa denotes the ASCII variant, and .ufb denotes the binary variant. The byte order used for the binary variant is specified in the Recording pane of the Setup window. ASCII does not have byte-ordering options. Details for the layout of the UFF format can be obtained from the University of Cincinnati at www.sdrl.uc.edu/sdrl/referenceinfo/universalfileformats.

You can instruct Scream! to record incoming data directly in UFF format. To do this, open the Files pane of the Setup window as above and select either UFF ASCII (.ufa) or UFF Binary (.ufb) in the Data format drop-down menu. However, UFF files tend to be large, and the format does not retain the full resolution of the data gathered by the sensor. It is recommended that you keep the initial recording in GCF format, and then convert to UFF as required using the batch-processing tools provided (see section 11.1.12 on page 150).

Files in UFF format must represent a contiguous period of time. If a discontinuity is detected in the incoming data stream, then the file which is currently recording will be closed and a new file opened with a file-name and time-stamp matching the start of the new file. This operation will take place regardless of the options you have specified for Granularity, although the Granularity options will still work. For example, if you specify files lasting one hour, a new file will be opened on the hour, every hour, whether or not a discontinuity occurred during the previous hour (which will have caused a new file to be opened at that point).

11.1.5 MiniSEED file format

Scream! supports recording in the IRIS MiniSEED format, using the same rules for generating file and directory names as for GCF files (see section 11.1.2 on page 138), but using the extension .msd.

Data are stored in 4K blocks with Motorola byte order, using Steim-1 compression. If a discontinuity is detected in the incoming data stream, then the block which is currently being built is written to disk, and a new block is started with its time-stamp in the header. Files continue to be created according to the options you have specified for Granularity.
Unless mapped, the MiniSEED headers are formed to comply with the FDSN (International Federation of Digital Seismograph Networks) SEED naming conventions:

- The MiniSEED Station ID is set to the instrument's System ID.
- The MiniSEED Channel ID is composed of three characters: the band code, the instrument code and the orientation code:
  - The band code (first character) is derived from the sample rate according to the following rules:
    - Rates ≥ 80 samples/s use H as the band code
    - Rates of between 10 and 79 samples/s use B
    - Rates between 2 and 9 samples/s use M
    - Rates of 1 sample/s use L
  - All streams use H as the instrument code (second character) in the Channel ID. This signifies "High-gain seismometer".
  - Streams ending in Zn, Nn, and En use Z, N, and E respectively as the orientation code (third character) in the Channel ID.
- The MiniSEED Network code must be specified in the [EXPORTINFO] section of scream.ini.
- The optional MiniSEED Location code can be specified in the [EXPORTINFO] section of scream.ini or left blank. See section 11.1.3 on page 141 for details about [EXPORTINFO].

The default mapping is illustrated below:

The default name mapping can be over-ridden on a per-digitiser basis, a per-instrument basis or even on a stream-by-stream basis. See section 11.1.3 on page 141 for information about [EXPORTINFO] and stream name mapping.
11.1.6 SAC file format

Scream! supports recording in the SAC format, using the same rules for file and directory names as for GCF files (see section 11.1.2 on page 138), but using the extension .sac instead of .gcf.

Files in SAC format must represent a contiguous period of time. If a discontinuity is detected in the incoming data stream, then the file which is currently recording will be closed and a new file opened with a file-name and time-stamp matching the start of the new file. This operation will take place regardless of the options you have specified for Granularity, although the Granularity options will still work.

Before you start recording SAC files, you should ensure you have selected the correct byte-order in the Recording tab of the Setup window.

By default, Scream! uses the SAC header field KSTNM to store the stream’s System ID, the Stream ID is output in the KCMPNM header field.

You can set your own header fields by preparing an [EXPORTINFO] section in the scream.ini file. See section 11.1.3 on page 141 for more details. The specifications that you can use are:

- net: or KNETWK: Sets the KNETWK (network) header field.
- sta: or KSTNM: Sets the KSTNM (station name) header field.
- chan: or KCMPNM: Sets the KCMPNM (component name) header field.
- type: or KINST: Sets the KINST (instrument) header field.
- STLA: Sets the STLA (station latitude) header field.
- STLO: Sets the STLO (station longitude) header field.
- STEL: Sets the STEL (station elevation) header field.
- CMPAZ: Sets the CMPAZ (component azimuth) header field.
- CMPINC: Sets the CMPINC (component inclination) header field.
- KUSER0:, KUSER1:, KUSER2: Sets the appropriate user header field.

If you miss out a specification, Scream! will fill in a default value.

**Note:** Status streams are recorded as plain text, as with GCF files.
11.1.7 SUDS file format

Scream! supports recording in the USGS SUDS 1.x format, using the same rules for file and directory names as for GCF files (see section 11.1.2 on page 138), but using the extension .sud.

Files in SUDS format must represent a contiguous period of time. If a discontinuity is detected in the incoming data stream, then the file which is currently recording will be closed and a new file opened with a file-name and time-stamp matching the start of the new file. This operation will take place regardless of the options you have specified for Granularity, although the Granularity options will still work.

The files generated have STATIONCOMP and DESCRIPTRACE values in the header structures, using the following fields:

- `sc_name.network` and `dt_name.network`: These are set to the last three digits of the System ID.
- `sc_name.st_name` and `dt_name.st_name`: These are set to the first four digits of the Stream ID.
- `sc_component`: This is set to v for Zn streams; n for Nn streams; e for En streams; m for the Mux channels Mn.

11.1.8 GSE file format

Scream! supports recording in the GSE 2.0 format (.cm6 sub-format) using the same rules for file and directory names as for GCF files (see section 11.1.2 on page 138) but using the extension .cm6.

Files in GSE format must represent a contiguous period of time. If a discontinuity is detected in the incoming data stream, then the file which is currently recording will be closed and a new file opened with a file-name and time-stamp matching the start of the new file. This operation will take place regardless of the options you have specified for Granularity, although the Granularity options will still work.

You can set your own header fields by preparing an [EXPORTINFO] section in the `scream.ini` file. See section 11.1.5 on page 144, for more details.

The values that you can specify are `sta`, `chan`, `aux`, `calib`, `calper`, `hang`, and `vang`:

Each specification sets the header field with the same name. If you omit a specification, Scream! will use a default value.

11.1.9 CSS file format

Scream! supports recording in the CSS 3.0 flat file format, using the same rules for file and directory names as for GCF files (see section 11.1.2 on page 138), but using the
extension .w. An additional file, the wfdisc table, is created and stored in the location specified as Base directory.

.w files in CSS format must represent a contiguous period of time. If a discontinuity is detected in the incoming data stream, then the file which is currently recording will be closed and a new file opened with a file-name and time-stamp matching the start of the new file. This operation will take place regardless of the options you have specified for Granularity, although the Granularity options will still work.

Samples are stored in the .w files as signed 32-bit integers (i4 or i4), using the Byte Order you have specified. Scream! updates the wfdisc table whenever data are added to a .w file.

You can set your own header fields by preparing an [EXPORTINFO] section in the scream.ini file. See section 11.1.5 on page 144, for more details.

The values that you can specify are sta:,chan:,wfid:,calib:,calper:,type:, segtype:, and commid:

Each specification sets the header field with the same name. If you omit a specification, Scream! will use a default value.

11.1.10 pSEG-y file format

Scream! supports recording in the PASSCAL-modified SEG-y format (sometimes called pSEG-y), using the same rules for file and directory names as for GCF files (see section 11.1.2 on page 138), but using the extension .sgy.

The main differences between the PASSCAL variant and standard SEG-y are:

1. the reel identification header is omitted (3200 bytes EBCDIC and 400 bytes binary).

2. Additional fields are defined in the "unassigned" bytes 181-240 of the trace header. These are required for recording continuous time-series data, which standard SEG-y would not otherwise be capable of.

Files in SEG-y format must represent a contiguous period of time. If a discontinuity is detected in the incoming data stream, then the file which is currently recording will be closed and a new file opened with a file-name and time-stamp matching the start of the new file. This operation will take place regardless of the options you have specified for Granularity, although the Granularity options will still work.

Before you start recording SEG-y files, you should ensure you have selected the correct byte order in the Recording tab of the Setup window.

Scream! sets header fields in SEG-y files as follows:

• CHANNEL_NAME: The last two characters in the Stream ID, e.g. Z2.

• STATION_NAME: The first four characters in the Stream ID.
• **SENSOR_SERIAL**: The *System ID*.

• **CHANNEL_NUMBER**: 1 for $Z_n$ streams; 2 for $N_n$ streams; 3 for $E_n$ streams; 4 – 19 for the 16 Mux channels $M_n$, adding four to the Mux channel number (e.g. stream $M_8$ will appear as 12).

Status streams are recorded as plain text, as for GCF files.

---

**11.1.11 SEG2 file format**

Scream has limited support for recording data in SEG2 format, using the same rules for file and directory names as for GCF files (see section 11.1.2 on page 138), but using the extension *.cm6*.

Whereas SEG2 files are intended for recording a single shot gather, spanning a few seconds for multiple channels in one file, Scream! is optimised for continuous data recording. Therefore, Scream! can only record one channel per SEG2 file and post-processing with SEG2 file manipulation tools may be necessary.

Files in SEG2 format must represent a contiguous period of time for a given channel. If a discontinuity is detected in the incoming data stream, then the file which is currently recording will be closed and a new file opened with a file-name and time-stamp matching the start of the new file. This operation will take place regardless of the options you have specified for Granularity, although the Granularity options will still work.

The recorded files are in standard SEG2 format, revision 1, using 32-bit fixed-point integers. The byte order is user-selectable in the recording options (see section 11.1.2 on page 138).

The *File Descriptor Block* strings included are:

• **ACQUISITION_DATE** = date of start of data in file, in *DD/MM/YYYY* format

• **ACQUISITION_TIME** = time of start of data in file, in *HH:MM:SS* format, to the nearest second

**Note**: The SEG2 format recommendations for **ACQUISITION_TIME** do not include fractional seconds. If the data sample rate is greater than 250 sps, therefore, there is a possibility that the specified time may be rounded by an arbitrary fraction of a second when compared to the true data start time. See the GCF Protocol description for details of higher sample rate packetisation.

• **TRACE_SORT** = **AS ACQUIRED**

• **UNITS** = **NONE**
The Trace Descriptor Block strings included are:

- **DELAY** = 0
- **LINE_ID** = the *SysID-StreamID* identifier - see section 5.3 on page 32.
- **SAMPLE_INTERVAL** = Sample delta (1 ÷ sample rate) in seconds
- **TRACE_TYPE** = SEISMIC_DATA

### 11.1.12 Converting GCF files to other file formats

On occasion, you may need to convert pre-recorded GCF files into one of the various data formats supported by Scream!. For example, you may want Scream! to record data in GCF format and convert it to UFF later, to ensure that you retain all the data received from the sensors. Güralp provide a number of command-line tools for this purpose. At the time of writing, available converters include:

- **gcf2msd** - GCF to MiniSEED
- **gcf2asc** - GCF to a variety of ASCII formats, including UFF and UFA
- **gcf2sac** - GCF to IRIS SAC
- **gcf2gse** - GCF to GSE

Please visit Support→Software on our website for the latest versions of these converters, detailed usage instructions and details of all converters available.

**MATLAB® integration**

You can also use GCF data in your own MATLAB® scripts. GCF files can be read directly into MATLAB using a simple script.

1. Download the example script from our website at [http://www.guralp.com/download/matlab/readgcffile.m](http://www.guralp.com/download/matlab/readgcffile.m)
2. Place the script in your MATLAB scripts directory, and launch MATLAB.
3. You can now access the function `readgcffile()` using the format

   ```matlab
   [samples, streamid, sps, ist] = readgcffile(filename);
   ```

   All samples in the file are returned in the array `samples`. The Stream ID is returned as a string of up to 6 characters in `streamid`, whilst `sps` is the sample rate used, in samples per second. The value `ist` is a serial date number representing the start time of the data.
The GCF file to be read, specified as **filename**, may contain continuous, interrupted, or overlapping data for one or several streams.

The file `readgcffile.m` includes a sample function to plot the data from any GCF file. This can be adapted to create your own MATLAB software.

**Caution:** This script is provided "as-is", and should only be considered as an example of how to read GCF data in MATLAB®.

### 11.2 Playback

**Note:** Most of the operations described in this section are deprecated. Better solutions exist, as documented in the appropriate subsections. If you have trouble using any of the alternatives, please contact support@guralp.com for advice.

#### 11.2.1 GCF files

**Note:** The replay function of Scream! in real-time mode, documented in this section, is deprecated. Scream!'s View mode is now the recommended method for viewing GCF files. See section 2.2 on page 10 for details.

To replay a stored GCF file or files:

1. Select **File → Replay Files**... from Scream!'s main menu and select the data you want to replay, or drag GCF files from a Windows “File Explorer” window into Scream!’s Main Window.

   You can also select directories and drag them into Scream!'s Main Window. Scream! will replay all the GCF files it finds in that directory.

   Microsoft Windows will not let you select files from more than one window at the same time, but you can perform multiple drag-n-drop operations into the **Replay Control** that appears after the first file-drop. You can also use the **Search** tool in Windows to select files from more than one directory. Open a window on the topmost data directory and click **Search**, or press **F3**.
Fill in your search criteria (e.g. name: *.gcf), and click Search. You can now select some or all of these files and drag them all into Scream!.

2. The Main Window will change to include the file(s) you selected:

3. Select streams from the files in Scream’s Main Window, and view them in a WaveView window.

4. The Replay Control window contains controls for moving through the files.
To begin with, the replay is set to the beginning of all files, and the **Pause** button ([ ]) is active.

5. Use the **Slower** and **Faster** icons to set the speed at which you wish to replay the file(s). You cannot choose a negative speed.

Scream! will replay data into the stream buffer, which has a limited length. If your file is longer than the buffer, Scream! will eventually begin overwriting old data. To see this data, you will have to begin the replay again.

If your file is shorter than the memory buffer, you can safely choose the highest speed and play the entire file into memory.

You can read files into memory one at a time by selecting them in the drop-down box. If you select *All files*, the files are replayed together at the same rate.

6. When you are ready to play the file, un-pause the replay by clicking on the **Pause** button ([ ]).

   Alternatively, click the **Block step** button ([ ]) to replay the files one block at a time.

7. Open *WaveView* windows as required on the data streams. *WaveView* windows begin in continuous mode, starting at the last data “received” (i.e. played back). All the normal functions of *WaveView* windows are available to you (see Chapter 6 on page 45).

   If you want to pause the *WaveView* window to examine or measure signals, it is recommended that you pause the replay beforehand, so that the data you are viewing stays in Scream!'s memory buffer. If you leave the replay running, the data you are viewing may be replaced with newer blocks.

8. When all files have finished playing back, the **Replay Control** window will disappear. You can continue to work with the data that remain in Scream!'s memory buffer.

### 11.2.2 Reading hard disks

**Note:** The replay of data from disks, as documented in this section, is deprecated. It is recommended to use the **gcfxtract** utility for faster offloading of data. Visit Support→Software on the Güralp website for more information about gcfxtract.
Note: Depending on your security settings, you may need elevated privileges in order to read DFD-formatted disks. Windows users may need to start Scream! by right-clicking on the icon or start-menu entry and selecting Run as administrator... from the context menu. Linux users may need to add their username to the disk group (or to another group with raw disk access) with a command like

```
sudo usermod --append -G group my_username
```

You can use Scream! to replay streams direct from Güralp Systems portable DFD disks. These are normally FireWire or USB (e.g. for Güralp 6TD disks) but SCSI is also supported. Up to 100 disks can be connected to the system at once, depending on your operating system and hardware. To read a disk directly, Scream! may need administrator (root) privileges.

Caution: When a DFD disk is connected to a Windows PC, the operating system will not recognise the file-system and will offer to re-format it. Do not allow it to do so: you will lose some data from the disk and make it hard to recover the rest. If you accidentally find yourself in this position, please contact support for advice.

1. Choose File → Replay SCSI disk from Scream!'s main menu. If Scream! cannot detect any suitable interfaces, this option will be greyed out.

2. Scream! will now search for DFD disks, and search for data streams on each disk it finds. When it has finished, a Select streams for Replay window will open.

3. Select the stream or streams you wish to replay, and click [OK].

4. The streams will appear in Scream!'s Main Window as a group, and the Replay Control window will open; you can now replay the files as above.

5. You can open more groups of streams by repeating steps 1 – 4 as desired.

To record data from the disk into your file system, right-click on the streams when they appear in the Main Window and select Start Recording, as for a real-time stream. Data will be recorded in the file format and using the file-names you specified in the Recording and Files tabs of the Setup window. For the highest replay rate, do not open WaveView windows on the streams as you replay them.

Alternatively, if you are using Linux, you can create a raw disk image with the command `dd`. For more information, see the Linux man page for `dd`.

Scream! can read raw disk images as if they were connected disks; to attach an image to a disk slot, run Scream! with the command line

```
scream /disknn=image.bin
```
where \texttt{image.bin} is the path of the image file, and \texttt{nn} is a slot number (between 0 and 99). This command line option can be repeated as many times as necessary.

Once you have read all the data on a disk, you can “blank” or reinitialise it by selecting \texttt{File $\rightarrow$ Reset SCSI disk} from the main menu. You can now remove the disk and re-use it in, for example, a 6TD. Scream! will not reset a DOS-formatted disk this way, in case it contains other files besides data. (DOS disks can be reformatted by your operating system.)

#### 11.2.3 SCSI tapes

Scream! can also replay data directly from an attached SCSI tape, provided that

- it detects a SCSI interface with at least one tape drive connected, and
- a suitable ASPI driver layer has been installed.

If more than one tape drive is connected, Scream! will use the one with the lowest SCSI ID.

- To record data, select \texttt{File $\rightarrow$ SCSI Tape $\rightarrow$ Record Data}. \textit{All} data subsequently received by Scream! will be recorded onto the tape, regardless of where it comes from, or whether the \textit{Rec.} option is set for the streams. Choose \texttt{File $\rightarrow$ SCSI Tape $\rightarrow$ Record Data} again to stop recording.

  If the tape drive fails or goes offline for any reason, Scream! will begin buffering data internally, and will continue recording once the fault has been resolved.

- To replay data, select \texttt{File $\rightarrow$ SCSI Tape $\rightarrow$ Replay Data}. This opens a \textit{Replay window} for loading the data on the tape into Scream!. Data are loaded into Scream! one block at a time; Scream! then waits until a time determined by the \textit{Faster} and \textit{Slower} icons in the \textit{Replay window} before loading the next block. Setting these icons to \textit{Max} stops Scream! from waiting at all. If you are using a slow tape drive, Scream! may not need to wait, and so the faster replay speeds will be equivalent.

  Do \textit{not} attempt to replay data from the tape whilst you are recording to it.

- To rewind the tape to the beginning, select \texttt{File $\rightarrow$ SCSI Tape $\rightarrow$ Rewind}. If you are recording data onto the tape, Scream! will resume recording as soon as the rewind operation finishes.

- To eject the tape, select \texttt{File $\rightarrow$ SCSI Tape $\rightarrow$ Eject}, or press the \textit{Eject} button on the tape device. If you are recording data onto the tape, Scream! will begin buffering data internally until the tape drive is ready to accept new data, and will automatically resume recording on the new tape. This feature allows you to “hot-swap” tapes directly, without losing any data.

  If no compatible tape drives are detected, these menu options will be greyed out.
11.3 Automatic playback

If a directory called autoload is present in Scream!'s program directory, Scream! will automatically look in it for GCF data and play it into the stream buffer in real time, as if it came from a local serial port. The data appear under Autoload in the Files section of Scream!'s stream list.

This feature allows you to transfer real-time data to Scream! by merely placing files in the designated directory. For example:

- If your acquisition equipment only has FTP access to the computer running Scream!, you can gather data into GCF files and transfer them every so often into the autoload directory, where Scream! will process them next time it is running; or

- You can set up a separate script on your computer that periodically fetches GCF files from a Web server.

Once a file has finished playing back, Scream! deletes it from the autoload directory. If you want to keep the data, you will have to re-record them from Scream! into a directory that you specify. If Scream! cannot delete it, it remembers the file so that it does not try and replay it again. However, if you exit Scream! and restart, Scream! will replay the file if it is still there.

**Note:** Data from the autoload directory will not be transmitted over the network.
12 Printing options

Scream offers a number of printing options, which are described in this chapter.

**Note:** On some older versions of Windows, if you print to a printer which is not your computer’s default, Scream! will revert to using the default printer immediately afterwards.

**Note:** On Linux systems, Scream! respects the **PRINTER** environment variable. You can start a copy of Scream! with a specific printer preselected by using a command such as

\[ \text{PRINTER=PDFgateway} \text{ scream} \]

or you can put a line like

\[ \text{export PRINTER=KyoP5026} \]

in your .profile, your .bash_profile or even in your scream.sh.

12.1 Page printout

The simplest way to print from Scream! is in **page** mode, using your operating system’s printer drivers. The print-out reproduces the vector data visible in a single **WaveView** window, including scaling factors, filters and cursors (but not spectrograms). Data in the window are stretched to fill the page.

1. Choose **File → Printer Setup…** to display your operating systems’ standard **Printer Setup** window and select from the options for your printer and paper.

2. Open a **WaveView** window on the streams you want to print.

3. If desired, pause the window and zoom in on an area of interest. Make any other necessary adjustments.

4. Click the **Print** button ⇩. The printer will output a full-page reproduction of the visible data, using the amplitude and time scaling, filtering, and other display options that you have set.

*Alternatively,* click the arrow beside the **Print** button and select **Page Print (monochrome)** to print the same data in black and white. Black and white output is more suitable for copying or faxing.
12.1.1 Automatic printing

To produce page printouts from a WaveView window on your default printer at regular intervals:

1. Click the arrow beside the Print icon , choose Auto-Print… from the drop-down menu and tick Enable Auto-Print in the dialogue box:

3. If you want print-outs in black and white, tick Monochrome.

4. In the three boxes below, specify the time period each day when Scream! will auto-print, and the interval between print-outs. Printing takes place at the end of each time period.

   For example, if you set From to 05:00:00, To to 10:00:00 and Every to 120 (minutes), Scream! will automatically print the contents of this WaveView window every day at 07:00, 09:00 and 11:00 UTC. If you have also set the WaveView window’s width so that it displays 120 minutes of data, the resulting printouts will cover the entire period 0500–1000.

5. Click OK.

Each page has a title at the bottom, which is taken from the title of the WaveView window. To change this title, right-click in the window and select Label…. Enter a new label, and click OK. This label is also used as the job name when Scream! sends data to your printer.

Any changes you make to the WaveView window will now be reflected in later printouts. If you want to examine the data yourself without disturbing the printing, you should Duplicate the WaveView window (Ctrl + D) and then minimize the one that is printing, so that its scale and other settings are not changed. Printing will continue in the background.
12.1.2 Automatic screen-shots

You can save screen-shots from a WaveView window at regular intervals. These can be saved to a file or used as input files for another program. The WaveView window does not have to be visible for a screen-shot to be taken, so you can minimize it once you are happy that everything is working correctly.

1. Click the arrow beside the Print icon to display a drop-down menu.
2. Choose Auto-screenshot… and tick Enable Auto-Screenshot.
3. Set the time interval between screen-shots in the two boxes beneath. Unlike Auto-Print, a screen-shot will be taken at this interval throughout the day.
4. Enter a file name for the screen-shot in Save to File. If you also want Scream! to run a command using this file as input, enter it in the Execute Command box. Screen-shots are saved in PNG format so, under Windows, you should add .png to the end of the file-name.
5. Ticking Force Size, and filling in an image width and height in the two boxes that appear, forces the WaveView window to have the size that you specified. Every image will also have this size. Whilst Force Size is active, you cannot resize the window. However, you can still obscure it with other windows, or move it partially off the screen.
6. Ticking Null before capture nulls (centres vertically) all unlocked streams immediately before taking the screen-shot.
Ticking *Auto-Scale before capture* sets the scale factor for all unlocked streams so that each trace just fits within its lane.

**Note:** If you do not *Save to File* or *Execute Command*, you can still *Null* or *Auto-Scale before capture*; this can be a useful way of keeping traces within a *WaveView* window over long periods, even if you do not need screen-shots.

The *Null* and *Auto-Scale before capture* cause the *WaveView* window to be redrawn immediately before a screen-shot is taken. If the window includes a spectrogram, this will be lost. If you need to save screen-shots that include spectrograms, clear these two options.

Screen-shots are bitmaps, best for publishing on the Web or another low-resolution medium. If you intend to print the traces later, consider saving them in vector format by using *Auto-Print* and setting your default printer to *Print to file* (or a PDF generator such as "Microsoft print to PDF" or, under Linux, the PDF driver within CUPS).

### 12.2 Continuous printout

*Scream!* includes built-in drivers for printing continuously to a parallel-connected Epson ESC/p (Epson Standard Code for Printers) compatible printer (this includes most dot-matrix printers, and many others, although you may need to explicitly enable this mode on your printer). You can print in continuous mode from any *WaveView* window, although only one *WaveView* window can be used as a print source.

**Note:** If you do not have a physical parallel port on your computer, please see section 12.2.1 on page 162.

Because *Scream!* bypasses the printer drivers of your operating system when it prints in continuous mode, you will need to set up the printer options manually:

2. This window only applies to continuous mode printing; for page mode printing, you should use the standard File → Printer Setup… window.

3. Set Port to the name of the parallel port connected to the printer (or an emulated port redirected to a real printer).

4. Set Resolution to a suitable value for the printer, in dots per inch (DPI) or pins. Ensure that the mode you select is within the capabilities of the printer, as Scream! cannot do this automatically.

5. Set Print Width to the width of the printout, in inches (leaving some room for binding, notes etc., if desired) and Page Length to a suitable value, also in inches. Page Length does not need to correspond to an actual page size; it is only used to specify when to print certain labels (see below).

6. The final three options determine when to print various labels, namely: the Stream ID of each stream, an amplitude scale, and a date-stamp.

7. If you select Every Page for one of these, the label will be printed at intervals of Page Length, above.

8. If you select When Change, the label will be printed whenever that attribute of the controlling WaveView window changes, i.e., the Stream IDs when a stream is added or removed from the window, the amplitude scale when the vertical zoom factor is changed, and the date every midnight.

9. Click OK.
10. Create a WaveView window containing the streams you want to print.

11. Choose a suitable amplitude scale for each stream within the window. Each trace will occupy the relative width across the page as it does across the controlling window.

12. Choose a suitable time scale in the window. The figure between the Scale icons \( \leftarrow 2 \rightarrow \) determines the scale that will be used, in lines per second (i.e. one pixel in the WaveView window corresponds to a single line on the printer).

13. Because printer lines are generally smaller than screen pixels - a typical screen resolution is about 75 DPI - the printed traces will appear squashed relative to the window. On a 75 DPI screen (or printer) at a scale factor of 5, an inch (25.4 mm) will correspond to fifteen seconds of data; on a 300 DPI printer, the same scale factor would produce an inch of output every sixty seconds.

14. Make any other choices you require (offsets, block boundaries etc).

15. When you are happy with the appearance of the window, click the arrow beside the Print icon to display the drop-down menu and choose Continuous Print.

16. (If the Continuous Print option is greyed out, check that you have not enabled continuous printing for another WaveView window.)

17. The printer will output a short banner, after which it will begin plotting the data.

18. To stop printing, click the Continuous Print icon again.

The display settings for the window will now continue to be reflected in the printout. If you want to examine the data yourself, you should Duplicate the WaveView window (Ctrl + D) and minimize the one that is printing, so that the scale and other settings are not changed. Printing will continue in the background.

Whilst continuous printing is in progress, do not attempt to print any other documents to the same printer through the operating system. If you need to do this, you should temporarily stop printing from Scream! and restart when you are done.

### 12.2.1 Parallel port redirection under Windows

Under Microsoft Windows, Scream! can only print in continuous mode to a named, local "LPT" port on your local machine. However, Windows can map a local port to a shared printer on the network. Once you have done this, you can use the mapped port name to print in continuous mode.

1. Key and type `cmd`.
2. In the resulting window, type

```
net use port-name printer-name
```

where `port-name` is the name of the new port to create (e.g. LPT2) and `printer-name` is the network share name of the printer you want to use (e.g. `\server\myprinter`). The `port-name` that you choose should be different from any physical port on your PC.

3. The program should report `The command completed successfully`. For more information about the `net` command, see the Windows documentation.

4. You can now use the new port name in Scream!'s `Setup` window.

**Note:** When Scream! prints in `paged` mode it uses your installed printer drivers, and can access printers shared across a network as normal. You do not need to map a local port if you only want to print a page at a time.
13 Logging and notification

13.1 Log files

As Scream! receives data blocks, it checks that each one is valid and self-consistent. Any errors it detects are highlighted in the ViewInfo window (see section 8.4 on page 106). They can also be logged to disk.

To specify this file, or to change which types of error are logged, choose File → Setup... from the main menu and move to the Event Log tab. Tick Enable Event log to begin.

The top section of this window lets you select the types of event to be logged:

**Block Sequence Errors**: A block with an unexpected block number. Blocks received over a data link are marked with a block number, which increases by one for each new block. If Scream! receives a block whose number is out of sequence, it generates this error.

**Suspicious System IDs**: A block coming from an instrument which is reporting a System ID of zero (i.e. blank). Although the block itself is valid, there may be a problem with the device from which it came.

**Invalid Time Code**: A block with an out-of-range time-stamp (i.e. greater than 23:59:59).
**User Commands**: A command initiated by the user which affects the operation of the instrument, *e.g.* locking, unlocking, centring, calibration, and configuration detection.

**Invalid Compression Code**: A block with a compression code other than 1, 2, or 4.

**Invalid Block Duration**: A block which is not a valid number of seconds long, or fraction thereof for higher sample rates. For up to 250sps, GCF blocks must contain a whole number of seconds of data, calculated as \( \text{number-of-samples} \times \text{sample-rate} \). For over 250sps, specific fractions of seconds are allowed. See the online GCF specification for more details.

**End Sample Mismatch**: A block whose final sample (RIC or reverse integrating constant) does not equal the first sample plus all the differences within the block.

**Checksum Errors**: A block whose checksum does not match the sum of all the bytes in the block.

**Data Discontinuities**: Any detected gap in a stream, along with the reason, if known. This includes reboots, clock synchronisations, and intentional gaps in triggered channels, as well as any data lost owing to slow or poor-quality communications links. Status streams hold no duration information and are not checked.

By default, log files are created in the user’s directory (*Local Settings* under Windows), under different names according to the source of the data:

- local serial inputs are logged by port, in files named *comport\_x.log*,
- network servers are logged by IP address, in files named *aa\_bb\_cc\_dd-pp.log* (for the IP address *aa\_bb\_cc\_dd* and port *pp*), and
- file and SCSI disk replays are logged in the file *replay.log*.

Any events which do not relate to a particular stream are logged in the file *scream.log*. If you clear the *File for each data source* check-box, all events are logged to this file.

Log files can become quite large and it is usual to limit their size. To do this, tick *Limit to...*, and set a value in the box. When a log file *xxx.log* reaches this size, it will be renamed *xxx.old*, and a new, empty *xxx.log* file will be created. If the file *xxx.old* already exists, it is overwritten.

Finally, enter the name of a directory in the text box, or click *Browse...* to find a suitable directory for saving the log file(s). See the notes about choice of a suitable directory in section 3.3 on page 14.
13.2 E-mail notification

You can also instruct Scream! to send e-mail to warn the operator when particular events happen. To set this up, choose `File → Setup...` from the main menu and move to the `Email Options` tab.

To be able to use e-mail, you will need access to a mail (SMTP) server which will accept messages from the address `Scream_SMTP_client@your-hostname`. Fill in the IP address or hostname of this server in the `SMTP Server` box. The `Recipient` box should contain the e-mail address to which you want the mail sent.

The events you can monitor are:

- **Digitiser re-boots**: Scream! can recognise the boot-up status messages of a Güralp digitiser or digital instrument. These are normal after a power cycle or when a new configuration is uploaded to the digitiser. After a re-boot, you should receive `Re-Sync` and `Data Discontinuity` messages as well.

- **Re-Syncs**: Whenever the digitiser’s internal clock is resynchronized with a GNSS. These are normal after a re-boot, or an extended period of GNSS outage.

- **Data Discontinuities**: Any detected gap in a stream, along with the reason, if known. This includes reboots, clock syncs, and intentional gaps in triggered channels, as well as data lost owing to slow or poor-quality communications.
links. You should check the log files (see above) to help you determine the cause.

- **SAM disk full**: SAM units send status messages when they stop recording data because their disk is full. SAM units in circular-buffer mode carry on recording, and do not send these messages. (This does not work with DCMs, EAMs or NAMs: only SAMs.)

- **Scream Start / Stop**: Generated by Scream! when it starts, and when it shuts down cleanly. If a computer suffers a sudden loss of power or is not shut down properly, Scream will not be able to respond in time so you will not see a *Scream Stop* message.

- **Scream recording stopped**: Whenever recording fails for a particular stream, because of a write error on the local disk. Check that the disk is not full, and that you have write access to the relevant directories. If you have *Auto Record – Enable* active and have set recording to GCF format, replaying a previously-recorded GCF file will cause Scream! to attempt to record to the same file, causing this error. The file will be undamaged.

- **GNSS Control Timeout**: Generated if Scream! has previously received satisfactory GNSS synchronization messages, but has not received any within the last 12 hours. Scream! will not send another *GNSS Control Timeout* message until GNSS operation resumes, at which point it will restart the 12-hour timer.

- **Digitiser Trigger Report**: Whenever the digitiser triggers. Scream! determines this from lines in status messages, and *not* from the data streams. Because of this, there may be a slight delay between a trigger and this message. The contents of the status lines are repeated in the message.

- **Mass Positions**: Generated if an instrument reports a mass position above the value you specify in the associated text-box, expressed as a percentage of the maximum possible value. Most Güralp instruments can operate satisfactorily with mass positions up to 50% of their travel; some can operate with significantly higher mass positions. A follow-up email will be generated when the mass position returns below the set threshold.

- **Disk Full Warning**: Generated if the amount of data on the hard disk exceeds the specified percentage of the size of the disk.
14 Extending Scream!

Scream! is a data communication, visualisation and recording tool. It is not intended for performing detailed analysis on the data received. However, extensions are available for Scream! which can carry out calculations on seismic data. These extensions can be stand-alone programs, or scripts written in MATLAB®. Some sample extension scripts are supplied in the Scream! program distribution.

14.1 Installing new extensions

There are two files that can reference a program extension; screamglobal.ini and scream.ini. The first is located in the installation directory of Scream, and will affect all instances of Scream! that run on the computer. The second is the normal configuration file for each instance of Scream, and so can be customised on a case-by-case basis. The following steps can apply to either file, but you only need to modify one.

To install a program extension:

1. Place the program file in a suitable directory, preferably one named in your PATH (i.e. you can launch it by typing its name at a command prompt).

2. Open the scream.ini (or screamglobal.ini) file (see section 16.3 on page 179 for help finding this file).

3. Look for a section beginning with the line
   
   [custom]

4. If it does not exist, add the following lines at the end of the file:
   
   [custom]
   
   SelectionMenu=executable-name

   executable-name should be the name of the program if it is in your PATH, and the full file-name otherwise.

   If you want the displayed menu entry to be different from the file-name, use the form

   [custom]
   
   SelectionMenu=executable-name|displayed-name

   e.g.

   SelectionMenu=art.exe|ART 3.0 Analysis Package

5. If the line [custom] exists, add the name of the new extension to the list after SelectionMenu, separating names with commas, e.g.

   SelectionMenu=art.exe|ART 3.0 Analysis Package,myextension.exe|My Analysis Extension
Note: The SelectionMenu line can become very long. It has been split at the symbol in the example above in order to make it legible but it should always be entered on a single line with no new-line characters.

To install a MATLAB® extension:

1. Make sure MATLAB® 5 or later is installed on your computer, together with the MATLAB® signal processing toolbox.

2. If you have not done so, register MATLAB® as an “automation server”. See the MATLAB® documentation for more details.

3. Place the script file in MATLAB®'s PATH, so that MATLAB® can see it.

4. Make sure Scream! is not running (stop it if necessary) and open the scream.ini (or screamglobal.ini) file in Scream!’s directory using a text editor.

5. Add the name of the script to the SelectionMenu as detailed above.

When an extension is launched, Scream! first saves the selected data to a file named samplesn.txt in the standard temporary directory (using the Windows TEMP environment variable, or /tmp under Linux). A second file, scrhdr.txt, is saved at the same time, which directs the script to the location of the data. The script or program is expected to fetch the data from this file. If you have problems, make sure that Scream! has the right permissions to create these files, and that your temporary space is not full.

14.2 Running extensions

To export data to a Scream! extension:

1. Open a WaveView window on the stream or streams of interest, and find the data you want to analyse.

2. If desired, click the Pause button to or key to pause the window.

3. Select the desired data as described in section 6.1.4 on page 52.
4. When you release the mouse button, a menu will pop up showing the extensions available.

5. Click on the name of the extension you want to run.

The standard Scream! Package (depending on installer) includes a number of useful extensions:

- **ART Analysis Package**: Güralp Systems’ suite of tools for strong motion analysis. See the separate ART documentation (MAN-SWA-0003) for full details of this package.

- **PSD in Velocity Units** and **PSD in Acceleration Units**: These extensions produce instant power spectral density plots of the selected time series.

- **Relative Orientation**: This extension applies the Güralp-Blacknest correlation method to determine the orientation of an instrument (usually a borehole instrument). It uses coherence techniques to estimate the angle between the horizontal components of two sensors, where one is rotated with respect to the other.

  Please see [www.guralp.com/howtos/determining-sensor-orientation.shtml](http://www.guralp.com/howtos/determining-sensor-orientation.shtml) for more information about this technique.

- **Sine Calibration, Step Calibration** and **Broadband Noise Calibration**: These extensions help you to calibrate sensors using an input sinusoidal, step or pseudo-random noise signal. These signals can be generated by Güralp Systems DM24 and CD24 digitisers, allowing you to calibrate sensors quickly and easily.
15 Keyboard and mouse shortcuts

Scream has lots of keyboard and mouse shortcuts which can be used to make routine tasks faster and easier. The most useful ones are listed in the sections below.

15.1 The Main Window

15.1.1 Menu items

A number of menu options from the Main Window have equivalent keyboard shortcuts:

- `Ctrl` + `A` Select all streams
- `Ctrl` + `I` Open the ViewInfo window
- `Ctrl` + `N` Open the Network Control window
- `Ctrl` + `S` Open the Setup window
- `Ctrl` + `U` Open the Summary window
- `Ctrl` + `W` Open a new, empty WaveView window

15.1.2 The source tree

When an entry in the left-hand pane (the source tree) is selected, you can navigate with the arrow keys:

- `↑` Move to the previous entry
- `↓` Move to the next entry
- `← or -` "Roll up" the current entry
- `→ or +` "Unroll" the current entry
Other shortcuts in the source tree include:

<table>
<thead>
<tr>
<th>Key Combination</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl + → or Ctrl + ←</td>
<td>Expand all &quot;rolled up&quot; sub-trees</td>
</tr>
<tr>
<td>Ctrl + + or Ctrl + -</td>
<td>&quot;Roll up&quot; all sub-trees</td>
</tr>
<tr>
<td>Del</td>
<td>Remove the currently selected entry (if not Files or Network) and any sub-entries. This action also clears from the stream buffer any data associated with the deleted streams.</td>
</tr>
</tbody>
</table>

Note: Deleting an active source when recording is enabled has the side-effect of flushing any buffered data to disk. The source will reappear as soon as the next packet is received.

Variable - see below:

- : The function of the Enter key changes, depending on the type of item that is selected in the source tree:
  - the Files section header equivalent to picking Replay files... from the File menu (see section 11.2 on page 151)
  - a file no action
  - the Network section header open the Network Control window (see section 4.3 on page 20)
  - a host directs a web browser to open the address of the PC, NAM or EAM.
  - a serial port open a terminal session to an attached digitiser (see section 8.1 on page 92)
  - a digitiser opens the Control window (see chapter 10 on page 121)

- : If the stream list has too many entries to fit into the pane, the pane contents can be scrolled using the mouse wheel.
15.1.3 The stream list

If the right-hand pane (the streams list) is selected, the keys perform the following actions:

- Move to the previous stream.
- Move to the next stream.
- Extend the selection to the previous stream.
- Extend the selection to the next stream.
- Open a new WaveView window on the currently-selected streams.
- Remove the currently-selected streams, and clear their data from the stream buffer.

**Note:** Deleting an active stream when recording is enabled has the side-effect of flushing any buffered data to disk. The stream will reappear as soon as the next packet is received.

If the source tree has too many entries to fit into the pane, the pane contents can be scrolled using the mouse wheel.

15.2 WaveView windows

Most of the functions of WaveView windows can be accessed by a keystroke, a mouse movement or the combination of the two. This is particularly useful if you have removed the window decoration with the *No Caption* menu option.

15.2.1 Shortcuts for all streams

- Increase the amplitude scale (zoom in vertically)
- Decrease the amplitude scale (zoom out vertically)
- "Roll up" the current entry
- "Unroll" the current entry
- Increase the time scale (zoom in horizontally)
or  

Decrease the time scale (zoom out horizontally)

or  

Set all scales to unity (i.e. display all amplitudes in counts)

Enter or leave “pause” mode (stop or start scrolling)

Scroll forwards in time when in pause mode

Scroll backwards in time when in pause mode

Create a duplicate window as an exact copy of the current WaveView window, with all settings the same

Toggle the filter on or off

Open the Filter Design window - see section 6.3 on page 73

Null the offsets of all unlocked streams in the WaveView window, so that the mean value of each is centred vertically in its respective lane

Toggle the spectrogram of all streams on or off

Increase the colour brightness of all spectrograms

Decrease the colour brightness of all spectrograms

Toggle the display of “lane lines” on or off

Toggle “overlay mode” on or off. In “overlay mode” all streams are drawn in the centre of the window, rather than having separate lanes. See also the following two entries

Restore standard axis spacing (see section 6.1.8 on page 58). If standard spacing is already in force, this will recompute the display cache and redraw the contents of the WaveView window, cancelling any selection

Overlay streams

Space stream axes according to the instrument’s depth. The calvals must contain a depth= entry for every stream in the window

If calvals contains position entries for every stream in the current window, this key will space the stream axes according to the distance from a set point, specified
Keyboard and mouse shortcuts

using...

CTRL + F8 Specify a set point for axes spacing
F11 Toggle “no caption” on or off
CTRL + DEL Remove all streams from the WaveView window
CTRL + 0 Sets the offsets all streams to zero. This may make some or all traces move vertically outside of their lanes or even outside of the WaveView window.

15.2.2 Shortcuts for the selected stream

There are also shortcuts which affect only the stream containing the mouse pointer. These are equivalent to the stream actions on the context-sensitive menu.

Del Remove the active stream from the WaveView window
C Display the Colour selection dialogue box for the active stream
D Toggles on or off the Details window for the active stream
N Null the offset of the active stream in the WaveView window, so that the mean value is centred vertically in its lane
S Scale the active stream
CTRL + S Scale all other streams to have the same (visual) peak-to-peak amplitude as the active stream
1 Sets the scale to unity (i.e. display the amplitude in counts)
0 Sets the offset of the current stream to zero. This may make the trace move vertically outside of its lane or even outside of the WaveView window
P Toggle on or off the spectrogram display for the active stream
+ Increase the colour brightness of the active stream’s spectrogram
− Decrease the colour brightness of the active stream’s spectrogram
15.3 Details window

The following shortcuts are active when the Details window has focus.

- Increase the stream's offset by one pixel (regardless of any scaling on the stream)
- Decrease the stream's offset by one pixel
- Increase the stream's offset by the width of one lane
- Decrease the stream's offset by the width of one lane
- Null the offset of the associated stream, so that the mean value is centred vertically in its lane
16 Inside Scream!

16.1 Command line options

Options can be prefixed with either a hyphen – or a forward slash / in both Windows and Linux versions. The option names are case insensitive.

-`view filespec [filespec...]`: Launch in data viewer mode. The files or directories specified are scanned and displayed in a single WaveView window. Whilst Scream! is scanning the files, a small window displays the progress and estimated completion time.

A WaveView window in data viewer mode is identical to a real-time WaveView window, except that

- The data are not held in memory (although memory equivalent to around 10% of the file size is used to store summary data). When you change the displayed time range by zooming in or out, panning, or resizing the window, Scream! re-reads the data for the new time range.

  The advantage of this approach is that you can view files in data viewer mode which are larger than the amount of memory available. Scream! in real-time mode can only draw blocks which are kept in its memory buffer (see section 6.4.1 on page 82).

- You cannot return to the Main Window by clicking on the stream identifier in the context menu.

- You cannot drag streams from one WaveView window to another one (unless one was created as a duplicate of the other), or from a viewer-mode window to a real-time Scream! application window.

Everything on the command line after `-view` is treated as a file specifier. If you need to issue other options, place them before `-view`.

-`-i: configuration-file`: Use `configuration-file` instead of `scream.ini` to load Scream!’s settings.

-`-FlashLED`: Flash the Scroll Lock keyboard LED each time a block is received.

-`-NoSplash`: Do not display Scream!’s splash-screen at startup.

-`-V31`: Force network packets to be in Scream! 3.1 format. Since Scream! 4.n is backwards compatible with Scream! 3.1, you should not need to use this option.

-`-disknn: image-file`: Treat the file `image-file` as a raw DFD disk, attached to port `nn`.

-`-noaspi`: On Windows 98, 95 and ME, Scream! uses the Adaptec ASPI drivers provided with the operating system to control SCSI devices. On other operating
systems, the ASPI drivers are not available, so Scream! controls the devices directly. Use this switch to force Scream! to control devices directly even if the ASPI drivers are present.

16.2 The calvals.txt file

If a file named `calvals.txt` exists in the same directory as Scream!'s executable (`scream.exe`), Scream! will look there for suitable calibration values.

Caution: If you do not have write permission on the directory where the executable is located (which is normal), Windows may silently redirect any file access to the virtual store instead. Please see the Microsoft documentation for information about the virtual store.

Note: If an alternative location has been specified for `calvals.txt` by use of a `parametersfile=path` declaration in the [CUSTOM] section of `scream.ini` and a file exists in that location, Scream! will use that file and not look further. If no such declaration exists, Scream! will look in the current working directory for a file named `calvals.txt`. If it finds one, it will use that in preference to the one in the same directory as Scream!'s executable. Neither of these techniques are recommended because none of the supplied MATLAB® extension scripts will look anywhere other than in the standard location.

Each stream has its own section in the file, identified by its System ID and Serial Number (as described in section 5.3.1 on page 32) in the format

```
[SystemID-SerialNumber]
```

Scream! and its extension scripts check to see if the streams being received match any of the instruments in the file. If they do, the software will apply the correct values for your sensor automatically.

You can edit the section of the `calvals.txt` file appropriate to any particular digitiser within Scream! by either:

- right-clicking on the digitiser icon and selecting Calvals… from the context menu; or
- right-clicking on a stream in a WaveView window and selecting Calvals… from the context menu.

The second method is the only method possible when in View mode.

The format of each section is given in section 5.7 on page 39.
16.3 File and directory locations

16.3.1 Windows version

Scream! creates or uses the following files and directories

- **scream-directory\scream.exe**: The program itself.
- **scream.ini**: The configuration file for Scream!. If updating older installations, this file may be in the `windows-directory e.g. C:\WINDOWS\scream.ini`, for new installations this will be in the `c:\scream\directory`. To restore the application to its factory settings, close down Scream! and delete this file.

  **Note**: The `scream.ini` file can actually have any name and be in any accessible location, provided that scream is started with the `-i:configuration-file` option. See section 16.1 on page 177 for details.

- **scream-directory\qtintf70.dll**: The Qt shared library which Scream! requires to run.
- **scream-directory\calvals.txt**: The sensor and digitiser calibration information file (but see the caution about the Virtual Store, above).
- **scream-directory\autoload\**: The directory to take auto-load GCF files from (see section 11.3 on page 156).
- **c:\scream\data\**: The default directory for recording data. You can change this: see Chapter 11 on page 135.
- **scream-directory\html\**: The default directory for Scream!’s online help.
- **c:\scream\logs\**: The default directory for log files. You can change this if you wish: see Chapter 13 on page 164.
- **scream.rec**: This file lists streams which have been manually set to be recorded. It is changed when a user sets a specific scream to be recorded or not. It is not changed when automatic recording of all streams is enabled so, if automatic recording is subsequently disabled, the original selection can be restored. This file is not always called `scream.rec` but it always has the same name and location as `scream.ini`, with the extension changed from `.ini` to `.rec`.
16.3.2 Linux version

The default installation directory - `scream-directory` - for the Linux version of Scream is `/usr/lib/scream-4.6`. The following files and directories are used:

- `scream-directory/scream`: The program itself.
- `scream-directory/scream.ini`: The configuration file for Scream!. To restore the application to its factory settings, close down all running copies of Scream! and delete this file.

**Note:** The `scream.ini` file can actually have any name and be in any accessible location, provided that `scream` is started with the `-i:configuration-file` option. See section 16.1 on page 177 for details.

- `library-directory/libborqt-6.9.0-qt2.3.so`: The Qt shared library which Scream! requires to run.
- `scream-directory/calvals.txt`: The sensor and digitiser calibration information file.
- `scream-directory/autoload/`: The directory to take auto-load GCF files from: see section 11.3 on page 156.
- `scream-directory/data/`: The default directory for recording data (you can change this: see Chapter 11 on page 135.
- `scream-directory/html/`: The default directory for Scream!'s online help.
- `scream-directory/logs/`: The default directory for log files. You can change this: see Chapter 13 on page 164.
- `scream.rec`: This file lists streams which have been manually set to be recorded. It is changed when a user sets a specific scream to be recorded or not. It is not changed when automatic recording of all streams is enabled so, if automatic recording is subsequently disabled, the original selection can be restored. This file is not always called `scream.rec` but it always has the same name and location as `scream.ini`, with the extension changed from `.ini` to `.rec.`
16.4 Common issues

A number of configuration or operational issues can produce error messages. The most common are described below.

⚠️ Unable to detect configuration

Scream! has not been able to retrieve the current configuration from a digitiser. This can happen because

- The device is not connected.
- The communications link is one-way (simplex). Scream! needs reliable two-way communications to discover the digitiser's set-up. However, you can still receive data over a simplex link.
- The device is heavily loaded, and Scream! times out waiting for a response from it.
- The network between Scream! and the computer hosting the device is slow or unreachable. You can check this using the standard command `ping ip-address` to check that the remote computer is responding.

If your computer is on the same network as the remote device, it must be on the same subnet as that device, or it will need to connect through a gateway machine.

It is recommended that you wait for data to be received from the digitiser before you attempt to configure it.

⚠️ Unable to save program status

The `Scream.ini` file could not be opened for writing. This can happen because

- The file or disk are write-protected.
- You do not have the right privileges to change the file.
- The file is in use by another program.

⚠️ Another application (possibly another instance of Scream) is using the setup file “<filename>”

An instance of Scream! is already running on your system, and is using the referenced ini file for it's configuration. You cannot run two instances of Scream! using the same configuration file. You should either return to the running instance, or if you intended to start a second instance of Scream, you need to specify a different configuration file. See the `-i` option in section 16.1 on page 177.
## Revision History

<table>
<thead>
<tr>
<th>Date</th>
<th>Revision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2018-06-13</td>
<td>N</td>
<td>Added information about ttyUSB permissions and extra details about stream recording.</td>
</tr>
<tr>
<td>2017-06-13</td>
<td>M</td>
<td>Major update for Scream! 4.6</td>
</tr>
<tr>
<td>2015-08-04</td>
<td>L</td>
<td>Changed ExportInfo to EXPORTINFO because Linux port is case-sensitive</td>
</tr>
<tr>
<td>2010-11-25</td>
<td>J</td>
<td>Update for Scream! 4.5</td>
</tr>
<tr>
<td>2009-09-09</td>
<td>I</td>
<td>Restored missing graphics</td>
</tr>
<tr>
<td>2009-05-21</td>
<td>H</td>
<td>Cosmetic improvements</td>
</tr>
<tr>
<td>2009-02-12</td>
<td>G</td>
<td>Various corrections</td>
</tr>
<tr>
<td>2007-01-12</td>
<td>F</td>
<td>Dynamic IP correction</td>
</tr>
<tr>
<td>2007-01-09</td>
<td>E</td>
<td>Update for Scream! 4.4</td>
</tr>
<tr>
<td>2006-10-12</td>
<td>D</td>
<td>Update for Scream! 4.3</td>
</tr>
<tr>
<td>2006-03-09</td>
<td>C</td>
<td>Added revision history</td>
</tr>
<tr>
<td>2005-12-22</td>
<td>B</td>
<td>Update for Scream! 4.2</td>
</tr>
<tr>
<td>2005-06-01</td>
<td>A</td>
<td>New document (Scream! 4.1)</td>
</tr>
</tbody>
</table>